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Copyright
This manual is copyrighted by Canon Computer Systems, Inc. (CCSI)
with all rights reserved. Under the copyright laws, this manual may not be
reproduced in any form, in whole or part, without prior written consent of
CCSI.

©1997 Canon Computer Systems, Inc.

Disclaimer
Canon Computer Systems, Inc. has reviewed this manual thoroughly in
order to make it an easy to use guide for your Canon MultiPASS L6000
system. All statements, technical information, and recommendations in
this manual and in any guides or related documents are believed reliable,
but the accuracy and completeness thereof are not guaranteed or
warranted, and they are not intended to be, nor should they be understood
to be, representations or warranties concerning the products described. 

Your MultiPASS L6000 and the software media included with your system
have been sold to you subject to the limited warranties set forth in the
warranty and license agreement enclosed with the respective product. All
software is licensed AS IS, as described in the license agreement enclosed
with the software media. Further, CCSI reserves the right to make changes
in the specifications of the products described in this manual at any time
without notice and without obligation to notify any person of such
changes. 

Trademarks
Canon is a registered trademark and MultiPASS, ScanGear, and UHQ are
trademarks of Canon Inc.

Other brand and product names may be trademarks or registered
trademarks of their respective companies.

As an ENERGY STAR® Partner, Canon U.S.A., Inc. has determined that the 
MultiPASS L6000 meets the ENERGY STAR guidelines for energy efficiency. 
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USERS IN U.S.A.

PRE-INSTALLATION REQUIREMENTS FOR CANON
FACSIMILE EQUIPMENT
A. Location

Supply a suitable table, cabinet, or desk. See Appendix A for the unit’s
dimensions and weight.

B. Order Information
1. Only a single line, touch-tone or rotary telephone set is to be used.

2. Order an RJ11-C modular jack (USOC code), which should be installed
by the phone company. If the RJ11-C jack is not present, installation
cannot occur.

3. Order a normal business line from your telephone company’s business
representative. The line should be a regular voice grade line or equivalent.
Use one line per unit.

DDD (DIRECT DISTANCE DIAL) LINE
or
IDDD (INTERNATIONAL DIRECT DISTANCE DIAL) LINE IF
YOU COMMUNICATE OVERSEAS

N Canon recommends an individual line following industry standards [e.g., the 2500
(touch-tone) or 500 (rotary/pulse dial) telephones]. A dedicated extension off a
PBX unit without “Call Waiting” can be used with your MultiPASS L6000. Key
telephone systems are not recommended because they send non-standard signals to
individual telephones for ringing and special codes, which may cause a fax error.

C. Power Requirements
This equipment should be connected to a standard 120 volt AC, three-wire
grounded outlet only. Do not connect this unit to an outlet or power line
shared with other appliances that cause “electrical noise.” Air conditioners,
electric typewriters, copiers, and machines of this sort generate noise which
often interferes with communications equipment and the sending and
receiving of documents.

CONNECTION OF THE EQUIPMENT
This equipment complies with Part 68 of the FCC rules. On the rear panel of this
equipment is a label that contains, among other information, the FCC
Registration Number and Ringer Equivalence Number (REN) for this equipment.
If requested, this information must be given to the telephone company. This
equipment may not be used on coin service provided by the telephone company.
Connection to party lines is subject to state tariffs.
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IN CASE OF EQUIPMENT MALFUNCTION
Should any malfunction occur which cannot be corrected by the procedures
described in this User’s Manual, disconnect the equipment from the telephone line
or unplug the power cord. The telephone line should not be reconnected or the
power cord plugged in until the problem is completely resolved. Users should
contact Canon Authorized Service Facilities for servicing of equipment.
Information regarding Authorized Service Facility locations can be obtained by
calling the Canon Computer Systems Customer Care Center. (See page 1-2 for
details.)

RIGHTS OF THE TELEPHONE COMPANY
Should the equipment cause harm to the telephone network, the telephone
company may temporarily disconnect service. The telephone company also retains
the right to make changes in facilities and services which may affect the operation
of this equipment. When such changes are necessary, the telephone company is
required to give adequate prior notice to the user.

WARNING
Do not make any changes or modifications to the equipment unless otherwise
specified in the manual. If such changes or modifications should be made, you
could be required to stop operation of the equipment.

N This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy
and, if not installed, and used in accordance with the instructions, may cause
harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one of the
following measures:
● Reorient or relocate the receiving antenna.
● Increase the separation between the equipment and receiver.
● Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.
● Consult the dealer or an experienced radio/TV technician for help.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any
person to use a computer or other electronic device to send any message via a
telephone fax machine unless such message clearly contains in a margin at the top
or bottom of each transmitted page or on the first page of the transmission, the
date and time it is sent and an identification of the business or other entity, or
other individual sending the message and the telephone number of the sending
machine or such business, other entity, or individual.

To automatically enter this information into your MultiPASS L6000, follow the
instructions in your Quick Start Guide.
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USERS IN CANADA

PRE-INSTALLATION REQUIREMENTS FOR CANON
FACSIMILE EQUIPMENT
A. Location

Supply a suitable table, cabinet, or desk. See Appendix A for the unit’s
dimensions and weight.

B. Order Information
1. Provide only a single-line to touch-tone or rotary telephone set

terminated with a standard 4-pin modular phone plug. (Touch-tone is
recommended if available in your area.) 

2. Order an RJ11-C modular jack (USOC code), which should be installed
by the phone company. If the RJ11-C jack is not present, installation
cannot occur.

3. Order a normal business line from your telephone company’s business
representative. The line should be a regular voice grade line or equivalent.
Use one line per unit.

DDD (DIRECT DISTANCE DIAL) LINE
or
IDDD (INTERNATIONAL DIRECT DISTANCE DIAL) LINE IF
YOU COMMUNICATE OVERSEAS

N Canon recommends an individual line following industry standards [e.g., the 2500
(touch-tone) or 500 (rotary/pulse dial) telephones]. A dedicated extension off a
PBX unit without “Camp On” signals is also permissible with your MultiPASS
L6000. Key telephone systems are not recommended because they send non-
standard signals to individual telephones for ringing and special codes, which may
cause a fax error.

C. Power Requirements
The power outlet should be a three-prong grounded receptacle (Single or
Duplex). It should be independent from copiers, heaters, air conditioners, or
any electric equipment that is thermostatically controlled. The rated value is
120 volts and 15 amperes. The RJ11-C modular jack should be relatively
close to the power outlet to facilitate installation. 

NOTICE
The Industry Canada label identifies certified equipment. This certification means
that the equipment meets telecommunications network protective, operational and
safety requirements as prescribed in the appropriate Terminal Equipment
Technical Requirements document(s). The Department does not guarantee the
equipment will operate to the user’s satisfaction.
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Before installing this equipment, users should ensure that it is permissible to be
connected to the facilities of the local telecommunications company. The
equipment must also be installed using an acceptable method of connection. The
customer should be aware that compliance with the above conditions may not
prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative
designated by the supplier. Any repairs or alterations made by the user to this
equipment, or equipment malfunctions, may give the telecommunications
company cause to request the user to disconnect the equipment.

Users should ensure for their own protection that the electrical ground
connections of the power utility, telephone lines and internal metallic water pipe
system, if present, are connected together. This precaution may be particularly
important in rural areas.

CAUTION
Users should not attempt to make such connections themselves, but should
contact the appropriate electric inspection authority, or electrician, as appropriate.

The Ringer Equivalence Number (REN) assigned to each terminal device provides
an indication of the maximum number of terminals allowed to be connected to a
telephone interface. The termination on an interface may consist of any
combination of devices subject only to the requirement that the sum of the Ringer
Equivalence Numbers of all the devices does not exceed 5.

CANON CANADA INC.
1-800-263-1121

24 HOURS A DAY, SEVEN DAYS A WEEK

Safety Information
Laser Safety

The MultiPASS L6000 complies with 21 CFR Chapter 1 Subchapter J as a
Class 1 laser product under the U.S. Department of Health and Human
Services (DHHS) Radiation Performance Standard according to the
Radiation Control for Health and Safety Act of 1968. This means that the
MultiPASS L6000 does not produce hazardous laser radiation.

Because radiation emitted inside the MultiPASS L6000 is completely
confined within protective housings, and external covers, the laser beam
cannot escape from the machine during any phase of user operation.
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CDRH Regulations
The Center for Devices and Radiological Health (CDRH) of the U.S.
Food and Drug Administration implemented regulations for laser products
on August 2, 1976. These regulations apply to laser products manufactured
from August 1, 1976. Compliance is mandatory for products marketed in
the United States.

Use of controls, adjustments or performance of procedures other than
those specified in this User’s Manual may result in hazardous radiation
exposure.

This label is attached to the laser scanner unit inside the MultiPASS and is
not in an area that you can access.

Using Your Documentation
The following documentation is supplied with the MultiPASS™ L6000 to
help you use your new Canon multi-talented laser printer. 

Quick Start Guide
This booklet describes how you unpack, set up, and start using your
MultiPASS L6000. It includes how to install the software that comes with
the MultiPASS, including the MultiPASS Printer Driver, MultiPASS
Desktop Manager for Windows® 95, and ScanGear™ for MultiPASS. The
software enables you to use all the features of the MultiPASS L6000—laser
printing, copying, scanning, and PC faxing.
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UserÕs Manual
This manual offers detailed information on how to operate your
MultiPASS L6000. It includes how to use the MultiPASS as a printer, how
to send and receive faxes, and how to copy and scan documents. It also
includes maintenance, troubleshooting, and specifications.

Conventions
This User’s Manual uses the following conventions to alert you to
information that will help you operate the MultiPASS L6000 correctly and
safely:

N Notes provide advice or suggestions regarding the use of the MultiPASS.

C Cautions alert you to operations that could cause damage to your hardware
or software, or cause injury to yourself.

Distinctive typefaces identify the buttons you press, the lights on the
operator panel, and any commands you enter at your computer.

❍ The buttons you press appear in this typeface: START/COPY.

❍ The names of lights you see appear in this typeface: ALARM.

❍ What you see in the LCD display appears in this typeface:  
PLEASE WAIT.

❍ When you type something on your computer, it appears in this
typeface: DIR/P .
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Chapter 1 Introduction 1-1

Thank you for purchasing the Canon MultiPASS™ L6000—the multi-
talented laser printer for your home office and the whole family. We 
are sure that your MultiPASS L6000 will provide all you need in one
machine: laser printer, plain paper fax, PC fax, copier, and scanner. 

This chapter introduces you to the MultiPASS L6000. It includes:

❍ Supplies and accessories

❍ Customer Care Center

❍ Important safety instructions

❍ Examining the main components of the unit

❍ Using the operator panel

❍ Loading paper in the multi-purpose tray

❍ Preparing documents for faxing, copying, or scanning

❍ Identifying your documents
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Supplies and Accessories
Canon has an extensive dealer network equipped to offer you supplies 
as you need them. To find a dealer near you, call the Canon Referral
Service at 1-800-848-4123.

If supplies are not available from your local dealer, you can order directly
from Canon by calling 1-800-385-2155. 

Toner Cartridges

Your MultiPASS L6000 comes with one FX-3 Toner Cartridge.

N For optimum printing results, Canon recommends that you use only the
Canon FX-3 Toner Cartridge with your MultiPASS L6000.

Customer Care Center
Canon Computer Systems, Inc. offers a full range of customer technical
support options including*:

❍ 24-hour, 7-day-a-week, toll-free automated support for troubleshooting
issues on most current products (1-800-423-2366)

❍ Speak to a technician free of service charge (currently Monday through
Friday, 8:00 A.M. to 10:00 P.M. EST and Saturday, 
12:00 P.M. to 6:00 P.M. EST, excluding holidays) for products 
still under warranty** (1-757-413-2848)

❍ Speak to a technician (currently $24.99) during holidays and
days/hours not listed above regarding urgent product questions or for
products no longer under warranty (1-800-423-2366)

❍ E-mail support via the Canon Computer Systems, Inc. Web site
(www.ccsi.canon.com)

❍ 24-hour, toll-free Fax Retrieval System (1-800-526-4345)

❍ 24-hour Bulletin Board Service (1-757-420-2000)

*Support program specifics subject to change without notice.
**Refer to individual product information for warranty details.
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Canon Canada
Customer support for Canadian residents is available 24 hours a day (seven
days a week) at 1-800-263-1121.

In other countries, please contact your Canon dealer.

Servicing the MultiPASS L6000

The Canon MultiPASS L6000 is designed with the latest technology 
to provide trouble-free operation. The warranty card that comes with your
system describes Canon’s limited warranty, which includes the
InstantExchange warranty program. Be sure to read the warranty
information to find out about the different service options available 
to you.

Save the warranty and keep your sales receipt for proof of purchase. In the
event that your MultiPASS needs servicing, you will need your proof of
purchase to obtain warranty service.

Be sure to register your new product. This will help Canon give you better
support and warranty service. You can register electronically during
installation; see your Quick Start Guide for details. You can also fill out the
Registration card and fax it or mail it in. See the Registration card for
details.

If you seem to have a problem, try to solve it by referring to the
troubleshooting information in Chapter 10. If you cannot solve the
problem, contact the Canon Computer Systems Customer Care Center
(see previous page for details). 

Important Safety Instructions
Read these safety instructions and refer to them later if you have any
questions.

C Except as explained in this manual, do not attempt to service the
MultiPASS L6000 yourself. Opening and removing interior covers may
expose you to dangerous voltage points or other risks. Refer all servicing to
a Canon Authorized Service Facility (ASF). Call the Customer Care Center
for details.

❍ Follow all warnings and instructions marked on the MultiPASS and
inside the front cover.
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❍ Place the MultiPASS on a sturdy level surface. Do not place it on an
unstable cart, stand, or table. If the unit falls, it could be seriously
damaged.

❍ Do not use the MultiPASS near water. If you spill liquid on or into
the unit, unplug it immediately and call the Customer Care Center.

❍ Slots and openings in the unit and on the back or bottom are provided
for ventilation. To ensure reliable operation of the MultiPASS and to
protect it from overheating, do not block or cover these openings. Do
not block the openings by placing the unit on a bed, sofa, rug, or other
similar surface. Do not place the unit near a radiator, nor in a closet or
built-in cabinet unless proper ventilation is provided.

❍ Operate the MultiPASS only from the type of power source indicated
on the unit’s label. If you are unsure of the type of power available,
consult your dealer or local power company.

❍ Do not allow anything to rest on the power cord, and do not locate
the MultiPASS where the cord will be walked on. Make sure the power
cord is not knotted or kinked.

❍ Do not push metal objects of any kind into the slots or openings on
the cabinet. This could result in a risk of fire or electric shock. 

❍ Do not allow small objects (such as pins, paper clips, or staples) to fall
into the MultiPASS. If something does fall into it that you cannot
remove, unplug the unit immediately and call the Customer Care
Center.

❍ Unplug this product from the wall outlet and call the Customer Care
Center if any of the following conditions exist:

• The power cord or plug is damaged or frayed.

• Liquid is spilled into the unit, or if the unit is exposed to rain 
or water.

• Smoke, unusual noises, or odors come from the unit.

• The unit has been dropped or the cabinet has been damaged.

• The unit does not operate normally when you have followed the
operating instructions. Adjust only those controls that are covered
by the operating instructions in the Quick Start Guide and this
User’s Manual. Improper adjustment of other controls may result
in damage and may require extensive work by a qualified
technician to restore the product to normal operation.
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Main Components of the MultiPASS L6000
Before using the MultiPASS L6000, it’s a good idea to familiarize yourself
with the components and understand their functions.

Front View

SUPPORT TRAY
HOLDS DOCUMENTS 
AS THEY FEED INTO ADF

PAPER GUIDES
ADJUST TO WIDTH 
OF PAPER

AUTOMATIC DOCUMENT
FEEDER (ADF) 
HOLDS DOCUMENTS 
TO BE SCANNED (UP
TO 20 SHEETS)

OPERATOR PANEL
USE TO CONTROL
THE MultiPASS L6000

MULTI-PURPOSE TRAY
HOLDS 100 SHEETS
OF PLAIN PAPER

SUPPORT TRAY
HOLDS PRINTED DOCUMENTS AS
THEY EXIT IN FACEDOWN POSITION

PAPER DELIVERY SELECTOR
DETERMINES WHETHER
PAPER EXITS FACEUP OR
FACEDOWN

OUTPUT TRAY AND EXTENSION
HOLDS PRINTED DOCUMENTS AS
THEY EXIT THE MultiPASS L6000 
IN FACEUP POSITION

FRONT COVER

PAPER REST
SUPPORTS PAPER
STACKED IN THE
MULTI-PURPOSE TRAY

FACEUP DELIVERY SLOT
PAPER EXITS IN FACEUP POSITION
IN NON-COLLATED SEQUENCE

FACEDOWN DELIVERY
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Back View

Inside the MultiPASS
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TELEPHONE/ ANSWERING
MACHINE JACK

BI-DIRECTIONAL
PARALLEL PORT

RELEASE LATCH

POWER
CONNECTOR

M
P

_L
60

00
_B

A
C

K

FIXING ASSEMBLY

PAPER RELEASE LEVER

FRONT COVER

TRANSFER CHARGING
ROLLER

FX-3 TONER CARTRIDGE
COMPARTMENT

M
P

_L
60

00
_I

N
S

ID
E



Chapter 1 Introduction 1-7

MP-L6000—USERS MANUAL/V000/12-97

In
tr

od
uc

tio
n

Using the Operator Panel
This section presents a brief description of the operator panel on the
MultiPASS L6000.

Document feed lever
Set this lever to the left ( ) for automatic feed or to the right ( ) for
manual document feed.

RECEIVE MODE button
Press to change the Receive Mode: Manual mode, FaxOnly mode, Answer
Machine mode, or FaxTel mode. The Receive Mode set during installation
overrides this setting every time the MultiPASS Background is turned on.

LCD display
Displays messages and prompts during operation. Displays selections, text,
numbers, and names when registering information.

RESOLUTION button
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8 ARROW BUTTONS

6 ONE-TOUCH SPEED
DIAL/FUNCTION
BUTTONS



Press to select the Resolution the MultiPASS will use for the document
you are faxing or copying.

ALARM light
Flashes when an error occurs, when the MultiPASS is out of paper or ink,
or when received faxes are stored in memory.

One-touch Speed Dial/Function buttons
Use for one-touch speed dialing, entering user information, and printing
documents stored in memory.

FUNCTION button
Use to register user settings or to print faxes stored in the MultiPASS
L6000’s memory.

Arrow buttons
Use to scroll through menu selections, or to move the cursor when
registering data.

STOP button
Press to cancel sending, receiving, or any other operation.

START/COPY button
Press to begin sending, receiving, copying, or other operations, or to select
functions when registering information.

CODED DIAL button
Press this button (followed by a two-digit code) to dial a number that you
have registered for coded speed dialing.

REDIAL/PAUSE button
Press to redial the last number that was dialed using the number buttons,
or to enter pauses between digits when dialing fax numbers.

Numeric buttons
Use these buttons to enter numbers and names when entering information,
and to dial fax/telephone numbers that are not registered for automatic
dialing.
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Loading Paper in the Multi-purpose Tray
The paper you load in the multi-purpose tray is used for printing
documents or for incoming faxes. You can use any plain paper (such 
as copier paper).

When the message LOAD PAPER appears in the LCD display, you need to
add paper to the multi-purpose tray. This tray holds approximately 100
sheets of plain paper.

❍ For best results, fan the paper before loading it.

❍ Always fan a stack of paper along the edge that will feed
into the MultiPASS first.

❍ Stack the paper so the leading edge and sides are even.

Open the paper
guides to the

approximate width
of the 

stack of paper.

2

Fan the paper.
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❍ Insert the paper with the print side facing you and top edge
first into the multi-purpose tray. (The multi-purpose tray is
behind the manual feed slot.)

❍ Insert the stack until it stops, but do not force it in.

❍ Make sure there is no space between the paper guides and
the stack of paper.

Your MultiPASS L6000 is now ready to print.

Adjust the 
paper guides 
to the width 
of the paper.

4

Insert the stack 
of paper.
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Preparing Documents for Faxing, 
Copying, or Scanning

You can use the MultiPASS L6000 to fax, copy, or scan documents that are
printed on standard letter, legal, or A4 size paper. Follow these guidelines
to prepare your documents.

❍ Do not attempt to feed the following types of documents into the
MultiPASS:

• wrinkled or creased paper

• curled or rolled paper

• torn paper

• carbon-paper or carbon-backed paper

• coated paper

• onion skin or thin paper

❍ Remove all staples, paper clips, and the like before feeding the
document.

❍ Make sure any glue, ink, or correction fluid on the paper is completely
dry before feeding the document.

❍ Make a photocopy of any document that will not feed into the
MultiPASS. You can then feed the copy.

❍ Do not feed documents with pages that are different sizes or of
different thicknesses.
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Loading the Document 

You can load up to 20 letter or A4 size sheets and up to 10 legal size sheets
at a time into the Automatic Document Feeder (ADF).

❍ For a multiple-page document, fan the sheets and tap the
document on a flat surface to even the stack.

❍ Adjust the document guides to the width of the document.Adjust the
document 

guides.

2

Stack your
documents.

1
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❍ Gently insert the document facedown (letterhead first) into
the ADF until it stops.

The document is now ready for scanning. The MultiPASS automatically
feeds the pages one by one from the bottom of the stack.

If you have problems feeding a multiple-page document, remove the
document and re-stack it tapping the edges on a flat surface. If problems
persist, feed one page at a time.

N Wait until your document has been scanned completely before inserting a
new document.

Feed the document.
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Adding Pages to the Document

If you want to add pages while the MultiPASS is sending a document, wait
until the last page is feeding into the MultiPASS and then insert the new
sheets. Insert the first new page so it overlaps the last page by about one
inch (2.5 cm).

❍ Always wait until the last page is being fed into the MultiPASS before
you add new pages. 

❍ Insert the new page so that it overlaps the last page by about an inch
(2.5 cm). 

Setting the Document Feed Lever

You use the document feed lever on the ADF to select multiple documents
( ) or single sheets ( ). 
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Always set the document feed lever to single sheets and manually feed the
following types of documents:

❍ Thick paper

❍ Thin paper

❍ Small documents (postcards, business cards)

❍ Documents with uneven surfaces

❍ Photographs

❍ Special types of paper

Identifying Your Documents
When sending a document, the following information is printed out 
by the receiving fax: your fax number, your name, and the current date
and time. This information is called your TTI (Transmit Terminal
Identification) and appears at the top of the faxed document in 
small type.

N In the United States, you are required by FCC regulations to include this
information every time you send a fax. 

By identifying the documents you send, the receiving party will recognize
your fax messages at a glance. The illustration below shows a sample
document with the identifying information.

12 /01 /95 10 :12 FAX  321   456   7777 CANON  U . S . A . →→→ CANON  USA  FAX 01 /01

THE SLEREXE COMPANY LIMITED 
SAPORS  LANE  - BOOLE - DORSET - BH  25  8  ER

Our Ref. 350/PJC/EAC

TELEPHONE   DOOLE  ( 945  13 ) 51617     TELEX 123456

.

THE PAGE NUMBER
THE NAME OF THE
PARTY WHO IS
RECEIVING THE
DOCUMENT

YOUR NAME OR
COMPANY NAME

YOUR FAX/
TELEPHONE
NUMBER

THE DATE AND
TIME YOU SENT
THE DOCUMENT

02/06/98  10:10   FAX 800 526-4345    CANON FAX BACK    JOHN DOE

ID
 Y
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U
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 D

O
C

001
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The top line includes the name of the receiving party if you send the
document using one-touch speed dialing, coded speed dialing, or group
dialing and you registered the party’s name. It also includes the page
number.

N You entered your fax header information during the MultiPASS
installation procedure. If you followed the installation procedure, this
information will be printed on the top of your outgoing faxes. If you did
not install the MultiPASS Desktop Manager, see Appendix B, Using the
MultiPASS L6000 as a Stand-alone Fax, for details on how to enter this
information.
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This chapter describes how 
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❍ Printing a document

❍ Printer setup within Wi

❍ The paper path

❍ Selecting paper delivery

❍ Loading paper in the m

❍ Loading envelopes in th

❍ Loading paper manuall

Paper Handling
Your MultiPASS produces l
including cotton bond and 
laser papers. However, the p
Be sure to test a type of pap

The MultiPASS supports pa
orientation. You can use reg
typical letterhead. Always u
damaged edges.
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When selecting or loading paper, please remember the following:

❍ Attempting to print on damp, curled, wrinkled, or torn paper can
cause paper jams and poor print quality.

❍ Use cut-sheet paper only. You cannot use multipart paper.

❍ Highly textured or extremely smooth or shiny paper does not 
print well.

❍ The laser printing process uses high temperatures to fuse toner to the
paper. Use paper that will not melt, vaporize, discolor, or emit
dangerous fumes at temperatures near 338°F (170°C). For example, do
not use vellum paper in a laser printer. Make sure any letterhead or
colored paper you use can withstand high temperatures.

❍ Make sure the paper is free of dust, lint, and oil stains.

❍ To keep the paper from curling, do not open paper packs until you are
ready to use the paper. Store unused paper from opened packs in a
cool, dry location in the original packaging.

❍ Your MultiPASS is factory-set to use letter-size paper. Whenever you
change the size of the paper loaded in the MultiPASS, you must also
set the MultiPASS Printer Driver to the new size.

❍ Do not use thicker paper than meets the specifications for this printer.
See Appendix A for details.

❍ Do not print on both sides of the paper. This may cause several sheets
to feed at one time.

Installing a Printer Driver
Before you can use any type of printer with your computer, you must
install a printer driver. The printer driver tells the computer what kind of a
printer you are using. The printer driver also controls the various settings,
such as print quality and paper type. You define these settings within the
printer driver, and the printer driver then communicates the settings to
both the computer and the printer.

You must install the MultiPASS Printer Driver and the MultiPASS
Desktop Manager for Windows 95 before you can use the MultiPASS
L6000 as a printer for your computer. See your Quick Start Guide for
details on how to install this software.
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Printing a Document
This procedure describes the general steps required for printing from
various Windows applications. The exact steps for printing a document
may vary depending on the application program you are using. Refer 
to your software application’s documentation for the exact printing
procedure.

❍ Start the program you use to create documents, and open
the document you want to print.

❍ From the File menu, choose Print Setup. 

❍ Click on the Properties or Setup button if you want to
make any adjustments as appropriate for printing your
document. (See Printer Setup Within Windows on the
following page for details.)

❍ Select OK to close the Print Setup dialog box.

❍ After making any necessary changes to the printing
parameters, select OK to start the print job.

Choose Print 
from the

File menu.

3

Make sure  the
Canon MultiPASS

L6000 Printer is 
selected as your
default printer.

2

Start your
application.
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Printer Setup Within Windows
You can use the MultiPASS with all your Windows 95 applications. 
Be sure to set the MultiPASS L6000 as the default printer for all your
Windows operations.

Most of your printing operations are controlled by your software
application. The following sections describe how you set certain options
directly from the printer driver; you only need this information if your
application does not control printing.

Opening the Printer Properties Dialog Box 
in Windows 95

You can open the Properties dialog box in one of the following ways:

❍ From within any Windows application, you can select the Print or
Print Setup command.

❍ From the Printers folder, you can select the printer and then select the
Properties command from the File menu.

❍ From the Printers folder, you can select the printer, click the right
mouse button, and then select Properties from the drop down list.

Using the Printer Driver in Windows 95

The printing options are displayed on these Windows 95 tabs: General,
Details, Paper, Graphics, and Setting. See Using the Windows Tabs section
(page 2-5) for details.

N For detailed information on any of the printing options, you can use the
Windows 95 on-line Help in the following ways:

❍ Use the right mouse button to click an item on the screen; then 
click the What’s This? command.

❍ Click ? and then click an item.

❍ Press F1.
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Using the Windows Tabs

The MultiPASS Printer Driver for Windows has several tabs from which
you can select your printing options and learn about your printer driver as
well as your MultiPASS L6000.

❍ General
This tab allows you to add comments regarding the printer driver and
print a test page or a separator page. (You see this tab when 
you open the Properties dialog box from the Printers folder, not 
from within a Windows application.)

❍ Details
This tab allows you to specify printer port settings, spool settings, and
time-out settings. (You see this tab when you open the Properties
dialog box from the Printers folder, not from within a Windows
application.)

DEFINE THE
PRINTER’S PORT

SPECIFY THE
PRINTER DRIVER

SPECIFY TIMEOUT
SETTINGS

SPECIFY PORT
SETTINGS

SPECIFY SPOOL
SETTINGS

L6
00

0_
D

R
2

L6
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0_
D

R
1

ADD COMMENTS
HERE

PRINT A
SEPARATOR
PAGE

PRINT A TEST PAGE
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❍ Paper
This tab allows you to specify page orientation, paper size, and type of
print media. 

❍ Graphics
This tab allows you to specify print quality and print model. 

SPECIFY TYPE
OF PAPER

SPECIFY PAGE
ORIENTATION

SPECIFY SIZE
OF PAPER

SPECIFY
PAPER FEED
METHOD

SPECIFY PRINT
QUALITY:

• 300 DPI (DEFAULT)—
DRAFT MODE

• 600 DPI—HIGHER
QUALITY PRINT BUT
SLOWER PRINT
SPEED

SELECT A PRINT MODEL:

• AUTOMATIC—PRINTER 
SELECTS SETTINGS 
FOR HIGHEST QUALITY

• GRAPHICS AND TEXT—
FOR PRINTING 
DOCUMENTS THAT
CONTAIN SOLID 
GRAPHICS AND TEXT

• PHOTO—FOR PRINTING 
SCANNED PHOTOGRAPHS
OR BITMAPPED IMAGES

• CUSTOM—ALLOWS YOU 
TO SPECIFY HALFTONING 
AND INTENSITY IN THE 
CUSTOM SETTING 
DIALOG BOX
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❍ Setting
This tab allows you to turn on or off the Setup Analyzer and the Toner
Saving feature. It also allows you to save up to four custom print
settings. 

Be sure to use the Windows 95 Help features to find out more about the
options on these screens.

Specifying Your Printing Options

Be sure to use your on-line help to find out about the settings available for
each printing option.

❍ To move between the Windows tabs, click on any of the tabs.

❍ To select the settings and exit, click the OK button.

❍ To cancel your setting selections on a tab, click the Cancel button.

❍ To save your settings without exiting, click the Apply button.

❍ To access the Help file, click on the Help button.

❍ When you move the mouse cursor over one of the printing options, a
help message appears at the bottom of the tab.

ENABLE OR
DISABLE SETUP
ANALYZER

SAVE YOUR
CUSTOM PRINT
SETTINGS

L6
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0_
D

R
5

ENABLE OR
DISABLE TONER
SAVING FEATURE
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The Paper Path
Understanding how paper feeds through the MultiPASS will help you to
determine how to load paper and handle paper jams.

The page travels first to the FX-3 Toner Cartridge. Here a laser beam
“draws” the print image on the drum, then the drum applies toner to the
page. The page then travels to the fixing assembly where the toner is fused
to the page. The page then exits the unit from the front or top.

When you are printing, follow these guidelines:

❍ Always set the paper delivery selector before starting to print.

❍ Do not change the paper delivery selector while a document is
printing. This may cause a paper jam to occur.

❍ Make sure there is enough room for the paper to exit from the 
faceup delivery slot.

❍ Do not pull the paper as it comes out of the unit.

❍ When using faceup delivery, be sure to remove each sheet of paper
from the output tray. 

AUTOMATIC DOCUMENT FEEDER
RECORDING
PAPER—MULTI-
PURPOSE TRAY

TONER
CARTRIDGE

MANUAL FEED
SLOT

P
A

P
E

R
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A
T

H

FACEDOWN DELIVERY

FACEUP DELIVERY
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Selecting Paper Delivery
Received faxes, copies, and printed documents can be delivered through
the faceup or facedown delivery slot. Choose paper delivery according to
the job the MultiPASS is performing and the type of print media you are
using.

Facedown Delivery

Use facedown delivery for most jobs and when using plain paper only (17
to 24 lbs or 64 to 90 g/m2). Printed pages are stacked in the order printed
in the facedown delivery slot. This slot holds up to 50 sheets of plain paper
(20 lb or 75 g/m2).
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FACEDOWN
DELIVERY

FACEUP DELIVERY

PAPER DELIVERY
SELECTOR
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❍ Make sure the paper delivery selector is set up to the mark.

Faceup Delivery

Use faceup delivery when printing on media other than plain paper, such
as transparencies, labels, thick paper (up to 28 lb or 105 g/m2), or
envelopes. With faceup delivery, the sheet or envelope travels straight
through the unit without bending, and thus prevents curling.

❍ Make sure the paper delivery selector is set down to the mark.

❍ Make sure the paper output tray is extended.

❍ Be sure to remove each sheet as it exits the faceup delivery slot.

FACEDOWN DELIVERY
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Loading Paper in the Multi-purpose Tray
You can stack up to approximately 100 sheets of plain paper (20 lb 
or 75 g/m2) in the multi-purpose tray. The multi-purpose tray holds letter,
legal, and A4 size paper, provided that its weight is 24 lb 
(90 g/m2) or less.

To load the paper, follow the steps starting on page 1-9.

Loading Envelopes in the Multi-purpose Tray

❍ Arrange the stack of envelopes (up to 7) on a firm surface
and press down firmly on the edges to make the folds crisp. 

❍ Press around the envelopes to remove any curls and expel
air from inside the envelopes.

❍ Press firmly on the area that corresponds to the edges of the
flap. 

❍ Make sure the print side is facing you.

❍ Open the paper guides to the approximate width of the
stack of envelopes.

Insert the stack 
of envelopes 
in the multi-
purpose tray.

2

Prepare the
envelopes.

1

FLAP

PRESS DOWN FIRMLY ON
THE EDGES OF THE FLAP
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Adjust the 
paper guides to the
stack of envelopes.

4

Insert the stack
until it stops, but

do not force it.

3
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❍ Be sure to use faceup delivery when printing on envelopes.

Your MultiPASS is now ready to print. 

N You can change the orientation of the envelopes through your application
software. Check the orientation before printing. 

Move the paper
delivery selector

down to the  mark.

5

FACEUP DELIVERY
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Loading Paper Manually
You can load paper manually, one sheet at a time, using the manual feed
slot. You can load plain paper (17 to 28 lb or 64 to 105 g/m2),
transparencies, labels, envelopes, and other special papers.

❍ Adjust the paper guide to the approximate width of the
sheet of paper.

❍ Make sure the print side is facing you and the top edge goes
into the slot first.

❍ Insert the sheet until it stops, but do not force it in.

Insert one sheet
into the manual

feed slot.

2

Open the 
paper guides.
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❍ Make sure there is no space between the paper guides and 
the sheet.

❍ Be sure to use faceup delivery when printing on media
other than plain paper.

Your MultiPASS is now ready to print. 

N ❍ If you insert a sheet into the manual feed slot when there is
paper stacked in the multi-purpose tray, the unit will feed
the sheet from the manual feed slot.

❍ Insert a sheet in the manual feed slot only when the
previous sheet has come out from the delivery slot. If you
insert a single sheet before the previous one has exited, a
paper jam may occur.

❍ If you have difficulty feeding a type of paper in the manual
feed slot, try feeding it through the multi-purpose tray—
one sheet at a time.

Move the paper
delivery selector

down to the 
mark.

4

Adjust the paper
guides to the sheet

of paper.
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The MultiPASS Desktop Manager is a full-featured Windows application
that enables you to use your MultiPASS L6000 from your computer. The
MultiPASS Desktop Manager coordinates the printing, PC faxing, and
scanning functions of the MultiPASS L6000. Its features include:

❍ Printing, PC faxing, and scanning control functions

❍ Manipulating and editing the faxed or scanned documents

❍ An Address Book where you store the names and fax numbers for
individuals and groups to whom you repeatedly send faxes

❍ Folders that hold your faxes and scanned documents

This chapter describes:

❍ Starting the MultiPASS Desktop Manager

❍ Exploring the MultiPASS Desktop Manager window

❍ Using the Desktop Manager folders

❍ Viewing documents in the Desktop Manager

❍ Setting up the Address Book

❍ Setting up speed dialing

❍ Using the Fax Log

N Your MultiPASS L6000 is designed to be used with the MultiPASS
Desktop Manager. To use all the outstanding features of the MultiPASS
requires use of the Desktop Manager. To use the unit as a stand-alone 
fax machine, see Appendix B.

3Using the MultiPASS 
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Starting the MultiPASS Desktop Manager
When you start Windows or open the Desktop Manager, the MultiPASS
Background is automatically started as well. The MultiPASS Background
enables and monitors the communication between the Desktop Manager
and the MultiPASS L6000.

When you exit the Desktop Manager, you close only the Desktop Manager
window. Any documents you have set up to PC fax or print remain active.
If open, the MultiPASS Status Monitor, which tracks the progress of your
active jobs, also remains open and active.

After it is installed, the MultiPASS Desktop Manager is an option on the
Canon MultiPASS L6000 menu. 

❍ Click the Start button and point to Programs.

❍ Point to Canon MultiPASS L6000 and then click MultiPASS Desktop
Manager.
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Exploring the MultiPASS Desktop 
Manager Window

When you start the MultiPASS Desktop Manager, you see a screen similar
to this:

Menu Bar
The menu bar contains commands that enable you to perform the various
Desktop Manager tasks. Some of the commands can also be accessed by
their corresponding icons on the toolbar or command bar.

Toolbar
The toolbar provides quick access to certain Desktop Manager tasks. When
a task is unavailable, the toolbar button appears dimmed.

Pause the mouse over a button to see a description of the button. These are
called ToolTips.

MENU BAR

TOOLBAR

FOLDERS LIST

COMMAND BAR

STATUS LINE

WORK
AREA
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FAX MEMO SETUP
ADDRESS
BOOK

CONTENTS-
SENSITIVE
HELP

HELP
CONTENTS

STOPSCAN FAX LOG

DELETE
LIST
VIEW

REMOVE
TOP
PAGE MERGE

SPLITDOCUMENT
VIEW
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Folders List
The folders list contains folders that store your fax and scan documents.
The list contains both system-defined folders, provided automatically when
you install the software, and user-defined folders.

System-defined folders include In Box, Out Box, Scan, Sent Fax, and
Trash. User-defined folders are folders you can create yourself.

Work Area
The work area appears to the right of the folders list and displays one of
the documents within the open folder. The documents are displayed either
as a graphic thumbnail of each document or as a list of the documents.

You can adjust the width of the work area using the mouse pointer to
move the border between the work area and folders list.

Command Bar
The command bar contains command icons, which enable you to perform
a variety of tasks.

You can use the command icons as follows:

❍ Drag a document to the command icon
For example, you can drag a document to the Print command icon to
start printing the document. The command icon signals its acceptance
of the item by lighting up.

If a document is dragged to a command icon that cannot perform the
task, the mouse pointer displays as a no-entry icon (a red circle with a
diagonal bar drawn through it).

❍ Click a document and then click the command icon
This method activates the command for the selected document, as
though the item had been dragged to the command icon.

MP L6000—USERS MANUAL/V000/12-97
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Status Line
The status line displays information about the selected folder or document,
such as the name of the folder or document and its creation date. You
cannot edit this information.

If the Address Book is open, the status line displays information about the
selected Address Book entry.

Closing the Desktop Manager

When you exit the Desktop Manager, you close only the Desktop Manager
window. Any documents you have set up to PC fax or print remain active.
If open, the MultiPASS Status Monitor, which tracks the progress of your
active jobs, also remains open and active.

To close the Desktop Manager, click Exit from the File menu.

N The MultiPASS Background will remain open.

Using the Desktop Manager Folders
The Desktop Manager stores and organizes your fax and scan documents
in folders. Only one folder can be open at a time. When you open another
folder, the current folder automatically closes.

System-defined Folders

When you install the Desktop Manager, these system-defined folders are
automatically available: In Box, Out Box, Scan, Sent Fax, and Trash.

❍ With the exception of the Trash folder, only the Desktop Manager can
place documents in the system-defined folders, based on faxes sent or
received, or images scanned. You can only rename, copy, move, or
remove documents from the folders.

❍ Including the Trash folder, the system-defined folders cannot be
deleted or renamed.
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A document remains in a system-defined folder until you move it to a
user-defined folder, or delete it. 

In Box 
The In Box folder stores all incoming faxes received by the Desktop
Manager. Each received fax displays a system-assigned name—fax nnnn,
where nnnn is a number of up to four digits which is unique within the
Desktop Manager. You can later change the name to something more
descriptive.

Out Box 
The Out Box folder is a chronological list of jobs you want to process. The
jobs consist of faxes to be sent, or fax or scan documents to be printed
from the Desktop Manager. A job in the Out Box folder is a copy of the
original document, not the original document itself. 

The list of jobs in the Out Box folder is sorted by order of action, with the
next document to be printed or faxed at the head of the list. The job
currently being processed—the active job—displays in a separate row at
the top of the list, above the column titles.

You can select a job in the list to review information about that job in the
Status Bar, including the original document from which the job came and
a reason if the job failed.

Each job in the Out Box folder displays a system-assigned name: fax nnnn
for a fax job, and print nnnn for a print job, where nnnn is a number of
up to four digits which is unique within the Desktop Manager. You cannot
rename a job in the Out Box folder.

Scan 
The Scan folder stores all images you scan with the MultiPASS from the
Desktop Manager. Each document displays a system-assigned name: scan
nnnn, where nnnn is a number of up to four digits which is unique within
the Desktop Manager. You can later change the name to something more
descriptive.

Sent Fax
The Sent Fax folder contains all documents that have been successfully sent
as faxes. If the fax had not been marked for deletion after sending, the sent
fax is automatically moved from the Out Box folder (where 
the fax job is processed) to the Sent Faxes folder. By having sent faxes
moved to their own folder, you can better track your completed fax
communications and reserve the Out Box folder for jobs to be processed.

MP L6000—USERS MANUAL/V000/12-97
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Trash 
The Trash folder holds any documents that you want to delete. Once you
drag a document from another folder to the Trash folder, you can hold the
document until you are ready to delete it.

N If you select a document and press the Delete key, or if you drag a
document to the Delete icon, the document is deleted immediately. 
It is not stored in the Trash folder.

User-defined Folders

You can create up to 255 folders for your own use. These folders are listed
immediately following the system-defined folders.

When you install the Desktop Manager software, you are automatically
provided an initial user-defined folder named My Folder. You can use this
folder immediately for storing documents moved from the system-defined
folders.

If you create additional folders that cause the folder list to grow beyond
the visible list area, a vertical scroll bar displays. The scroll bar scrolls the
entire list of system- and user-defined folders as a single entity.

Viewing Documents in the Desktop Manager
When you open a folder, you can view the documents contained within
the folder. With the exception of the Out Box folder, you can choose to
display the documents in Document View or in List View.
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When you first open the Desktop Manager, the documents are displayed
in Document View. However, you can change to List View at any time.

If the number of documents within a folder exceeds the available work
area, horizontal and/or vertical scroll bars appear. You can then scroll the
work area to view your documents. 

To open a folder, simply click the desired folder in the folders list.

Document View

Document View presents each individual document as a thumbnail of the
document. Each document thumbnail displays the document name at the
top. For multiple page documents, the thumbnail also displays the page
count and scroll arrows at the bottom, and a scroll box at the right side.
The scroll arrows and scroll box enable you to page through a multi-page
document, displaying each page in turn or moving you to a particular page
in the document.

Document View enables you to work with an individual document at the
page level: scrolling through the pages, removing a page, splitting a
document, or merging two or more documents into a single document.
You can rearrange the document thumbnails within the work area as
needed.

Document View is available only for the In Box, Scan, Sent Fax, and Trash
folders, and any user-defined folders you create. You cannot use Document
View for the Out Box folder.

❍ To view documents in a folder as thumbnails, make sure the folder is
open. Then click Document View on the View menu or the toolbar.

MP L6000—USERS MANUAL/V000/12-97
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List View

List View presents the documents within the open folder as a list. Each
document on the list displays an icon representing the document type,
along with other pertinent information about the document (such as the
name, page count, disk storage size, and date and time of creation).

The icon designates the document type as fax, scan, or modified. A
modified document is a document where the fax cover page has been
removed from a fax, or a multipage document that has been split into
multiple documents.

List View is available for all folders, both system- and user-defined. When
you display documents using List View, the documents cannot be
manipulated at the page level (as in Document View), such as splitting a
document or merging two or more documents.

❍ To view the documents in a folder as a list, make sure the folder is
open. Then click List View on the View menu or the toolbar.

Sorting the Documents in the List

Documents in the Out Box folder are listed by a combination of the date
and time they were submitted for processing, any future scheduling time,
and processing status. Documents in the other system-defined folders are
listed in order of date and time. You cannot change the displayed order of
the list in a system-defined folder.

However, you can change the order of the listed documents in the user-
defined folders. Typically, documents in user-defined folders are sorted
alphabetically by name. You can sort the documents based on criteria
corresponding to the column labels displayed at the top of the list (such as
type, name, number of pages, size, and date). Sorting by page, size, or date
and time displays the documents with the largest document or most
current document last. The list continues to display in the order you chose
each time you open the folder.
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To change the order of the list, click the title of the appropriate column at
the top of the list.

Setting Up the Address Book
You set up the Address Book to create an easily accessible list of names and
fax and/or phone numbers for your business and personal contacts. You
use the entries in the Address Book to:

❍ Send a PC fax

❍ Assign one-touch speed dialing

❍ Assign coded speed dialing

❍ Assign group dialing

To display the Address Book, select Tools from the Desktop Manager
menu bar.
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Now click Address Book. The MultiPASS Desktop Manager displays the
Address Book window:

❍ Address Book Entries
Address Book entries are listed by row. The columns indicate the
Address Book entry type (individual or group), name and address
information, and phone and fax numbers. Address Book entries can be
sorted based on a chosen column of information.

❍ Status Line
The status line displays additional information about the selected
Address Book entry, based on whether the selected entry is an
individual entry or group entry.

❍ Command Buttons
You use the command buttons to perform various tasks in working
with your Address Book.

Working With Address Book Entries

When open, the Address Book displays a list of the address entries you
currently have set up, along with the corresponding information for each
entry. The Address Book contains two types of entries:

❍ Individual
An individual entry enables you to identify each individual to whom
you repeatedly send faxes. When you send a fax, you can then specify
the recipient for your fax from the entries listed in the Address Book.
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❍ Group
A group entry identifies the two or more individual Address Book
entries to whom you repeatedly send the same fax. For example, you
can set up a group to include those individuals involved in a particular
business project. When you specify the group entry as the fax recipient
on your fax, the fax is sent to each individual in the group.

Sorting the Address Book

The Address Book is sorted alphabetically by last name. You can change
the order of the list based on the column titles for the list. For example,
you can sort the list based on the fax number.

To change the order of the Address Book entries, click the appropriate
column title.

Adding and Editing an Individual Entry

When setting up an individual Address Book entry, you must specify the
contact’s first and last names, and fax number. Optionally, if you want the
information available for a fax cover page, you can provide the contact’s
phone number, title, company, address, and any comments.
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To add an individual entry, click the New Individual button on the
toolbar. To edit an individual, select the Address Book entry and click the
Edit button.

Enter the appropriate information.

❍ You must type at least a First Name or Last Name and a Phone or Fax
number before you can click Add. 

❍ You can enter 20 characters in the First and Last Name text boxes, 
40 characters in the Company Name text boxes, and 32 characters 
in the Phone and Fax Number text boxes. 

❍ You can use the following:

Characters Activity

0 to 9 * # + Dialing digits
, p Pause (2 seconds)
P Last pause (10 seconds, at end of number only)
- ( ) Space Display-only characters; space cannot be used at the

beginning of a number

❍ Be sure to include all numbers that need to be dialed, for example, 1-
714-555-2222.

❍ If you entered an Outside Line Prefix number (such as 9) in the
Phone/Fax Setup dialog box, do not enter it here.

If adding a new entry, click Add. If editing an entry, click Replace.
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Adding and Editing a Group Address

A group address contains addresses previously set up in the Address Book,
either individual addresses or other group addresses.

The New Fax Group dialog box displays two lists—a list of all Address
Book entries previously set up, and the list of addresses included in the
group. You select addresses from the Address Book to include in the group.

You’ll want to add addresses to a group when you will be PC faxing to this
group. If you will be sending plain paper faxes, you’ll want to set up the
group in the speed dial list. See page 3-20 for details.

N You cannot assign a group address to a speed dial code.

To add a group entry, click the New Group button on the toolbar. To edit
a group, select the entry in the Address Book and click the Edit button.

❍ Enter or edit the name you want assigned to this group.

❍ In the Address Book list box, click the individual entry you want to
add to the group and click Add.

❍ To remove an entry from the group, click the entry in the group list
box and click Remove.

❍ In the Comments box, you can enter a note for this group entry.
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❍ If adding a new group, click Create.

❍ If editing a group, click Replace.

Using a Group Address

When you specify a group address when sending a fax, the individual
addresses for the contained group are listed. If you specify more than one
group address for a fax, and each group contains the same individual
address, the duplicate address is removed. Separate fax jobs are created for
each recipient in the group.

Importing an Address Book

You may have an address book in another program that you want to use in
the MultiPASS Desktop Manager. You can import your address book and
use it in the Desktop Manager.

You can import addresses from any ASCII text file containing 
information that is separated by a comma or tab. 

❍ If the fields in the text file are separated by commas, the text file
extension must be .CSV. 

❍ If the fields in the text file are separated by tabs, the text file extension
must be .TXT. 

You must save your text file as a comma- or tab-separated text file before
you import it into the MultiPASS Desktop Manager. For more
information about saving your text file, see your application’s
documentation. If you attempt to import information from an improperly
formatted text file, the system alerts you to a problem with importing.

When you import the text file, you assign the appropriate field names to
each column of information. For example, the column containing the
contact’s name must be titled as the name.
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❍ You see this screen:

❍ In the Assign Field Names dialog box, the address
information is listed in columns, with a column title that
identifies the type of information within the column. The
button above the column titles enables you to reassign the
column titles where necessary.

❍ To remove a field name from the column heading, drag the
column heading text off the dialog box.

❍ To assign the correct name, drag the titled button to the
column title.

Assign the
appropriate name

to each column 
as the title.

3

In the Import
Address Book

dialog box, 
specify the location

and filename to
import. Then 

click OK.

2

To import addresses
from a text file,

click on the Import
button. 
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❍ When the appropriate names appear at the top of each
column, click Import.

Exporting the Address Book

You can export the Address Book from the MultiPASS Desktop Manager
to an ASCII text file. The address information can be separated by either
commas or tabs. 

❍ If you choose to have the address information separated by commas,
the text file extension is .CSV. 

❍ If you choose to have the address information in the text file separated
by tabs, the text file extension is .TXT.

❍ You see this screen:

❍ In the Assign Field Names dialog box, the address
information is listed in columns, with a column title that
identifies the type of information within the column. You
can reassign the column titles where necessary.

To export the
Address Book, click

on the Export
button.

1

Click Import.
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❍ To remove a field name from the column heading, drag the
column heading text off the dialog box.

❍ To assign the correct name, drag the titled button to the
column title.

❍ When the appropriate names appear at the top of each
column, click Export.

❍ In the Export Address Book dialog box, select the file type
(.CSV or .TXT), location, and filename for saving the file.
Then click OK.

Setting Up Your Speed Dial Assignments
To set up speed dialing, you use the fax recipients set up in your Address
Book, and assign the desired individual recipients to speed dial codes. If
you have not set up the recipient in the Address Book, you can add the
recipient while creating speed dial assignments. You can also set up a group
speed dial by assigning two or more individual speed dial assignments to a
single speed dial assignment.

N You cannot assign a group address from the Address Book to a speed dial
code.

Click Export.

3

Assign the
appropriate name

to each column 
as the title.
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To set up your speed dialing assignments, select Setup from the Desktop
Manager menu bar, and then click on the Speed Dial tab.

Assigning
 an Individual Recipient to a Speed Dial Code

To assign a fax recipient to a speed dial code:

❍ In the Address Book list box, select the recipient that you want to
assign to a speed dial code.

❍ Select the speed dial code to which you want to assign the Address
Book, and click Add.

To remove a recipient from a speed dial code:

❍ In the speed dial list box, select dial assignment, and then click
Remove.

To print the speed dial assignment list:

❍ Click the Print List button.

To add a recipient to the Address Book:

❍ Click New.

❍ In the New Individual Entry dialog box, complete the appropriate
information for the recipient and then click Add.
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Defining a Group Speed Dial Code

You’ll want to assign multiple recipients to a speed dial code when you will
be sending plain paper faxes to this group. If you will be PC faxing, you
can set up the group in your Address Book. See page 3-14 for details.

To assign two or more recipients to a speed dial code:

❍ On the Speed Dial tab, make sure the desired recipients for your group
are set up as individual speed dial assignments.

❍ Select the speed dial code to which you want to assign the group of
recipients, and click Group Dial.

❍ In the Group Dial dialog box, enter a name for the group assignment
in the Group Name box.
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❍ In the Speed Dial list box, select the first recipient and click Add.
Repeat this procedure until the desired recipients are included in the
Member(s) list box.

❍ To remove a member from the group, select the member in the
Member(s) list box and click Remove.

❍ When all the desired members are listed in the Member(s) list box,
click OK to save your group.

❍ To close the dialog box without saving your group, click Cancel.

❍ To complete the operation, click OK to close the Setup Options dialog
box.

Using the Fax Log
The Fax Log contains a list of the fax activity (PC faxes sent from and
received to the Desktop Manager) for the last two months. Each fax is
listed with historical information, such as transmission status, date and
time the fax was sent or received, the recipient of the fax, and the number
of pages. You can use the Fax Log for a variety of reasons, such as
reviewing the error status of a PC fax that failed.

While reviewing the Fax Log, you can print the log.

Displaying the Fax Log

In the Desktop Manager, click Fax Log on the Tools menu.
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You can also click on the Fax Log icon on the toolbar.

❍ In the Fax Log dialog box, click a specific fax document to review
additional information in the Details and Log Note boxes.

❍ Click the Print button to print the Fax Log.

FA
X

_L
O

G
.T

IF



Chapter 4 Sending Faxes With the MultiPASS L6000 4-1

MP L6000—USERS MANUAL/V000/12-97

S
en

di
ng

 F
ax

es

You can use the MultiPASS L6000 to send paper faxes or PC faxes. 
PC faxing is the ability to send a fax from an application without first
printing the document. Using the MultiPASS L6000 and the MultiPASS
Desktop Manager, you can PC fax documents from any Windows
application that supports printing.

Before sending faxes, you may want to set up the numbers you plan to use
for automatic dialing methods such as one-touch speed dialing. 
To do this, you first set up your Address Book; then you assign speed-
dialing numbers. See Setting Up the Address Book on page 3-10.

This chapter describes:

❍ Sending a document

❍ Sending a document to more than one location

❍ Adjusting the quality of your faxes

❍ Sending PC faxes

❍ Creating a fax memo in the MultiPASS Desktop Manager

❍ Designing a fax cover page

N Because the MultiPASS is a multitasking device, you can send a fax and
print a document at the same time.

4Sending Faxes With the
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Sending a Document
The MultiPASS starts sending a document while it is being scanned into
memory. When scanning a multipage document, the unit calls the other
party as the first page is being scanned. Once connection is made, the
MultiPASS begins to transmit the information while the remaining pages
are being scanned. This is called Memory Sending.

Regular Dialing

❍ Place the document facedown in the Automatic Document
Feeder (ADF). See page 1-12.

❍ The LCD display shows how much of the unit’s memory is
in use, then displays the current resolution, and then the
message DOCUMENT READY.

❍ Change the resolution if necessary. See page 4-13.

DOCUMENT READY

STANDARD

MEMORY USED 0%

Feed the document.

1
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❍ Use the numeric buttons to dial the number.

❍ To enter a pause, press REDIAL/PAUSE .

• A pause within a number (p) is two seconds. (You can
enter more than one.)

• A pause at the end of a number (P) is ten seconds.

The MultiPASS begins scanning the
document, and dials the number.

❍ After a few seconds, the display shows the number of pages
it has scanned followed by the transaction number for the
fax. This is a unique number the MultiPASS assigns to the
document and uses to identify the document in transaction
reports.

The LCD continues to show these displays in order while
the fax is being sent.

TX/RX NO.      0001

SCANNING      P.001

TX

START/COPYPress
START/COPY.

3

TEL=       555  7899

1 2
ABC

3
DEF

4 5
JKLGHI

6
MNO

7 8
TUVPRS

9
WXY

0
OPER

TONE

SYMBOLS

Dial the other
party’s fax number.

2
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4-4 Sending Faxes With the MultiPASS L6000 Chapter 4

❍ When the document has been sent successfully, the display
shows this message.

The MultiPASS automatically redials if the receiving fax does
not answer, if the line is busy, or if a transmission error occurs.
You can specify the number of times it redials using the
Automatic Retries option in the Send Fax dialog box of the
MultiPASS Desktop Manager (see page 8-4). If all redial
attempts fail, the MultiPASS beeps intermittently for a few
seconds. If this happens, check the fax number and try sending
the fax again.

If the ALARM light is flashing, correct the error described in the
LCD display, and then press STOP. You may need to open the
operator panel to remove the document from the ADF (see
page 10-3).

Automatic Dialing

You can send a document using one-touch speed dialing, coded speed
dialing, or group dialing. You must register the one-touch speed dialing
numbers, the coded speed-dialing numbers, and the group dialing
numbers using the MultiPASS Desktop Manager before you can send
documents using these automatic dialing methods. See Setting Up Your
Speed Dial Assignments on page 3-18.

❍ Place the document facedown in the ADF.

DOCUMENT READY

Load the
document.

1

TRANSMITTING OK

MP L6000—USERS MANUAL/V000/12-97
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❍ Press the one-touch speed dialing button (1 through 6)
assigned to the number you wish to fax to; the name you
assigned to that button is displayed.

OR

❍ Press CODED DIAL and enter the appropriate two-digit
coded speed dialing code.

❍ If a number is not registered for the button or codes, the
LCD displays NO TEL # message. Make sure you pressed the
correct button or entered the correct code and that the
number you want to dial is entered correctly.

❍ If you make a mistake, press STOP. Then press the correct
one-touch speed dialing button or press CODED DIAL and
re-enter the code.

❍ If you do not press START/COPY within five seconds, the
MultiPASS starts sending your document automatically.

❍ If the ALARM light is flashing for any reason, correct the error
and press STOP. You may need to open the operator panel to
remove the document from the ADF (see page 10-3).

DIALING
START/COPYPress

START/COPY.

3

CCSI/MKT

CODED DIA

CANON FAX BACK

Use automatic
dialing.

2
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Sending a Document Using Group Dialing

If you frequently send plain paper faxes to the same group of people, you
can use the MultiPASS Desktop Manager to assign a “group” of numbers
to a speed dial code.  See page 3-20.

❍ Place the document facedown in the ADF.

❍ Press the one-touch speed dialing button or press CODED
DIAL and the code under which you registered the group.

❍ The MultiPASS starts scanning your document into
memory five seconds after you select the group to which
you will send the fax, even if you do not press START/COPY
(ten seconds if you are sending to more than one group).

❍ After scanning the document into memory, the MultiPASS
automatically dials each number in the group.

SCANNING       P.001
START/COPYPress

START/COPY.

3

TEL=CANON GROUP 1

Choose the 
group you wish 

to  send to.

2

DOCUMENT READY

Feed the document.

1

MP L6000—USERS MANUAL/V000/12-97



Chapter 4 Sending Faxes With the MultiPASS L6000 4-7

❍ If there is no group registered under the one-touch speed
dialing button or the two-digit code, the LCD displays the
NO TEL # message. Make sure you entered the correct
number and that the group has been registered correctly to
a speed dial code.  See page 3-20.

❍ If you make a mistake when dialing, press STOP. You can
try again.

Redialing

Manual

To start dialing again, just press the REDIAL/PAUSE button. The
MultiPASS redials the previous number you dialed with the numeric
buttons. Make sure the document is in the ADF.

Automatic
The MultiPASS automatically redials if the first attempt at sending fails
(for example, if the line is busy). The unit redials twice, and the time
between redials is two minutes. (These are the default settings.) The LCD
displays AUTO REDIAL and the transaction number while the MultiPASS is
redialing.

If the MultiPASS fails to make a connection after the last redial, it beeps.
The LCD displays BUSY/NO SIGNAL; try sending again later.

You can change the number of redials and the time between redials. The
redialing options are set in the Send Fax dialog box of the MultiPASS
Desktop Manager; see page 8-4.

BUSY/NO SIGNAL

TX/RX NO.       XXXX

AUTO REDIAL
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4-8 Sending Faxes With the MultiPASS L6000 Chapter 4

To Cancel Automatic Redialing
To cancel automatic redialing, press the STOP button. However, you
cannot cancel redialing while the LCD displays AUTO REDIAL (the unit is
waiting to redial). In this case, wait until dialing begins and then press
STOP to cancel redialing. The MultiPASS asks you to confirm:

To cancel the redialing, press *. The MultiPASS L6000 beeps and the
LCD displays:

The unit then prints an error report:

Resending a Fax After an Error

If you get an error while sending a fax from memory, the MultiPASS can
resend it to the same destination without having to rescan it. To do this,
the On Error Resend option must be set in the Advanced: Send Fax dialog
box of the MultiPASS Desktop Manager. See page 8-5 for details.

You can also set how much of the fax is sent again:

❍ The pages following the page on which the error occurred (ERROR
PAGES)

❍ The first page of the document and the pages following that on which
the error occurred (ERROR & FIRST PAGES)

❍ The entire document (ALL PAGES)

N The fax is erased from memory after it is successfully sent or after the
resending fails.

PRINTING REPORT

TX/RX NO.       XXXX

TX/RX    CANCELLED

CANCEL?  *YES  #NO

STOP
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Manual Sending

If you would like to speak with the other party before sending a fax to
them, you may do so; this is called manual sending. To use manual
sending, you must have a telephone connected to the MultiPASS.

❍ Place the document facedown in the ADF.

❍ You can use regular dialing or any of the automatic dialing
methods.

❍ If a person answers, you can converse normally. When you
are ready to send the fax, ask them to press the start button
on their fax machine. Then press START/COPY on your
unit and hang up the telephone. 

Faxing starts.

❍ Be sure to press START/COPY before you hang up, or you
will disconnect the call.

START/COPY

Converse with the
other party.

3

TEL=         4567899

1 2
ABC

3
DEF

4 5
JKLGHI

6
MNO

7 8
TUVPRS

9
WXY

0
OPER

TONE

SYMBOLS

Pick up the
telephone and 
dial the other

party’s fax 
number. 

2

DOCUMENT READY

Feed the document.

1
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4-10 Sending Faxes With the MultiPASS L6000 Chapter 4

Messages Displayed During Sending
When sending a document, the MultiPASS displays the following messages
as the call progresses.

When it is finished sending the document, the MultiPASS beeps once; the
LCD displays:

Cancel Sending

To stop sending before a fax is complete, follow these steps:

❍ If you are sending manually, the transmission is cancelled
immediately.

❍ If you are sending from memory, the LCD displays:

❍ Press * to cancel or press # to continue the transmission.

Transmission continues.

If you press STOP while the document is being scanned, you may need to
open the operator panel to remove the document (see page 10-3).

TX/RX CANCELLED

Press *
or #.

2

CANCEL?   *YES  #NO

STOP

Press STOP.

1

TRANSMITTING OK

TX/RX NO.      XXXX

TRANSMIT
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Sending a Document to More Than One
Location (Sequential Broadcasting)

Sequential broadcasting sends one document to more than one location.
You can send to a total of 57 destinations as follows:

One-touch speed dialing = up to 6 destinations
Coded speed dialing = up to 50 destinations
Regular dialing (numeric 
buttons dialing) = 1 destination only

You can enter the one-touch and coded speed dialing numbers in any
order. You simply press the one-touch speed dialing button, or press
CODED DIAL followed by the two-digit code.

You can also include one destination using regular dialing. This must be
the last number you enter because you must press START/COPY after
entering the number.

N If you often send to the same group of destinations, use group dialing (see
page 4-6).

Transmitting the Document

❍ Place the document facedown in the ADF.

DOCUMENT READY

Feed the document.

1
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4-12 Sending Faxes With the MultiPASS L6000 Chapter 4

❍ Simply enter the numbers one after the other: press the
desired one-touch speed dialing button or press CODED
DIAL followed by the two-digit code.

❍ If you are sending to group dialing destinations, use the
one-touch speed dialing buttons and the CODED DIAL
button (along with the two-digit codes) to enter the groups.

❍ You must press the second speed dialing number within five
seconds of pressing the first one. Each subsequent speed
dialing number must be entered within ten seconds of the
preceding one.

❍ You can enter only one number directly from the numeric
keypad using regular dialing. This must be the last number
you enter.

❍ The MultiPASS scans the entire document into memory
and begins sending.

TX
START/COPYPress 

START/COPY.

3

TEL= 4567899

Dial the other
party’s number.

2
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❍ The MultiPASS begins the operation approximately ten
seconds after you press the last button (five seconds if you
press only one button) even if you do not press
START/COPY.

❍ The MultiPASS dials the destinations in numerical order
starting with the coded dial numbers, then the one-touch
numbers, and finally the regular-dial number (regardless of
the order in which you entered the numbers).

❍ To cancel a transmission, press STOP during the dialing or
transmission. All subsequent transmissions in the sequence
are cancelled. (You may need to open the operator panel to
remove the document; see page 10-3.)

N If the memory becomes full while scanning your document, the LCD
displays MEMORY FULL. (You may need to open the operator panel 
to remove the document; see page 10-3.) You can split the document into
two or three different jobs, or you can try sending the document to one
location at a time.

Adjusting the Quality of Your Faxes
Canon’s Ultra High Quality (UHQ™) imaging technology enables you to
send faxes that have a print quality very close to that of the original
document. The MultiPASS also allows you to adjust the resolution and
contrast it uses in sending faxes to best suit your particular document.

Setting the Resolution

Resolution is a measure of the fineness or clarity of a printout and is
usually expressed in horizontal and vertical dots per inch (dpi). Low
resolutions may cause text and graphics to have a jagged appearance, while
higher resolutions provide smoother curves and lines, crisp text and
graphics, and a better match to traditional typeface designs.
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4-14 Sending Faxes With the MultiPASS L6000 Chapter 4

The MultiPASS has three resolution settings:

❍ STANDARD
Standard resolution (203 × 98 dpi) is adequate for most text
documents. 

❍ FINE 
Fine resolution (203 × 196 dpi) is suited for documents with fine
print (smaller than the print in this sentence).

❍ PHOTO 
Photo resolution (203 × 196 dpi with halftones) is for documents that
contain photographs. With this setting, areas of the document that
contain photos are automatically scanned with 64 levels of gray, rather
than just two (black and white)—which it uses otherwise. This gives a
much better reproduction of the photos, though transmission time is
longer.

You use the RESOLUTION button to set the resolution for faxing
documents.
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❍ The LCD shows the current resolution.

❍ Press RESOLUTION once or twice more to display the
resolution you want (STANDARD, FINE, or PHOTO).

❍ After about five seconds, the LCD returns to Standby
mode.

Setting the Contrast

Contrast is the difference in brightness between the lightest and darkest
parts of a printed document. You can adjust the contrast the MultiPASS
uses for sending faxes (Darker, Standard, or Lighter) through the
Advanced: Send Fax dialog box in the MultiPASS Desktop Manager. (See
page 8-5 for details.) Standard is the default, and is adequate for most
documents. To darken a light original, choose Darker; to lighten a dark
original, use Lighter.

12/11/97 FaxTel

PHOTO

FINE

STANDARD

Press the
RESOLUTION

button again.

2

STANDARD 

Press the
RESOLUTION

button.

1
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Sending PC Faxes
You can create and send a PC fax from any Windows application that
supports printing or you can create a fax in the MultiPASS Desktop
Manager. You can PC fax the document immediately, send it at a specific
time, or hold it in the Out Box to be sent at a future time. 

Sending a PC Fax From a Windows Application

❍ Open the Windows application.

❍ Create and save the document. 

❍ It varies between Windows applications but is generally
found in one of two ways:

• From the File menu, choose Print Setup. 

• OR

• From the File Menu, choose Print. In the Print Dialog
box, click Print Setup. 

❍ Select and set up the Canon MultiPASS L6000 Fax as the 
current printer. 

❍ Click OK.

Open the Print
window in the

application. 

2

Create a PC 
fax document.

1
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❍ The Send Fax dialog box appears:

❍ Choose individuals or fax groups from the Address Book
list on the left by clicking a name and clicking the Add
button. 

• To remove a name from the Recipients list, click the
name and click the Remove button. 

• To add a new entry to the Address Book, click New.

❍ For a single, one-time recipient, enter the appropriate
information in the Last Name, First Name, Company,
Prefix, and Fax Number boxes.

❍ To attach a coversheet, enter the name of the coversheet
from the drop-down list or click None.

❍ To revise the name and phone number indicating from
whom the fax is being sent, enter the changes in the From
and Phone boxes.

❍ To add comments or notes for the fax on the cover page,
enter the text in the Memo box.

❍ To have the fax deleted after you send it, click Delete after
Sending.

Complete the
information in 
the dialog box. 

3
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❍ To send the fax with any annotations that were added to
the document using the MultiPASS Desktop Manager
Document Viewer, click Include Annotation.

❍ To add a reference comment for the fax log, enter the text
in the Log Note box.

❍ Send Now
Sends the document right now. 

❍ Send Later
Saves the document in the Out Box. 

❍ Hold
Places the document in the Out Box until you select it and
specify a time for it to be sent. The MultiPASS Background
must be open for the PC fax to be sent at the specified
time. 

❍ Cancel
Closes the dialog box without sending the fax and cancels
the specified options.

Defining Send Fax Options

Attaching a Cover Page
You can attach a cover page to your fax. The MultiPASS Desktop Manager
contains a library of predefined fax cover pages, designed with different
styles and suggested uses. In addition, you can design your own cover page,
thereby adding it to the library. The available cover pages are listed
alphabetically by name in the Coversheet drop-down list box.

Previewing the Cover Page
To check the appearance of the cover page you have chosen, click Preview.
The cover page displays, including the recipients and other fax information
you have specified; you cannot edit the cover page during Preview.

To send the 
PC fax, click 

Send Now, 
Send Later,

or Hold.

4
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Identifying the Fax Sender
You can enter your name and phone number in the From and Phone
boxes. After sending the first PC fax, this information is automatically
displayed the next time you send a PC fax. You can change the fax sender
information as needed.

Entering a Memo
You enter a memo to be included on the fax cover page. The memo
appears on the cover page if the cover page is designed to include it. The
font, style, and size of the memo text is determined by the particular
design of the cover page you select.

Deleting the Fax After Sending
If you select the Delete After Sending option, the fax is automatically
deleted from the Out Box folder after it is successfully transmitted. This
option enables you to more easily clear your system of unneeded
documents, thereby freeing disk space. 

If the option is not selected, the sent fax is moved from the Out Box folder
to the Sent Fax folder after successful transmission.

Including Annotations
Using the editing capabilities within the MultiPASS Desktop Manager
(described in Chapter 7, Working With Documents in the Desktop
Manager), you may have modified your document—for example, by
adding text annotations, stamps, or highlighting. In this case, you can
choose to include the modifications by clicking the Include Annotation
option. 

If the option is not selected, the original version of the document is faxed,
without any annotations.

Entering a Fax Log Comment
The Fax Log maintains a history of each fax sent. By providing a log note,
you can include descriptive text on the fax log that has particular meaning
to you. The log note may be an account number for billing purposes, or a
personal note about the particular document, recipient, or fax
transmission.
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Creating a Fax Memo in the MultiPASS
Desktop Manager

You can create and send a Fax Memo that consists of a coversheet with a
message you type. This allows you to quickly send a memo without using
another Windows application.

Simply choose Fax Memo from the File menu. The Send Fax dialog box
appears:

Specify this information exactly like you do for a regular PC fax. 
See page 4-17.

Designing a Fax Cover Page
In addition to the set of predefined fax cover pages that are installed with
your system, you can design your own fax cover page. You can 
edit any existing cover page—one installed with your system or created by
you.

When you create a new cover page, you use a previously designed
background as your base page, and then place the fax information fields on
the page. The fax information fields, or variable fields, provide areas where
you place recipient and sender information for a specific fax. You can
specify the size, font, and style of the text displayed in each field.
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Preparing the Cover Page Background

The cover page background provides the permanent information and any
graphics you want included on your cover page. You then position the
variable fields in the appropriate locations on the background. For
example, for your background, you may want to include heading text that
provides your company name and address information, labels for the
variables fields (such as To: and From:), and one or more graphics that may
represent your company logo or your signature. The background you plan
to use with the Cover Page Designer must be 
black and white, and must be saved in a TIFF file format.

The following instructions provide the recommended procedure for
preparing a cover page background. Using the recommended procedures,
you process a document (created by a word processing application) as a
held fax. Once the document is in the Desktop Manager, you export the
document to save it in a TIFF file format. The TIFF file can then be used
as the background for a new cover page.

❍ In a word processing application (such as Word for
Windows), create a full-page, black-and-white document
that includes the desired features of your background:
heading text, field labels, and any graphics or pictures.

❍ When you have completed the document, print the
document using the Canon MultiPASS L6000 Fax driver. 

To do so, click the Print command. In the Print dialog box,
select Canon MultiPASS L6000 Fax as the printer, and
click the command to print (usually OK or Print).

❍ Select None as the cover page to attach. Then click Hold.

❍ Once the fax document is placed on hold, open the Out
Box Folder in the Desktop Manager.

Specify and 
hold the fax.

2

Create and 
print your

background.

1

MP L6000—USERS MANUAL/V000/12-97

S
en

di
ng

 F
ax

es



4-22 Sending Faxes With the MultiPASS L6000 Chapter 4

❍ Locate the held fax document and open it in the Document
Viewer.

• Double-click the document, select the document and
click Open Document on the File menu, or drag the
document to the Open Document button on the
toolbar.

❍ With the document open in the Document Viewer, export
the document in a TIFF file format.

• On the File menu, click Export. In the Export dialog
box, specify the drive, directory, filename, and file type
for saving the document. Click OK.

Once you have exported the document in a TIFF file format, you can use
the TIFF file as the background of your new cover page.

Another way to prepare the cover page background is to use a graphics
application (such as Paint or Photoshop) to prepare the cover page
background. The background graphic you prepare must be a black-and-
white image, 1728 pixels wide, saved in a TIFF file format. 

Opening the Cover Page Designer

You open the Cover Page Designer from either the Windows desktop or
the MultiPASS Desktop Manager.

❍ From the Windows desktop:

• Click Start, then click Programs. On the Programs menu, click
Canon MultiPASS L6000, then click Cover Page Designer.

❍ From the MultiPASS Desktop Manager:

• On the Tools menu, click Cover Page Designer.

Open and 
save the document.

3
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Using the Cover Page Designer
The Cover Page Designer window consists of the following components.

Menu Bar
The menu bar contains commands that enable you to create, edit, and
print your fax cover page. Some commands can also be accessed by
their corresponding buttons on the toolbar.

Toolbar
The toolbar provides you quick access to commands needed to create,
edit, and print a fax cover page.

In addition to the buttons, the toolbar also provides you with drop-
down list boxes that enable you to select a font and font size for the
text of a variable field.
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Variables Bin
The variables bin contains the fields of information you want to
include on the cover page for your fax. When you use the cover page
for sending a fax with the Desktop Manager, these fields are
automatically filled in with the appropriate information for that
specific fax transmission. 

Layout Area
The layout area allows you to visually create and edit the features of
your cover page. The size of the layout area corresponds to the size of a
standard fax page. You use the horizontal and vertical scroll bars to
view different portions of the cover page.

Creating a New Cover Page

❍ Prepare or have available a black-and-white background, in
TIFF file format, to use as the template of your new cover
page. (See page 4-21 for details.)

❍ With the Cover Page Designer open, click New Cover on
the File menu or toolbar.

❍ In the displayed dialog box, specify the drive, directory, and
name of the TIFF file for your cover page background.

❍ In the layout area, where the black-and-white background is
now displayed, insert the variable fields you want to include
with the fax. (See page 4-25 for details.)

❍ Position the fields in the desired locations on your
background. 

❍ Optionally, adjust the appearance of each field as necessary.
(See page 4-25 for details.)

Add variable
fields.

2

Have your
background

template ready.

1
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❍ When you have completed the cover page design, click Save
on the File menu or toolbar.

❍ In the Save Cover Page Template dialog box, enter the
name of your cover page and click OK.

Inserting Variable Fields

You insert variable fields that are filled in with actual data when you attach
the cover page to a particular fax you are sending. You can choose any or
all of the available fields, and place each at the desired location in the
layout area. A field is placed on top of any cover page background. Each
field displays sample text to illustrate the current font, font size, and text
attributes used. 

Only the variable fields that display in the variables bin or on the Insert
menu are available for you to use on your cover page. You cannot add or
delete a field to or from the existing set. You cannot use a single field more
than once on a cover page.

To insert a field:

❍ Drag a field from the variables bin to the desired location in the layout
area. 

❍ On the Insert menu, click the field you want to insert. Then position
the cursor at the desired location in the layout area and click to place
the field.

Adjusting the Appearance of the Fields

Once you have placed the desired variable fields into the layout area, you
can adjust the appearance of any field. You can resize, move, or delete a
field. When you delete a field, the field is removed from the layout area
and returned to the variables bin. 

Additionally, you can set the text attributes for a field and align two or
more fields on the right, left, top, or bottom. Text attribute changes are
reflected in the sample text shown in the field.

Save your 
cover page.

3
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❍ To select a field in the layout area:

• To select a single field, click the field.

• To select more than one field, hold down the Ctrl key and click
the desired fields.

• To select all fields, on the Edit menu, click Select All. 

❍ To move a field, drag the selected field to a new location.

❍ To delete a field, select the field and click Delete on the Edit menu or
press the Delete key.

Resizing a Field
With the exception of the Memo field, most of the variable fields consist
of a single line of text. If the variable information to be placed in the field
is longer than the field size, the text does not automatically wrap onto a
next line. The text is truncated to fit the length of the field. For this
reason, you may want to resize a field to ensure the full line of text is
visible on the cover page for the fax.

Because the Memo field typically contains multiple lines of information,
this variable field does provide automatic text wrapping. However, make
sure the size of the Memo field is large enough to accommodate the length
of memo text that you may enter in the Send Fax dialog box. If the Memo
field is not large enough, not all the lines of a memo text may be visible
when the fax cover page is sent.

To resize the field, click the field and drag any sizing handle.

Changing the text attributes
Once you have placed fields in the layout area, you can change the font
and font size for the text to be displayed in the field. You can also choose a
text style (bold, italic, underline). If you have multiple fields to which you
want to assign the same attributes, you can select the fields together and
make the change to all the selected fields. You can change the text
attributes assigned to predefined cover pages installed with the Desktop
Manager. 

You choose the desired font and font size from drop-down list boxes on the
toolbar. The sample text in the variable field reflects the font and font size
you choose.
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To change the text attributes, select the field you want to change in the
layout area. Now choose the appropriate text attributes:

❍ Select the font and font size from the drop-down list boxes on the
toolbar.

❍ Click Bold, Italic, and/or Underline on the toolbar.

Aligning fields
When placing the variable fields in the layout area, you can align two or
more selected fields, based on the position of the first field you select. The
first field selected in the set of fields to be aligned is the anchor for the
alignment.

Fields that are placed in a column can be aligned on the right or left
border of the first field you select. Fields that are placed in a row (one next
to the other) can be aligned on the top or bottom border of the first field
you select.

For example, if you want to align a column of fields on the right, the right
border of the first field selected is used as the anchor. The other selected
fields are lined up with the right border of the first field selected.

To align fields:

❍ Select the two or more fields you want to align on the right or left, or
on the top or bottom.

❍ Click Align Left, Align Right, Align Top, or Align Bottom on the
toolbar.

Editing an Existing Cover Page

You can edit any existing cover page to change the variable fields placed on
it. You can add, move, or remove fields, or adjust the existing fields.

To edit an existing cover page:

❍ With the Cover Page Designer open, click Open on the File menu or
toolbar.

❍ In the Open Cover Page Template dialog box, specify the name of the
cover page you want to edit, and click OK.
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❍ In the layout area, make the appropriate changes.

❍ Save your changes.

To save the changes under the same name:

❍ Click Save on the File menu or toolbar.

To save the changes under a different name:

❍ On the File menu, click Save As. In the Save Cover Page Template
dialog box, specify the name of the cover page, and click OK. (This
retains the opened cover page under its original name.)

To rename the originally opened cover page:

❍ On the File menu, click Rename. In the Rename dialog box, specify
the new name and click OK.

Deleting a Cover Page

You can delete a cover page that you no longer need. You do not need to
open the cover page to delete it.

❍ With the Cover Page Designer open, on the File menu, click Delete.

❍ In the Delete Cover Page Template dialog box, click the name of the
cover page you want to delete. Then click OK.
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Printing a Fax Cover Page

You can print a cover page to produce a hard copy for review or to use
when sending a fax directly from the MultiPASS. The hard copy includes
the name of the cover page and the date last modified, printed at the
uppermost edge of the page.

❍ In the Print Setup dialog box, specify your print options
and click OK.

❍ With the cover page open, on the File menu, click Print
Preview.

❍ To print the cover page, click Print.

❍ To enlarge or reduce the view size, click Zoom In or Zoom
Out.

❍ To close the preview window, click Close.

❍ Because a cover page is not typically more than one page,

Preview before 
printing.

2

With the Cover
Page Designer

open, on the 
File menu, click

Print Setup.

1
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you will not use the remaining commands.

❍ With the cover page open, click Print on the File menu or
toolbar.

❍ Complete the Print dialog box and click OK.

Print the 
cover page.

3
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The MultiPASS L6000 has four Receive Modes:

❍ Fax Only Mode

❍ FaxTel Mode

❍ Manual Mode

❍ Answer Machine Mode

You set the Receive Mode during the MultiPASS installation procedure.
(See your Quick Start Guide for details.)

You can change the Receive Mode and the Receive Fax options through the
MultiPASS Desktop Manager. See page 8-7 for details.

This chapter describes:

❍ Receiving documents

❍ Printing documents received in memory

❍ Receiving while copying, printing, or registering

❍ Receiving faxes to the MultiPASS Desktop Manager

❍ Using the Distinctive Ring Pattern Detection (DRPD) feature

5Receiving Faxes
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Receiving Documents
During reception of a fax:

❍ If the unit runs out of paper or if the toner cartridge runs out of toner,
the MultiPASS receives the remainder of the document in memory. 

❍ To stop receiving before the document is complete, press STOP.

❍ If the ALARM light is flashing for any reason, correct the error and
then press STOP. If necessary, see Chapter 10, Troubleshooting. 

❍ If an error occurs, the MultiPASS beeps intermittently for a few
seconds. If this happens, contact the other party and have them resend
the document.

Receiving Documents Automatically Fax Only Mode
When you set up the MultiPASS for a dedicated fax line, the unit
automatically receives the document whenever a call comes over the fax
line. If a voice call comes in, the caller will hear the fax tone.

Receiving Both Documents and Telephone Calls
Automatically FaxTel Mode

In FaxTel Mode, the MultiPASS monitors all incoming calls over the
telephone line. When the MultiPASS receives an incoming call, it checks
to see if the call is from another fax machine trying to send a document or
from someone wanting to talk to you. You must have a telephone
connected to the MultiPASS to use this mode.

How FaxTel Mode Works
In FaxTel Mode, the MultiPASS does not ring when it receives 
a call from another fax machine that is trying to send a document. 
This is so that you are not disturbed when your MultiPASS is
communicating with another fax machine. The unit automatically receives
the document.

If the call is from a person, the MultiPASS rings to alert you to pick up the
phone. You must pick up the telephone connected to the MultiPASS.
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If you do not pick up the telephone connected to the MultiPASS within
15 seconds (set by the Ring Time option), the unit stops ringing. It checks
again to make sure the call is not from a fax machine and then hangs up.

N The MultiPASS does not recognize an extension telephone connected to
another phone jack (that is, not connected to the MultiPASS). If a call
comes in and you pick up an extension phone, the MultiPASS will
continue to ring for 15 seconds, check for a fax, and then hang up.

Receiving Documents ManuallyÑManual Mode
You will want to set your MultiPASS to receive documents manually when
you want to personally check each incoming call to see if it is from a fax or
from a person. You must have a telephone attached to the MultiPASS.

When the MultiPASS rings, pick up the telephone.

❍ If you hear a person’s voice, start your conversation. If the caller wants
to send a document after talking to you, wait on the line until you
hear a slow beep or silence (depending on the sending fax unit), then
press START/COPY to receive the document. 

❍ If you hear a slow beep or silence, another fax is trying to send you a
document. Press START/COPY.

Your MultiPASS begins receiving the document.

❍ Hang up the telephone after the MultiPASS displays RECEIVE. If you
don’t hang up, the MultiPASS beeps intermittently for a few seconds
after you receive the document. To disable the beeping, turn off the Off
Hook Alarm option in the Advanced: Send Fax dialog box. (See page
8-5 for details.)

Using the Telephone to Receive a Fax
If you have a telephone connected to the MultiPASS, you can start
receiving a document manually by entering a two-digit ID code from the
phone. This is particularly convenient if you are using a cordless phone
and you answer the phone away from the MultiPASS.

To use this feature, the telephone must be plugged into the telephone jack
of the MultiPASS (see your Quick Start Guide for details). The Remote

START/COPY
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Receive option must be enabled in the Advanced: Receive Fax dialog box.
(The default is enabled.) For details, see page 8-8.

Use the telephone to receive manual calls as follows:

1. When you answer a call and hear a long beep or silence, a fax is being
sent.

2. Enter the two-digit ID code on your telephone (the default code 
is 25). Wait for five seconds, then hang up. The MultiPASS then
begins receiving the document. 

N If you have an answering machine connected to your MultiPASS and you
can control your answering machine from a remote telephone, make sure
the security code for this function is different than the two-digit ID code
described above. You change the two-digit ID code used by the MultiPASS
to make it distinct from the answering machine’s security code. See page 8-
10.

Using an Answering MachineÑAns. Machine Mode
Connecting an answering machine to the MultiPASS allows you to receive
faxes and phone messages while you are out of the office. 

In Answer Machine Mode, the MultiPASS allows the answering machine
to answer incoming calls, then listens for a fax tone or for four seconds of
silence (also an indication that a fax is coming in), and automatically
receives the fax if it detects the tone or a four-second silence. (Four seconds
is the default; you can change this value.)

N Canon does not recommend using an “answering service” (like those
offered by local telephone companies that provide voice mail) on the
telephone line you are connecting to the MultiPASS. If you do subscribe to
an answering service, you may want to dedicate a separate line for fax
communication only and connect that line to the MultiPASS. Or, you can
see if your telephone company offers a Distinctive Ring Pattern (DRP)
service (see page 5-10 for details).
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Using the MultiPASS With an Answering Machine
Follow these guidelines when using the MultiPASS with an answering
machine:

❍ Set the answering machine to answer on the first or second ring.

❍ If the MultiPASS runs out of paper or toner in Answer Machine
Mode, it receives all faxes into its memory. The faxes then print
automatically when you add paper or replace the toner cartridge.

❍ When recording the outgoing message on the answering machine:

• The entire message must be no more than 15 seconds long.

• In the message, tell your callers how to send a fax. For example:

• “Hello. I can’t answer the phone right now, but please leave a
message after the beep. I’ll return your call as soon as possible. If
you would like to send a fax, press the start button on your fax
machine after you leave your message. Thank you.”

Printing Documents Received in Memory
If one of the following errors occurs while the MultiPASS is receiving a
document, the unit stores the document in memory:

❍ Toner cartridge runs out of toner

❍ Toner cartridge is not installed

❍ Multi-purpose tray runs out of paper

❍ Paper jam occurs
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The MultiPASS can store up to 122 letter-size pages (based on the CCITT
No. 1 chart). 

The LCD display shows REC’D IN MEMORY alternating with the error
message when the memory contains documents. The MultiPASS will
automatically print the contents of memory when you correct the problem.

After printing the document(s) stored in memory, the MultiPASS erases
the document(s) from memory.

N If you are using the MultiPASS Desktop Manager and it is set to 
Save in memory, the MultiPASS stores incoming faxes in its memory when
the computer is off. In this case, you will see the REC’D IN 
FILE message. See page 5-8 for details on receiving faxes with the 
MultiPASS Desktop Manager.

Receiving While Copying, Printing,
or Registering

Because the MultiPASS supports multitasking, you can receive a document
or a phone call while you are: 

❍ Making a copy

❍ Printing a document

❍ Entering information

If you are making copies or printing a document and the MultiPASS
receives a fax, it stores the document in its memory. It then prints the
document as soon as you finish making copies or printing. If you are
entering information into the LCD menu system and the MultiPASS
receives a fax, it prints the document immediately (it does not store the
document in memory).
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Receiving Faxes to the MultiPASS 
Desktop Manager

When your computer is on, you can automatically receive incoming faxes
to the MultiPASS Desktop Manager. 

When your computer is off, the MultiPASS stores received faxes in its
memory until you either print them or you turn on the computer. When
you turn on the computer, you can send the faxes to the MultiPASS
Desktop Manager.

The MultiPASS can also print incoming faxes directly. If your computer is
going to be off for a while and you are expecting incoming faxes, it’s a
good idea to set the MultiPASS to automatically print incoming faxes. 

Receiving a Fax Into the In Box
To receive a fax into the In Box of the MultiPASS Desktop Manager, your
computer must be on and MultiPASS Background must be running. You
must also have selected Upload Fax in the Receive Conditions of the
Desktop Manager. (See page 8-7 for details.)

The Receive Options determine how your faxes are received by the
MultiPASS.

❍ When the Computer is Off

• Set this to Print Fax to always print an incoming fax.

• Set this to Save in memory to save an incoming fax in the
MultiPASS’s memory. You can then print the fax, or upload 
it to the MultiPASS Desktop Manager after you turn 
on the computer. 

❍ When the Computer is On

• Set this to Upload Fax to receive all your faxes to the 
MultiPASS Desktop Manager.

• Set this to Print Fax to always print an incoming fax.
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Printing a Received Fax When Your Computer Is Off
When a document is in its memory, the MultiPASS displays the message
REC’D IN FILE and alternately flashes the date. 

To upload the fax to the MultiPASS Desktop Manager, simply turn on the
computer.

If you want to print a fax that is stored in the MultiPASS’s memory
without turning on the computer, follow these steps:

❍ Use the < or > buttons to select FILE PRINT.

The MultiPASS begins printing the
document.

N Once the MultiPASS prints a fax, it erases the fax from its memory.

Press
START/COPY.

3

FILE PRINT

Select FILE PRINT.

2

FUNCTION
On the MultiPASS,

press the
FUNCTION key.

1



Chapter 5 Receiving Faxes 5-9

MP L6000—USERS MANUAL/V000/12-97

R
ec

ei
vi

ng
 F

ax
es

Using the Distinctive Ring Pattern Detection 
(DRPD) Feature

Some phone companies offer a distinctive ring pattern (DRP) service
whereby they assign two or more telephone numbers with distinctive ring
patterns to a single telephone line. If your phone company offers such a
service, you can have both a fax number(s) and a telephone number(s) for
your MultiPASS using only one telephone line.

Your MultiPASS will automatically detect incoming calls. Based on the
distinctive ring pattern, the MultiPASS knows if the call is from a fax
machine trying to send a document or from a telephone trying to make a
voice call.

Use the information in this section to set up the MultiPASS for use with a
DRP service. For more details on the DRP service, contact your local
telephone company. (Your telephone company may have a different name
for this service. Also, this service may not be offered in all areas.)

Types of Ring Patterns
Your telephone company will assign a distinctive ring pattern to each
number when you order the DRP service. The setting you make in the
MultiPASS must match the setting assigned by the telephone company.

You can set the MultiPASS for the following ring patterns:

❍ Normal ring—Ring type of normal telephone line
(Recommended for voice calls)

❍ Double ring—Two short rings at regular intervals
(Recommended for fax calls)

❍ Triple ring—Short-short-long at regular intervals
❍ Triple ring—Short-long-short at regular intervals
❍ Other ring type—Patterns other than those described above

You set the DRPD Switch Options in the Advanced: Receive Fax dialog
box (see page 8-10 for details).

You must set all DRPD ring numbers in the MultiPASS. You select the
ring pattern and then specify whether the pattern is for telephone calls,
faxes, or both (FaxTel switching). See the next section for details.
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How DRPD Responds to Calls
When there is an incoming call, the MultiPASS checks the incoming 
ring pattern and determines the type of pattern being received. The
MultiPASS may require up to 10 seconds to determine the pattern type.
During this time, any telephone device connected to the MultiPASS will
not ring if Silent Receive is enabled. After the pattern is detected, the
MultiPASS reacts according to how you registered the setting.

Incoming Call Incoming Call
Your Setting From Fax From Telephone 

Fax Receives the fax document Answers as a fax 
without ringing. machine.

Tel Rings to alert you to pick Rings to alert you to pick 
up the telephone. Press up the telephone and 
START/COPY to receive the take the call.
fax (Manual Mode).

FaxTel Switches to receive mode Rings to alert you to pick 
for fax transmission signals up the telephone and 
and does not ring. take the call.

Communicating Using the Distinctive Ring Pattern
Detection (DRPD) Feature

Using the MultiPASS with a DRP service is almost the same 
as using it with a normal telephone line. 

When you turn on DRPD, the Receive Mode defaults to FaxTel Mode.
(You cannot change this Receive Mode.)

When someone calls using the number assigned for telephone
communication, the MultiPASS rings in the pattern you registered 
for telephone calls. When you hear this pattern, simply pick up the
telephone connected to the MultiPASS and talk. If you do not pick up the
telephone, the MultiPASS continues to ring until the other party hangs up.

When someone sends a fax using the number assigned for fax
communication, the MultiPASS does not ring. It receives the 
document automatically.
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You can use the MultiPASS L6000 as a copier and a scanner. This 
chapter describes:

❍ Setting the document feed lever

❍ Copying documents using the operator panel

❍ Scanning documents with the MultiPASS L6000

Setting the Document Feed Lever
To copy or scan, you set the document in the Automatic Document
Feeder (ADF). See the instructions starting on page 1-12 for details. 

You use the document feed lever on the ADF to select multiple documents
( ) or single sheets ( ). Always set the document feed 
lever to single sheets and manually feed the following types of documents:

❍ Thick paper
❍ Thin paper
❍ Small documents (postcards, business cards)
❍ Documents with uneven surfaces
❍ Photographs
❍ Special types of paper

MP L6000—USERS MANUAL/V000/12-97

C
op

yi
ng

 a
nd

S
ca

nn
in

g

6Copying and Scanning With
the MultiPASS L6000

DOCUMENT FEED LEVER

D
O

C
_O

P
P

N
L



6-2 Copying and Scanning With the MultiPASS L6000 Chapter 6

Copying Documents Using the Operator Panel
One of the convenient features of the MultiPASS is its ability to make
high-quality copies. You can make up to 99 copies of one document at a
time.

❍ Place the document facedown in the ADF. The LCD
displays these messages:

❍ The display shows the size of the copy (the default is
100%) and the number of copies (the default is 1).

❍ To set the resolution, press the RESOLUTION button.

PHOTO

FINE

Change the
resolution if

necessary.

3

COPY    100%     01
START/COPYPress 

START/COPY.

2

DOCUMENT READY

FINE

MEMORY USED    0%

Feed the
document.

1
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N ❍ Use FINE resolution for copying most text documents.

❍ Use PHOTO resolution when copying documents that contain 
photographs. This scans areas of the document that contain photos 
with 64 levels of gray, and results in a much better reproduction of 
the photograph.

❍ STANDARD resolution is not available for making copies.

❍ To reduce the size of the copies, use the < and > buttons to
select the reduction percentage you want (70%, 80%, 90%,
or 100%):

❍ To make multiple copies, use the numeric buttons to enter
the number of copies (up to 99).

❍ To stop copying at any time, press STOP. You may need to
lift the operator panel to remove the document (see page
10-3 for details).

❍ If an error occurs and the LCD displays START AGAIN,
reload the document and start copying again.

COPY 
START/COPYPress 

START/COPY.

6

COPY    100%     05

1 2
ABC

3
DEF

4 5
JKLGHI

6
MNO

7 8
TUVPRS

9
WXY

0
OPER

TONE

SYMBOLS

Enter the 
number 

of copies.

5

COPY      80%     011 2

Select 
Reduction mode 

if necessary.

4
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N ❍ If the LCD displays MEMORY FULL while making multiple copies 
of a document, do not use the multiple copy feature for copying the 
document. Make single copies of the document instead (as many 
times as required).

❍ You may be able to make multiple copies if you first print out any 
faxes that are stored in memory (see page 5-5).

❍ The MultiPASS makes single copies at 600 × 300 dpi and multiple 
copies at 300 × 300 dpi. For the higher resolution, make one copy at 
a time.

Scanning With the MultiPASS L6000
To scan a document into the MutliPASS Desktop Manager you use the
Monochrome Scan option.

The MultiPASS Desktop Manager scans each document page, gives it a
system-assigned name, and places it in the Scan folder as a TIFF
document. You can review, annotate, print, or send as a fax each scan
document. For more information on these tasks, refer to Chapter 7,
Working With Documents in the Desktop Manager.

A document remains in the Scan folder until you move or delete it.

❍ Place the document facedown in the ADF.

❍ You can also click Monochrome Scan from the Tools menu.Click the 
Scanner icon.

2

Feed the
document.

1
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❍ Scan Mode
Selects the type of image you are scanning:

Black and White—Scans an image at one bit per pixel.

Grayscale—Scans an image at eight bits per pixel; when
scanning a color image in black and white, this option
retains the greatest tonal range.

Text Enhanced—Scans an image in grayscale, converted to
black and white using Canon Image Trust technology.

❍ Scan Resolution
Selects the resolution in dots per inch. Use the scroll bar to
view the various resolutions, or choose Custom for further
selections. Generally, a higher resolution provides better
image quality. 

❍ Selection
Defines the size of the image you are scanning and the scale
(enlarging or reducing). 

N For details on the scan options you can set, please use the 
on-line documentation for the MultiPASS Desktop Manager.
Simply click the ? on the toolbar and select Scanning to learn all
about the scan options.

In the Main tab,
you specify the

scan options for
your document.

3
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❍ This tab appears only when the Scan Mode is set to
Grayscale.

❍ Text Enhanced—Use Text Enhanced instead of Black and
White for OCR software
This option is designed for use with OCR (Optical
Character Recognition) software. Set this option to increase
the contrast in black and white scanning to promote the
accurate recognition of characters in OCR software. For
OCR scans, set the resolution to at least 
300 dpi. 

❍ Color Matching
This option is not applicable for the MultiPASS L6000.

In the Preferences
tab, you specify

preferred options.

5

In the Tone tab,
you specify the

Contrast and
Brightness for

grayscale
scanning.

4
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❍ Page Size
Specifies the size of image you are scanning.

❍ Black & White Options
Specify the Threshold, Brightness, and Contrast of the
image. 

In the Black & White Options list box, select the desired
option:

Threshold
Provides a high contrast evaluation of the image in terms of
black and white only. 

Halftone
Simulates the tonal range of an image with a precise pattern
of lines and dots. 

In the 
L6000 tab, 
you specify

options for a
Black & White

scan.

6
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❍ If you click Preview, the image is displayed in the ScanGear
window. You can adjust the properties of the images as
needed for the final scan, such as:

• Crop the image

• Reverse the color or tone

• Mirror the image

• Rotate the image

• Scale the output size 

• Adjust the tone

• Adjust the contrast/brightness of a black and white
image

When you click Scan, the scanned image is stored in the
Scan folder with an assigned number such as SCAN_19.
From the Scan folder, you can save (Export), rename, print,
or delete the scanned image—just like any other file. 

❍ You can PC fax a scanned document. For information on
PC faxing, see Chapter 4, Sending Faxes With the
MultiPASS L6000.

To start the scan,
click the Preview
or Scan button.

7
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Scanning From a Windows Application
You can use the MultiPASS to scan documents directly into a Windows
application that supports a TWAIN interface (such as Adobe®

PageMaker®). Some applications allow multiple page scans, while others
do not. If you are unsure whether your Windows application supports this
feature, refer to your user documentation for the application.

The following instructions summarize the procedures for scanning an
image. For specific information about scanning with your Windows
application, refer to the user documentation for the application.

❍ Place the document facedown in the ADF.

❍ Normally, you select Acquire and then Select Source from
the File menu. Now you select the MultiPASS.

❍ Then you select Acquire and then Image.

❍ For information on the scan options, see page 6-5.

The scanned image appears in your application.

In the ScanGear
window, specify

the scan options,
and then click

Preview or Scan.

3

In your Windows
application, specify
the MultiPASS as 
the scan device.

2

Feed the
document.

1
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This chapter contains information and instructions for managing,
manipulating, and modifying your documents in the MultiPASS Desktop
Manager. It includes:

❍ Managing your documents in the Desktop Manager

❍ Annotating a document

The MultiPASS Desktop Manager screen looks similar to this:

Managing Your Documents in the 
Desktop Manager

Once you send a PC fax, receive a fax, or scan an image, the resulting
document is available in the Desktop Manager. You can perform a variety
of tasks with and on your documents, as described in this chapter.

7Working With Documents 
in the Desktop Manager
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Selecting Documents in the Desktop Manager
To work with a document, you select it in the open folder. To select a
document in Document View, simply click the document thumbnail. To
select more than one document, hold the Ctrl key while you click on each
document you want to select. 

To select a document in List View, simply click the document name in the
list.

Printing a Document in the Desktop Manager
You can print a document from any folder in the Desktop Manager. 

❍ Click the document you want to print. Then on the File
menu, click Print.

OR

❍ Drag the document to the Print button on the 
command bar.

Select the
document.

1
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❍ A copy of the document to be printed is sent to the Out
Box folder. The job is assigned a unique name. When
printing is complete, the copy is automatically deleted from
the Out Box folder.

N Annotations will not be printed. To print a document with
annotations, you must print from the Viewer. See page 7-14 for
details on Annotating a Document.

Working With Jobs in the Out Box Folder
For each PC fax you send, fax you receive, or document you print in the
Desktop Manager, a job is created in the Out Box folder. The job currently
being processed—the active job—displays at the top of the list.

In the Print dialog
box, specify the 

number of copies
and click OK.

2
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Each job in the Out Box folder displays with a system-assigned name. A
job remains in the Out Box folder until it is successfully processed or
deleted. You cannot rename a job in the Out Box folder, or move the job
to another folder.

You can select a job in the list to review information about that job in the
status bar. This information includes the name of the original document
from which the job came, as well as the reason the job failed (if it did).

The Out Box folder displays the current status of each job. While in the
Out Box, you can work with your jobs in the following ways:

❍ Stop an active job from PC faxing or printing

❍ Send a PC fax that has been scheduled for sending later, held, or has
failed

❍ View on-hold, stopped, and failed jobs

❍ Print a job

❍ Delete a job that is not active

Job Status
Each job in the Out Box folder is assigned a status:

❍ Active
The active job is the job currently being PC faxed or printed using the
Desktop Manager. When an active fax job completes successfully, it is
automatically moved to the Sent Fax folder or deleted (based on
whether you specified to delete after sending in the Send Fax dialog
box). When an active print job completes successfully, it is
automatically deleted.

❍ Queued
A queued job is a job waiting to be PC faxed or printed. Queued jobs
are processed in chronological order.

❍ Scheduled
A scheduled job is a PC fax you chose to send at a later time. You can
select a scheduled fax job at the appropriate time to have it sent.

❍ Retry
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A PC fax job receives the Retry status if:

• The MultiPASS L6000 is busy with another task, and thus unable
to transmit the PC fax, or

• The receiving fax line is busy.

The Desktop Manager continues to try sending the fax until the
transmission is successful or the Desktop Manager exceeds the defined
number of retries. If a job cannot be completed successfully within the
specified number of retries, the job is marked with a Failed status. The
job remains in the Out Box folder until you reprocess or delete it.

❍ On Hold
A held job is a PC fax you chose to place on hold, rather than send
immediately. The held fax job remains in the Out Box folder until you
choose to send or delete it. You can print a job that is on hold.

❍ Failed
A job receives a Failed status because a PC fax could not be sent
successfully. This occurs because the Desktop Manager exceeded the
defined number of retries. For example, a PC fax may have failed
because of a continuously busy fax line or an incorrect fax number.
The failed job remains in the Out Box folder until you attempt to
reprocess or delete it.

❍ Stopped
A stopped job is an active job that you stopped from processing before
it was completed. The stopped job remains in the Out Box folder until
you attempt to reprocess or delete it.

❍ Error
An error results for a job if there is a problem with the MultiPASS
L6000, such as a loss of communication with the Desktop Manager or
memory is full. You can display the nature of the error in the status
line by selecting the job or reviewing the Fax Log.
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Stopping an Active Job
If necessary, you can stop the active job from processing. When you do so,
the Desktop Manager retains the job in the Out Box folder as a stopped
job. You can later reprocess or delete the job.

To stop an active job, open the Out Box folder and click Stop on the Edit
menu or toolbar.

Sending a Scheduled, Held, Failed, or Stopped PC Fax
A PC fax job continues to reside in the Out Box folder if it is scheduled
for sending later, if it is on hold, if it failed to transmit in the specified
number of retries, or it was stopped. You can reprocess the PC fax job for
sending now or you can reschedule it for a different time.

When you send a PC fax from the Out Box folder, the Send Fax dialog
box displays the information initially entered for the PC fax. You can
change the information as needed. For example, for a PC fax that failed
because of a wrong fax number, you can correct the fax number. For a
scheduled PC fax, you can specify a different time for transmission.

If a cover page is attached, the Desktop Manager displays the style and any
memo text and you can edit it.

❍ In the Out Box folder, drag the document to the Send Fax
button on the command bar. 

OR

❍ Select the document and click Send Fax on the File menu.

❍ In the Send Fax dialog box, change any fax options as
needed.

❍ To process the fax for immediate sending, click Send Now.

❍ To schedule the fax for a later time that you specify, click
Send Later.

Process 
the fax.

2

Send 
the fax.

1
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Creating a Folder
To better organize your documents in the MultiPASS Desktop Manager,
you can create additional folders. When you create a new folder, you assign
a unique name. 

❍ In the Create Folder dialog box, enter the desired name of
your new folder and click OK.

Moving a Document
You can move a document from:

❍ System-defined folder (except the Out Box folder) to a user-defined
folder

❍ System-defined folder (except the Out Box folder) or user-defined
folder to the Trash folder

❍ One user-defined folder to another user-defined folder.

You cannot move a document into a system-defined folder other than the
Trash folder. 

Simply open the folder containing the document you want to move. Then
drag the document to the desired folder. The document is placed in the
appropriate sort order.

Name the 
folder.

2

From the File
menu, click 
New Folder.

1
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Renaming a Document or Folder
You can rename a user-defined folder or a document at any time. Folder
names must be unique within the Desktop Manager. Document names
must be unique within a folder. 

Whenever you attempt to rename a folder or document, the system verifies
whether the new name is unique. In the event of a conflict, the system
alerts you of the conflict. A folder or document name can contain blank
spaces.

❍ To rename a document, click the document. Then, on the File menu,
click Rename. In the Rename dialog box, enter the new name and
then click OK.

❍ To rename a folder, simply click the folder name and enter the new
name in the highlighted rectangle.

Deleting a Document or Folder
You can delete a document or user-defined folder when it is no longer
needed. 

When deleting a document, you can delete the document permanently,
which removes the document from the Desktop Manager immediately.
You can also move it to the Trash folder where it is stored until you later
decide you want to delete it permanently, or empty the Trash folder.

When deleting a folder, you must first delete all documents from the
folder. You can delete only user-defined folders.

❍ To delete a document permanently, open the folder with the
document you want to delete and click the document. Then, on the
Edit menu, click Delete.

❍ To delete a folder, delete all documents from the folder you want to
delete. Then click the folder. On the Edit menu, click Delete.

N
E

W
N

A
M
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Emptying the Trash Folder
If you moved documents to the Trash folder, the documents remain in the
folder until you move them again to a user-defined folder, delete them
individually, or empty the Trash folder. 

As you move more documents to the Trash folder, more space is used 
on your hard disk for storing the documents. To prevent out-of-date
documents from unnecessarily using space on your disk, you should
periodically review your Trash folder and remove the documents no longer
needed.

To empty the Trash folder, click Empty Trash on the File menu. If
prompted, confirm that you want to empty the Trash folder.

Importing a Document
If you have a document residing on your hard disk or a diskette, you 
can import the document into a user-defined folder in the Desktop
Manager. To be imported and usable in the Desktop Manager, the
document must be in monochrome TIFF file format.

To import a document: 

1. Open the user-defined folder into which you want to import a
document. 

2. On the File menu, click Import Tiff. 

3. In the Import Tiff File dialog box, specify the drive, directory, and
name of the file you want to import, and click OK.

N The Desktop Manager examines the file before importing it. If any page in
the file is more than 400 dpi, the Desktop Manager will not import the
file.
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Exporting a Document
You can export a document in the Desktop Manager, saving it to a drive
and directory you specify. When you export a document, you save a copy
of the original document. You can save the document in monochrome
TIFF file format.

To export a document:

1. Open the folder with the document you want to export. 

2. Drag the document to the Export Tiff File button on the command
bar. 

OR

Click the document you want to export and, on the File menu, click
Export Tiff. 

3. In the Export Tiff File dialog box, specify the drive and directory
where you want to place the exported file, and click OK.

Attaching a Document to Electronic Mail (E-mail)
If you have an e-mail application installed on your system and it supports
document attachments, you can attach a document in the Desktop
Manager to an e-mail message. When you select a document and use the
E-mail command, the Desktop Manager opens your e-mail application,
attaching the selected document to a blank e-mail message. 

To attach a document to an e-mail message, select the document you want
to attach and drag the document to the E-mail button on the command
bar. Or, on the File menu, click E-mail. 
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Manipulating a Document in Document View
If you are using Document View, you can manipulate the documents in
the open folder in a variety of ways. (The only exception is the Out Box
folder.) You can arrange the documents in a preferred order. You can also
remove a page from a document, split a single document, or merge one
document with another. 

Arranging the Documents in Document View
A document thumbnail in Document View retains its position until you
rearrange it. You can arrange one or more documents manually or
automatically by clicking a command.

When you arrange the documents automatically, the documents are
positioned within a grid, with row positions filling from left to right. 

To arrange documents manually, select one or more documents and drag
them to a different location within the work area.

To arrange documents automatically, click Arrange on the View menu.

Scrolling Through a Multi-page Document
You scroll through a multiple-page document to position yourself at the
page that you want to remove from the document or where you want to
split the document.

As you scroll the pages in the document, the current page number for the
document updates instantly. After scrolling, the top page is retained even if
the folder is closed and reopened. 
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To scroll the pages in a document:

❍ Click the left and right scroll arrows displayed with the page numbers
for the document.

❍ Drag the scroll tab on the right side of the document.

Removing a Page from a Document
You can remove the current top page of a document. For example, you
may want to remove the cover page from a received fax.

1. Scroll through the document until the page you want to remove is on
top.

2. Click Remove Page on the Edit menu or toolbar.

Splitting a Document
You can split a document into two documents. You can split a document
from any page after the first page within the document. In other words,
you cannot split a document on page 1 of the document. For example, you
split a 10-page document, beginning at page 5. The original document
consists of pages 1 through 4. The newly created document consists of
pages 5 through 10. 

The original document—consisting of at least the first page, up to the page
where the split occurred—retains the original name. The newly created
document is assigned a unique name. 
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To split a document:

1. Scroll to the page where you want to split the document. The top page
represents the first page for the newly created document.

2. Click Split on the Edit menu or toolbar.

Merging a Document
You merge two documents to combine them into a single document. The
documents are merged in the order you select them. In other 
words, the first document selected becomes the top pages of the 
second document selected. Both documents are merged into the 
second document. 

To merge two or more documents:

1. Select the two documents you want to merge (by holding the Ctrl key
and clicking each document).

2. Click Merge on the Edit menu or toolbar.
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Annotating a Document
You can open a document to view its contents, and annotate it with notes,
highlighting, stamps, or graphics (line/arrow, rectangle, circle). Although
you can save the document with your annotations, any annotations you
make are only added markings placed on the original document. The
original contents of the document remain intact. If you choose to fax or
print the modified document, you have the option not to include the
annotations with the document. Following are some sample annotations
you can add to your document.

For example, if you insert a whiteout on your document (such as over a
paragraph of text), the area is no longer visible. However, the paragraph is
still part of your document. You can fax or print the document with or
without the whiteout annotation. You can later remove the whiteout
annotation from the document, restoring the hidden area. 

When you open a document for annotations, the document displays in the
MultiPASS Document Viewer. You can open one document at a time. 
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❍ Double-click the document.

❍ Select the document you want to open. On the File menu,
click Open Document.

❍ Drag the document to the Open Document button on the
toolbar.

❍ With the document open in the Document Viewer, adjust
the size of your view of the document as needed.

❍ Create the desired annotations on your document.

❍ On the File menu, click Save to save the annotations with
your document in the Desktop Manager.

❍ On the File menu, click Exit.

❍ If you have not saved your annotations, you are prompted
to do so.

Close the
Document

Viewer.

3

Annotate
the document.

2

Open the
document in the

Document Viewer.

1

MP L6000—USERS MANUAL/V000/12-97

D
oc

um
en

ts
 in

D
es

kt
op

 M
an

ag
er



7-16 Working With Documents in the Desktop Manager Chapter 7

Features of the Document Viewer Window

❍ Menu Bar
The menu bar contains commands that enable you to perform various
tasks with your document. Some of the commands can also be
accessed by their corresponding buttons on the toolbar.

❍ Toolbar
The toolbar provides you quick access to performing certain
Document Viewer tasks. In circumstances where a task is not possible,
the toolbar button is unavailable, appearing dimmed. 
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In addition to the buttons, the toolbar also provides you with a drop-
down list box that enables you to select a display size for your
document.

❍ Document Display Area
The document itself is displayed and modified in the Document
Display Area. You can page or scroll through the document, enlarge or
reduce the view of the document, or change the orientation. The
display area contains the results of any annotations you may make. 

❍ Annotation Panel
The annotation panel is a set of tools for annotating your open
document. When you select a tool on the panel, an additional panel
may open enabling you to specify specific features for the tool. You
can move the panel around the window to position it for working on
your document. You can also hide the display of the panel.

❍ Page Panel
The page panel contains a number of buttons, one for each page in the
document you are currently viewing. The page panel provides a quick
visual indication of the number of pages in the document and a
method for moving to another page. The page panel normally displays
along the bottom edge of the Document Viewer window, above the
status bar. 

❍ Status Bar
The status bar appears at the bottom of the window, and contains
useful information about the document that you are currently viewing. 
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Adjusting Your View of the Document
You can adjust your view of the open document in a number of ways, 
to provide a more workable display area for making annotations. For
example, you can hide or show the different components of the Document
Viewer.

To show/hide the components of the window:

❍ On the View menu, click Toolbar, Status Bar, Annotation Panel,
and/or Page Panel. Clicking the same command turns the display 
of the item on and off. 

❍ For the annotation panel, you can also click the Annotation Panel
button on the toolbar.

Changing the Document Orientation
You may need to rotate a document for easier reading. For example, the
document may represent a fax you received that was originally sent in
landscape mode or was fed into a fax machine in an inverted position. The
change in orientation applies to the entire document, not just a currently
displayed page.

To change the document orientation:

❍ On the View menu, click Rotate. On the Rotate menu, click Right,
Left, or 180 to rotate the document right by 90°, left by 90°, or 180°
(flipping the document upside down).

❍ On the toolbar, click Rotate Right, Rotate Left, or Rotate 180.

Adjusting the Display Size
The Document Viewer offers different levels of magnification to enable
you to work at the most comfortable size for your document. You can
zoom in and out at predefined increments, or specify a particular size or
scale. 

You can use the Fit to Width option which fills the width of the window
with your page display, or Fit to Window which adjusts the document
image size so that the entire document is visible within the window.
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To enlarge or reduce the size:

❍ To enlarge the document by increments, click Zoom In on the View
menu or the toolbar.

❍ To reduce the size of the document by increments, click Zoom Out on
the View menu or the toolbar.

❍ To select a specific size or scale for enlarging or reducing the
document, click Zoom on the View menu. On the Zoom menu, click
the desired size. Or, click the size or scale from the drop-down list box
on the toolbar.

Adjusting the Image Display
For ease of viewing and better visibility, you can adjust or invert the light
and dark levels of your displayed document. When you invert the display
colors, you change the black areas to white and vice versa. Any colors you
use for annotations are not changed, although highlight annotations may
be difficult to see against a black background.

You may find that the Gray Scale setting is more pleasing to the eye;
however, it is slower to generate an image. For speed and reasonable image
display, consider the Darkest setting.

To lighten or darken the image:

❍ On the View menu, click Image Enhancement. On the Image
Enhancement menu, click the desired setting.

To reverse the colors of the image:

❍ On the View menu, click Invert.
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Paging Through Your Document
For multipage documents, you can move to the next or previous page, or a
particular page you specify.

To page through your document:

❍ Click Next Page or Previous Page on the View menu or toolbar.

❍ On the View menu, click Go to Page. On the Go To Page dialog box,
enter the page number you want to display and click OK.

❍ Click the page on the Page Panel.

Reviewing Information About the Document Image
As a reference, you can display information about the document currently
displayed in the Document Viewer. This information includes the name
and size of the file, when the file was created, the number of pages, the
width and height, the resolution (pixels per inch), the number of bits used
to represent each pixel (thus, the number of colors that can be displayed),
and the scaling.

To review information about the image, click Image Info on the 
View menu. 

Adding Annotations to Your Document
The following sections describe the various ways you can annotate your
document.

Adding a Sticky Note
You can add a text note on any portion of your document. When you do
so, you can choose the text attributes: font, font size, and special effects
(boldface, italic, underline, strikeout). Sticky notes always appear as black
text on a yellow background.
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You can type any text that you want for the note, editing the note later if
necessary. If you select a font, font size, or special effect, it affects the entire
note. If you change any of the attributes while editing a note, or while the
note is selected, it changes all the text in the note.

If you switch away from the note to do something else (such as change the
text size or switch to a different tool) before entering your text, the sticky
note is removed. This is to prevent you from creating unwanted blank
sticky notes.

To add a sticky note:

1. Click the Sticky Note tool on the annotation panel.

2. Select the font, font size, and any special effects.

3. At the desired location on the displayed page, drag the cursor to draw
the size of the sticky note. A dotted line displays to show you where
the sticky note will be placed. When you release the mouse button, the
sticky note is created.

4. Type the text of your note.

To edit the text in a sticky note:

1. Make sure the Sticky Note tool is selected on the annotation panel.

2. Move your mouse pointer over the sticky note. The cursor changes to
an insertion point. 

3. Click at the location where you want to make your changes. 

4. Edit the text as needed.
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Concealing a Region
You can conceal a region of your document to hide certain areas. For
example, you can hide a paragraph before you fax the document to a
business contact. You can conceal the paragraph with either an opaque
whiteout or blackout annotation, which is always a rectangle. Once
applied, the whiteout or blackout annotation can be moved, resized, 
or deleted. 

To conceal a region:

❍ On the annotation panel, click the White Out tool.

At the desired location on the displayed page, drag the cursor to draw
the whiteout annotation. A dotted line displays to show you where the
whiteout annotation will be placed. When you release the mouse
button, the annotation is drawn.

❍ On the annotation panel, click the Select Region tool.

At the desired location on the displayed page, drag the cursor to draw
the outline of the region. A dotted line displays the region. On the
Edit menu, click White Out or Black Out.

Inserting a Stamp
You insert a stamp to place a bitmap image on the displayed page of your
document. The Desktop Manager contains a library of available stamp
images, stored as .BMP files that were installed with the Desktop Manager.
You can use only those stamps installed with the Desktop Manager.
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To insert a Stamp:

1. On the annotation panel, click the stamp tool. You see this dialog box:

2. In the Choose Stamp dialog box, select the desired stamp from the list
box and click Accept.

3. Click the cursor in the desired location for placing the stamp. The
stamp is placed at that location.

Highlighting Your Document
You can add a color highlight to the text or other images in your
document. You select a color and draw a rectangular highlight over the
desired area. All highlight colors are transparent and display as the color
you selected. When you print the document, the highlighted region prints
as gray shadings.

To highlight your document:

1. On the annotation panel, click the Hilite tool.

2. Select the color of the highlighting.

3. At the desired location on the displayed page, drag the cursor to draw
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the highlight region. A dotted line displays to show you where the
highlight region will be placed. When you release the mouse button,
the highlight is created.

Creating a Drawing Graphic
You can annotate your document with one or more drawing objects 
that include a straight line, single- and double-headed arrow, hollow
rectangle, and a hollow circle or ellipse. When you draw the object, you
can select the color and width of the line for the object.

To create a drawing object:

1. On the annotation panel, click the drawing object tool: Arrow/Line,
Rectangle, or Circle.

2. Select the color and width of the line for the object you are drawing.
For an arrow or line, also select the particular style you want to use.

3. At the desired location on the displayed page, drag the cursor to draw
the object. A dotted line displays to show you where the drawn object
will be placed. When you release the mouse button, the object is
created.

Showing and Hiding Your Annotations
As you add annotations to your document, you can turn the display of the
annotations on and off for viewing. 

To show or hide your annotations, click Annotations on the View menu.
On the Annotations menu, click the command to hide or show your
annotations. For color annotations, click B&W Preview to display the
annotations in black and white.
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Revising Your Annotations
Once you have created annotations in your document, you can revise the
annotations as needed. For example, you may want to resize, move, delete
or cut, or copy and paste an annotation.

Selecting One or More Annotations
To revise an annotation, you must first select it. In most situations, you
can select one or more annotations at a time.

❍ To select a single annotation, click the Annotation Select button on
the annotation panel. Then click the annotation.

❍ To select all annotations, click Select All on the Edit menu. This
method selects all the annotations in the open document on all pages.
You cannot resize an annotation using this method.

❍ To select annotations within a specified region, click the Region Select
tool on the annotation panel. At the desired location on the displayed
page, drag the cursor to draw a rectangle enclosing the annotations you
want included within the region. A dotted line displays to indicate the
region. On the Edit menu, click Select in Region. Graphic handles
display for the annotations that are selected.

❍ To select the base page of your document, click Select Base Image on
the Edit menu.

Moving an Annotation
You can move an annotation currently displayed from its present position
in your document to another. You can also change the layering order of
annotations that occupy the same position. Normally, an annotation you
add to the document in the same position as a previously added
annotation is layered on top. As needed, however, you can move the
background annotation to the front, or the foreground annotation to the
back. 

❍ To move an annotation, select the annotation and drag it to the
desired location. 
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❍ To change the layered position of an annotation, select the annotation
and do one of the following:

• To bring the annotation to the foreground, click Bring to Front on
the Edit menu.

• To place the annotation on the background, click Send to Back on
the Edit menu.

Resizing the Annotation
When you create an annotation, you draw it to the desired size. If the
original size proves unsuitable, you can resize the annotation either smaller
or larger.

❍ To adjust the size, click the border of the annotation and drag any
sizing handle.

Copying and Pasting an Annotation
If you want an annotation to appear more than once within your
document, you can create the first annotation, and then copy and paste it
any number of times. When you copy an annotation, it is placed on the
Document Viewer clipboard. From the clipboard, it can be pasted to any
location on any page of your document.

To copy and paste an annotation:

1. Select the annotation to be copied and click Copy on the Edit menu
or toolbar. 

2. With the annotation copied, click Paste on the Edit menu or toolbar.

3. Move the pasted annotation to the desired location in your document.
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Saving All or Part of a Base Page of Your Document
You can select the original base page, or a region of the page, and save the
selection to a bitmap (.BMP) file. Once it is saved as a bitmap file, you can
import the file into another Windows application as needed.

1. Select either the base page or a region of the page in your document.

2. Click Copy on the Edit menu or toolbar.

3. Once copied, on the Edit menu, click Paste to File.

4. When prompted, specify the drive, directory, and name of the file for
saving.
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Removing an Annotation
If you decide you no longer want an annotation to appear in your
document, you can remove the annotation, either permanently or by
moving it to the clipboard. 

To remove an annotation, select the annotation and do one of the
following:

❍ To delete the annotation permanently, press the Delete key.

❍ To remove the annotation to the clipboard, click Cut on Edit menu or
toolbar.

Exporting the Document
You can save a copy of the document currently open in the Document
Viewer to a file on a specified drive and directory. The document is saved
as a graphic file, and can include or not include any annotations you may
have created. Typically, you would save the document to use in a graphics
application of your choice. To determine the appropriate file type for
saving the document, refer to the user documentation for the graphics
application to which you want to import the file. 

1. On the File menu, click Export.

2. In the Export dialog box, specify the drive, directory, filename, and file
type for the file you want to save. Specify also whether you want to
save any annotations with the document. Then click OK.
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Adjusting the Document Viewer Default Options
As you work in the Document Viewer, you can change the options that
affect your view of the open document, such as the size and lightness or
darkness of the image. However, if you have view settings that you
generally prefer to use in most situations, you can define default settings.
These settings are activated when you first open the Document Viewer.

To adjust the initial Document Viewer options:

1. On the File menu, click Initial Options.

2. On the Initial Options menu, click the appropriate command to set
default options:

❍ Scale Factor
To select the appropriate view size

❍ Image Enhancement
To select the level of lightness or darkness

To return the options to their original settings when you installed the
Desktop Manager, click Reset All to Default.
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This chapter contains information and instructions on changing your
MultiPASS L6000 Setup Options in the Desktop Manager, and using
other Desktop Manager utilities. It includes:

❍ Setting up the MultiPASS L6000 Setup Options in the Desktop
Manager

❍ Making a phone call from the Desktop Manager 

❍ Using the Status Monitor

❍ Closing the MultiPASS Background

❍ Disconnecting the MultiPASS L6000

❍ Using MultiPASS Diagnostics

❍ Uninstalling the Desktop Manager

8Setup and Other Utilities in the
Desktop Manager
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Setting Up MultiPASS L6000 Options 
in the Desktop Manager

The Desktop Manager contains Setup Options that define the operation of
your MultiPASS.

When you first install the Desktop Manager, the Setup Options are set to
default settings that enable you to begin using your MultiPASS with the
Desktop Manager immediately. However, you can change the option
settings as needed. 

To change Setup Options in the Desktop Manager:

1. From the Setup menu, click the group of Setup Options you want to
change.

2. In the Setup Options dialog box, click the appropriate tab for the 
options you want to display.

3. On the appropriate setup tab, specify your changes.

4. To save any changes and close the dialog box, click OK. 

To exit the dialog box without saving your changes, click Cancel.

When you click OK, the Desktop Manager downloads the software
changes to the MultiPASS. The Desktop Manager displays a dialog box to
remind you that the Setup Options are being updated.
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Setting Up Preferences

❍ Date Format and Display Language
Select the format in which you want to enter the date and the
language you want to see in the Desktop Manager screens.

❍ Document Deletion
Select this option if you want to be prompted each time you delete a
document from the Desktop Manager.

❍ Telephone
Select this option if you have attached a telephone to your MultiPASS.
With this option selected, you can use the Desktop Manager to dial a
phone number. 

❍ Volume
You can set the volume level of the various sound components of your
MultiPASS to suit your office environment. The settings are
Minimum, Medium, or Maximum for Incoming Ring, and OFF,
Minimum, Medium, or Maximum for Alarm, Keypad, and Speaker.
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Setting Up Send Fax Options

❍ Fax Information
You specify the information that displays as the header for a PC fax:
your name, company name, and your fax number. Initially, this
information was set up when you installed the Desktop Manager. 

❍ Phone Line
You specify the dialing method the MultiPASS will use: touch-tone 
or rotary pulse. You also specify any prefix used to access an outside
phone line. Initially, this information was set up when you installed
the Desktop Manager.

❍ Automatic Retries
You specify the number of retries (1-10) the system should attempt
when sending a fax transmission, and the length of time between each
retry (2-99 minutes).

❍ Automatic Report
You specify whether or not you want a report to print with each fax
transmission, or only when there is an error with the transmission. You
can also specify if you want an image of the first page of the fax
included in the report.
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Restoring the Default Settings
If, after making changes, you decide to restore the default settings for the
options, click the Use Defaults button.

Setting Up Advanced Send Fax Options
When you click on the Advanced button on the Send Fax tab, you see this
dialog box:

❍ Speed
You set the transmission speed used to send faxes. The higher the
setting, the faster the transmission. If you experience problems when
sending faxes, try a lower speed setting.

❍ Pause Duration
You set the length of the pause that will be inserted when you enter a
pause in a phone number (1-15 seconds).

❍ Error Correction (ECM)
You select this option to reduce system and line errors when sending a
fax. With this option selected, the system checks each outgoing fax for
lost data. If data has been lost from a portion of a page, the system
transmits that portion again after confirming that all data within that
portion can be transmitted successfully.
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❍ Auto Start Send
When you select this option, the MultiPASS starts scanning
automatically five or ten seconds after you enter a phone number.
When you don’t select this option, you must press START/COPY to
scan the document, or the unit returns to standby mode after 60
seconds.

❍ Off Hook Alarm
You select this option to turn on the alarm if the telephone’s handset is
off hook.

❍ Image
You select a contrast setting that determines the level of contrast in the
faxes you send. The Standard setting is usually appropriate for most
documents. However, based on the lightness or darkness of your
original fax document, you may prefer to lighten or darken the
contrast for the fax transmission.

❍ Fax Heading
You select the position where you want the sent fax heading
information (your fax number, your name, and date and time) to print
on the faxes you send. This information is known as the Transmit
Terminal Identification (TTI). It can be printed either inside or
outside the image area of your fax page.

❍ On Error 
You select Resend option if you want the MultiPASS to automatically
redial when an error occurs while sending a fax. You also select which
pages are to be resent: only the page on which the error occurred, the
page on which the error occurred and the first page of the fax, or all
pages.
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Setting Up Receive Fax Options

❍ Paper Size and Reduction
You specify the size of paper in the sheet feeder and whether you want
an incoming fax reduced (approximately 98%) to ensure the contents
fit on the paper on which it is printed.

❍ Answer 
You specify the Receive Mode. Initially, you set the Receive Mode
when you installed the Desktop Manager. 

You use the Silent Receive option to specify whether the optional
telephone should ring when you receive a call. The type of call for
which the device will ring is determined by the Receive Mode. The
ringing will occur for a fax call only (Fax Only mode), or fax and
telephone calls (FaxTel mode). 

You can set the number of rings (1-99) before the MultiPASS will
respond to any call. If the Receive Mode is Fax Only, this is the
number of rings before the MultiPASS answers the call. In FaxTel
mode, this is the number of rings before the MultiPASS answers to
determine if the call is from a fax or a telephone.
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❍ Receive Conditions
You specify how the system should handle an incoming fax under the
following conditions:

• When your computer is turned off:
You set the MultiPASS to print the fax or save the fax in its
memory.

• When your computer is turned on:
You set the MultiPASS to move (upload) the fax to the Desktop
Manager on your computer, or to print the fax.

• When toner is low:
You set the MultiPASS to hold the fax in memory until more
toner is added, or to continue printing the fax even though toner
is low.

❍ Report 
You specify whether or not you want a report to print with each fax
reception, or only when there is an error with the fax reception.

Restoring the Default Settings
If, after making changes, you decide to restore the default settings for the
options, click the Use Defaults button.

Setting Up Advanced Receive Fax Options
When you click on the Advanced button on the Receive Fax tab, you see
this dialog box:
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❍ Speed
You set the transmission speed used to receive faxes. The higher the
setting, the faster the fax is received. If you experience problems when
receiving faxes, try a lower speed setting.

❍ Error Correction (ECM)
You select this option to reduce system and line errors when receiving
a fax. With this option selected, the system checks each incoming fax
for lost data. If data has been lost from a portion of a page, the system
receives that portion again after confirming that all data within that
portion can be received successfully.

❍ Ink/Toner Saver
You select this option to print documents in the Desktop Manager
using a reduced amount of toner. When using Ink/Toner Saver mode,
the print document may appear less bright or contrasted.

❍ Fax/Telephone Switching Options
You specify these options when your Receive Mode is Fax/Telephone
Switching (FaxTel mode).

• Listen Time Before Ringing
When a call is received, the MultiPASS checks to see if the call 
is from a fax machine or a telephone. You use this option to set
the appropriate amount of time (0-30 seconds) to allow the
MultiPASS to check for the type of call. If your MultiPASS does
not have enough time to detect the fax tone, it assumes the call 
is from a telephone.

• Ring Time
When your MultiPASS is set to receive both fax and telephone
calls (FaxTel mode), it rings to inform you of an incoming
telephone call. You use this option to set the appropriate amount
of time (10-45 seconds) the MultiPASS will ring. If you do not
pick up the telephone within a certain amount of time, the
MultiPASS stops ringing.

• Ring Tone
You set the tone of the ring.
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• Default Action if No Answer to Telephone
You set this option to Receive if you want the MultiPASS to
handle an incoming call, detected as a telephone call that is not
answered, as an incoming fax. If no fax is received, the line is then
disconnected. If you set this option to Disconnect, the MultiPASS
automatically disconnects the unanswered call without switching
to try and receive a fax.

❍ Answering Machine Mode Options
You select this option to set the MultiPASS L6000 to automatically
switch to fax receive mode if your telephone caller does not speak
within the specified amount of time.

You can set the number of seconds (1-99) the MultiPASS L6000 will
wait before switching to fax receiving mode if the telephone caller does
not speak.

❍ Remote 
You select the Receive option so that you can receive a fax by pressing
an ID code on the telephone attached to the MultiPASS. You assign a
remote Identification Number (00-99) that signals the MultiPASS to
receive the fax. The default number is 25.

❍ DRPD Switch Options
If you select DRPD for the Receive Mode, you need to set up the
Ring Pattern, Action, Fax ID, and Fax Number. See the DPRD
description starting on page 5-9 for complete details on how these
settings work with your MultiPASS.
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Setting Up Speed Dial Assignments

On the Speed Dial tab, you can set up fax numbers for speed dialing with
the MultiPASS. You use the fax recipients set up in your Address Book,
and assign the desired individual recipients to speed dial codes. 
If the recipient has not yet been set up in the Address Book, you can 
add the recipient while creating speed dial assignments. You can also set up
a group speed dial by assigning two or more individual speed dial
assignments to a single speed dial assignment.

For reference, you can print the list of speed dial assignments. 

See page 3-18 for details on setting up your speed dial assignments.
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Making a Phone Call From 
the Desktop Manager

You can use the MultiPASS and Desktop Manager to dial telephone 
calls if:

❍ You have a telephone attached to the MultiPASS.

❍ You enabled the Telephone Attached to Unit option on the Preferences
tab in the Setup Options dialog box in the Desktop Manager. (See
page 8-3.)

You can place a call to any individual you want, whether or not the
individual has been set up in the Address Book. At the time you are
attempting to make your call, you can set up an individual entry in the
Address Book.

In the Desktop
Manager, click
Phone on the 
File menu or

command bar.

1
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❍ You can enter the phone number in the Prefix and Phone
boxes, or select an Address Book entry.

❍ When you enter the phone number, you use the applicable
numeric characters and any valid characters that separate the
different segments of the phone number. For example, you
can use 0 through 9, dash (-), or parentheses (). Other
characters are also available for entering a phone number. 

❍ To add an individual to the Address Book, click New
Individual and complete the New Individual Entry dialog
box. For details on completing the New Individual Entry
dialog box, refer to Chapter 3, Using the MultiPASS Desktop
Manager.

❍ When the Dialing Phone dialog box displays, you are
prompted to pick up the telephone.

❍ If you want to stop the number from being dialed, click
Stop.

❍ When you have completed your call, click Exit.

When the phone
number is entered

or selected, 
click Dial.

3

In the Phone
dialog box, enter

the phone 
number you 

want to call.

2
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Using the Status Monitor
The Status Monitor is a utility that enables you to track the current status
of the MultiPASS, incoming and outgoing faxes, print and scan jobs, and
any error conditions needing your attention. You can open the Status
Monitor either from the Windows desktop or the MultiPASS Desktop
Manager. 

The Status Monitor displays as a button and can also display as a window.
Whether displayed as an icon or window, the Status Monitor alternates the
status message shown for more than one activity occurring at the same time.
For example, if the sending of a fax and an out-of-paper error condition
occur at the same time, the Status Monitor alternates the display of the
corresponding messages.

Opening the Status Monitor
❍ On the Windows desktop—Click Start, and then point to Programs.

On the Programs menu, point to Canon MultiPASS L6000. Then
click MultiPASS Monitor.

❍ In the Desktop Manager, click Status Monitor on the Tools menu.

Using the Minimized Status Monitor
With Windows 95, the minimized Status Monitor appears as a button on
the Windows desktop in the taskbar. 

The graphical appearance of the icon or button depicts the type of activity
it is reporting. For example, the scan graphic is used to depict the status of
scan activity.

MP L6000—USERS MANUAL/V000/12-97

S
TA

T
U

S
2

T
O

O
LS

_1



Chapter 8 Setup and Other Utilities in the Desktop Manager 8-15

A menu contains commands that enable you to open the Status Monitor
window, open the Desktop Manager, and close the Status Monitor.

❍ To open the menu on the minimized Status Monitor, click the right
mouse button on the Status Monitor icon or button.

❍ To open the Status Monitor window from the icon or button, click
Restore on the Status Monitor menu.

❍ To open the Desktop Manager from the Status Monitor icon or
button, click Go to Manager on the Status Monitor menu.

❍ To close the Status Monitor, click Close on the menu.

Using the Status Monitor Window
The Status Monitor window displays the status of MultiPASS activity only.
You cannot use the Status Monitor to interrupt an activity.

The Status Monitor window contains commands that enable you to:
specify the Status Monitor as the top window at all times, close the
window and return to the minimized Status Monitor, open the Desktop
Manager, and close the Status Monitor.

❍ To open the menu on the Status Monitor window, click the right
mouse button in the Status Monitor window.

❍ To specify the Status Monitor as the top window, click Always On Top
on the displayed menu.

❍ To return to the Status Monitor icon or button, click the Minimize
button in the window title bar. Or, click Minimize on the Status
Monitor menu.

❍ To open the Desktop Manager, click the Desktop Manager button in
the window title bar. Or, click Go To Manager on the menu.

❍ To close the Status Monitor, click the Close button in the title bar.
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Status Messages
The Status Monitor reports the following statuses for the 
MultiPASS.

❍ Idle
The MultiPASS is currently inactive.

❍ Scanning
The MultiPASS is scanning an image. The Status Monitor window
displays the number of the page currently being scanned.

❍ Printing
The MultiPASS is printing a document. The Status Monitor window
displays the number of the page currently being printed.

❍ Sending Fax
The MultiPASS is sending a fax document. The Status Monitor
window displays the number of the page currently being faxed.

❍ Receiving Fax
The MultiPASS is receiving a fax document. The Status Monitor
window displays the fax number or name of the sender (if available),
and the number of the page currently being received.

❍ Attention Needed
The MultiPASS needs your attention for situations such as being out
of paper. The Status Monitor window describes the nature of the
attention required.

When you have corrected the situation, the status message
automatically clears. 

❍ Error Warning
The MultiPASS has a problem that needs your immediate attention,
such as when the Status Monitor can no longer detect the MultiPASS.
The Status Monitor window displays the nature of the problem, with a
comment indicating a corrective action.

When you have corrected the situation, the status message
automatically clears.

MP L6000—USERS MANUAL/V000/12-97



Chapter 8 Setup and Other Utilities in the Desktop Manager 8-17

Closing the MultiPASS Background
The MultiPASS Background is a utility that monitors and controls activity
between your computer and your MultiPASS, including:

❍ Input and output (such as sent and received faxes) to and from the
Desktop Manager 

❍ Output (print and PC fax activity) from Windows applications.

When you installed the Desktop Manager, the MultiPASS Background was
placed in the Windows StartUp group and is automatically opened when
you open Windows. 

If you decide you need to disconnect the MultiPASS from the designated
port and/or attach another device to the port, you should close the
MultiPASS Background first. If you close the MultiPASS Background first,
you avoid receiving error messages when the MultiPASS Background
detects it can no longer communicate with the MultiPASS.

When you start the Desktop Manager again at a later time, the MultiPASS
Background is automatically reopened if your MultiPASS L6000 has been
reconnected to the port. You can also open the MultiPASS Background
without opening the Desktop Manager.

N If you are closing the MultiPASS Background, you may want to set the
MultiPASS to print any received faxes. With the MultiPASS Background
closed, received faxes cannot be moved to the Desktop Manager. Received
faxes can also be stored in the MultiPASS memory. However, 
if the memory becomes full, the MultiPASS is unable to receive more faxes
until you print the faxes stored in memory.

To close the MultiPASS Background in Windows 95:

1. Close the MultiPASS Desktop Manager.

2. On the Windows taskbar, click the right mouse button on the
MultiPASS Background button. In the displayed menu, click Close.

Do not delete the MultiPASS Background icon from the Canon
MultiPASS L6000 group.
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Removing MultiPASS Background From StartUp
Closing the MultiPASS Background does not remove it from the Windows
StartUp group. If you have disconnected your MultiPASS, the next time
you start Windows, the MultiPASS Background will try to open. At that
time, the MultiPASS Background will be unable to detect the device,
displaying an error message.

Click OK to close the message dialog box. The MultiPASS Background
closes automatically, since it cannot detect the MultiPASS device. Your
port remains available for you to use with other devices.

However, if you would like to prevent the message from displaying each
time you start Windows, you can remove the MultiPASS Background from
the StartUp group.

The following instructions summarize the procedures for removing a
program from Windows StartUp. For more details, refer to your Windows
user documentation.

To remove the MultiPASS Background from StartUp:

1. On the Windows desktop, click the right mouse button on Start.

2. On the displayed menu, click Open.

3. In the Start Menu window, double-click the Programs icon.

4. In the Programs window, double-click the StartUp icon.

5. In the StartUp window, click the MultiPASS Background icon and
press the Delete key.
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Restarting the MultiPASS Background
If you reconnect the MultiPASS to the port and want to begin using the
Desktop Manager again, the MultiPASS Background is restarted
automatically when you open the Desktop Manager. You can also open the
MultiPASS Background without opening the Desktop Manager.

To restart the MultiPASS Background:

1. On the Windows desktop, click Start and then point to Programs. 

2. On the Programs menu, point to Canon MultiPASS L6000. Then
click MultiPASS Background.

The MultiPASS Background starts automatically.

Adding MultiPASS Background to StartUp
When you reconnect your MultiPASS device, you will probably want to
add the MultiPASS Background to the StartUp group again (if you
removed it as described earlier). With the MultiPASS Background in
StartUp, the MultiPASS Background automatically opens when Windows
is started.

To add MultiPASS Background to StartUp:

1. Open the Windows Explorer.

2. Display the contents of the \MPASS directory and click the right
mouse button on MPSERVER.EXE.

3. In the displayed menu, click Create Shortcut. (A shortcut item
appears.)

4. Click the plus (+) signs next to the Windows folder, the Start Menu
folder, and then the Programs folder.

5. Drag the shortcut item (created in Step 3) to the StartUp folder.

The MultiPASS Background will be automatically started when you start
Windows.
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Disconnecting the MultiPASS 
You can disconnect the MultiPASS if you want to use the parallel port for
another purpose. Before disconnecting your unit, be sure to close the
MultiPASS Background. 

1. Turn off your computer. 

2. Unplug your computer from all electrical sources. 

3. Unplug the MultiPASS from all electrical sources. 

4. On the back of your computer, remove the cable connector from the
parallel printer port. 

5. On the MultiPASS, release the wire clips and remove the cable
connector from the port. 

6. Plug your computer back into the electrical source. 

Using MultiPASS Diagnostics
If you have difficulties with your MultiPASS software or hardware, you can
use the MultiPASS Diagnostics. You use the MultiPASS Diagnostics to
verify your MultiPASS software and hardware installation, and identify
hardware problems. 

The MultiPASS Diagnostics produces a report with information you can
use to resolve your problem. You can save the report to an ASCII text file
on your hard drive. 

1. Open the MultiPASS Diagnostics.

• On the Windows desktop, click Start, and then point to Programs.
On the Programs menu, click Canon MultiPASS L6000. Then
click MultiPASS Diagnostics.

• The MultiPASS Diagnostics displays a message indicating if all
tests were performed successfully. Messages appear suggesting
solutions for any problems detected.
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2. When prompted in a dialog box, click Yes to view the log file. 

3. In the MultiPASS Diagnostics window, to save the log file, choose
Save As on the File menu. 

4. In the Save As dialog box, specify the drive, directory, and filename for
saving the file. Then click OK.

5. To exit the MultiPASS Diagnostics window, click Exit on the File
menu.

Uninstalling the Desktop Manager
If you are planning on reinstalling the MultiPASS Desktop Manager, you
must first uninstall the current installation of the software. When you
uninstall the software, you remove the MultiPASS Desktop Manager and
related printer driver. The following items are not removed, so that you
can reinstall the MultiPASS Desktop Manager at a later time and continue
to use your data files:

❍ MPASS directory

❍ Data folders and files (such as Fax Log and Address Book)

❍ System files shared with other applications

To uninstall the Desktop Manager:

1. Close the MultiPASS Desktop Manager and all MultiPASS-related
utilities (such as the Cover Page Designer).

2. Close the MultiPASS Background (see page 8-17).

3. On the Windows desktop, click Start, and then point to Programs. 

4. From the Programs menu, point to Canon MultiPASS L6000, and
then click MultiPASS Uninstaller. 

5. Follow the on-screen instructions.

n Be sure to restart your computer after uninstalling the Desktop Manager
and before reinstalling.
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❍ To remove the printer driver:

1. On the Windows desktop, click Start, and then point to Settings.

2. On the Settings menu, click Printers.

3. In the Printers dialog box, click the Canon MultiPASS L6000
Printer icon and press the Delete key.

Repeat this step for the Canon MultiPASS L6000 Fax icon.
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This chapter describes the routine maintenance required for your
MultiPASS L6000. It includes:

❍ MultiPASS L6000 guidelines

❍ Routine maintenance

❍ Cleaning inside the MultiPASS

❍ Cleaning the scanner components

❍ Toner cartridge guidelines

❍ Replacing the toner cartridge

❍ Transporting the MultiPASS

MultiPASS L6000 Guidelines
Follow these guidelines to avoid damage to your MultiPASS and harm to
you or others:

❍ Place the MultiPASS on a stable surface. Do not use an angled stand.
Avoid setting the unit in direct sunlight.

❍ Do not install the MultiPASS near devices that contain magnets or
generate magnetic fields, such as speakers.

❍ Do not subject the MultiPASS to strong physical shock or vibration.

❍ Make sure the area where you use the unit is free from dust.

❍ Keep the MultiPASS clean. Dust accumulation can prevent the unit
from operating properly.

❍ To assure proper electrical contact, make sure the unit is firmly
plugged in.

9Maintaining the
MultiPASS L6000
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❍ Never pull on the cord to unplug the MultiPASS. Pull on the plug
itself.

❍ Do not overload the electrical outlet where the MultiPASS is plugged
in.

❍ For your safety, unplug the MultiPASS during electrical storms.

❍ Lift the MultiPASS from the bottom only. Do not lift the unit by the
operator panel, front cover, or any of its trays.

Routine Maintenance
Your MultiPASS requires little routine maintenance. Follow these
guidelines to keep your MultiPASS in good operating condition:

❍ Before you clean the MultiPASS, be sure to print any faxes stored in
memory.

❍ Do not use tissue paper, paper towels, or similar materials for cleaning;
they can stick to the components or generate static charges.

❍ Be sure to disconnect the power cord before cleaning the unit.

❍ Lightly wipe the unit’s exterior with a clean, soft, lint-free cloth
moistened with water or diluted dishwashing detergent solution.

❍ Never use thinner, benzene, alcohol or any other organic solvent, as it
may damage the surface of the MultiPASS.
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Cleaning Inside the MultiPASS 
To prevent toner powder and paper dust from accumulating and affecting
the unit’s print quality, clean the inside of the MultiPASS periodically.

N When you unplug the unit, any faxes stored in memory will be erased. Be
sure to print out any documents stored in memory before unplugging the
unit. See Printing Documents Received in Memory on page 5-5.

❍ Open the front cover by pressing the release latches on the
sides of the unit.

❍ Lift the cover forward to its open position.

Unplug the
MultiPASS and

open the 
front cover.

1
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❍ Hold the cartridge by its handle and remove it.

❍ Store the cartridge in its protective bag to avoid exposure to
light.

C Do not touch the transfer charging roller (black) at the back, as
this may affect the print quality of your faxes.

Use a clean, soft,
dry, lint-free

cloth to remove
any toner or paper

debris from the
shaded area.

3

Remove the 
toner cartridge.

2
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❍ Gently press the cartridge into the unit as far as it will go.
Press down and back on the cartridge’s handle.

❍ Use both hands to lift the cover back into the closed
position.

❍ Plug the unit back in.

Close the 
front cover.

5

When you have
finished cleaning

the MultiPASS,
replace the toner

cartridge.

4
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Cleaning the Scanner Components
Periodically check the scanning glass and rollers.

N When you unplug the unit, any faxes stored in memory will be erased. Be
sure to print out any documents received in memory before unplugging
the unit. See Printing Documents Received in Memory on page 5-5.

❍ If the document scanning glass and rollers are dirty, the
documents you send or print will also be dirty.

❍ Clean with a soft cloth that will not scratch the glass or
rollers.

Use a soft, 
dry clean cloth 

to clean the
scanning glass 

and rollers
(shaded areas).

2

Unplug the
MultiPASS 

and open the 
operator panel.

1
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❍ Dirt and dust particles that collect on the underside of the
operator panel also affect the quality of documents you
copy and send.

Use a soft, dry
clean cloth to
wipe up paper

dust around 
the rollers.

4

Clean the shaded
areas of the

operator panel
and the unit.

3
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9-8 Maintaining the MultiPASS L6000 Chapter 9

N Be sure to close the operator panel until it locks into place.
Otherwise the unit will not function properly.

❍ Plug the MultiPASS back in.

Toner Cartridge Guidelines
The FX-3 Toner Cartridge contains a photosensitive component called the
drum and black carbon powder called toner. The drum is extremely light
sensitive and may deteriorate if exposed to light. Also, poor print quality
may result if the toner becomes unequally distributed inside the cartridge.

When you are
finished, close the
operator panel by
pressing it down
from the center.

5
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When storing toner cartridges, follow these guidelines:

❍ Store cartridges in their protective bags. Do not open a protective bag
until you are ready to install the cartridge in the MultiPASS.

❍ Store cartridges where they will not be exposed to direct sunlight.

❍ Store cartridges right side up—not on their ends or upside down. This
helps prevent the toner particles from settling to one side of the
cartridge, which may cause streaks or lines on your printed pages.

❍ Store cartridges in areas where the temperature is comfortable and
stable. Avoid areas with high temperatures, high humidity, or extreme
changes in either.

❍ Store cartridges away from a monitor’s CRT, disk drives, and diskettes.
The cartridge contains a magnet that could destroy the image data in
the CRT or data on the disks.

After opening the toner cartridge’s protective bag, follow these guidelines:

❍ The cartridge has a handle in the center. Always hold the cartridge by
its handle.

❍ Do not expose a cartridge to direct sunlight. Do not expose it to room
light for more than five minutes.

❍ Do not open the drum’s protective shutter on the bottom of the
cartridge. Avoid touching the protective shutter.

❍ Do not attempt to disassemble the cartridge.

❍ Remove the toner cartridge from the MultiPASS before transporting
the unit. Store the cartridge in its original protective package or wrap
it in a thick cloth to avoid exposure to light.

C Do not incinerate the cartridge. The toner powder is flammable.
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Canon instituted the Clean Earth Campaign to recycle used cartridges. To
participate in this program, simply follow the instructions packed with
your new FX-3 Toner Cartridge. Canon encourages you to return used
cartridges to us at no cost to you.

For more information about the Canon Clean Earth Campaign, you 
can call 1-800-962-2708 in the continental United States. 

FX-3 Toner Cartridge Warranty
The Canon FX-3 Toner Cartridge is warranted against defects in materials
and workmanship for 90 days from the date of original purchase, under
the terms of the Limited Warranty packaged with the cartridge. Refer to
the Limited Warranty for a full statement of your warranty rights.

Under the Limited Warranty, a defective FX-3 Toner Cartridge will be
exchanged for a new cartridge. You can return the defective cartridge to
Canon Computer Systems, Inc., or to one of their Authorized Service
Facilities. To obtain the name and address of the Canon Computer
Systems shipping location or the Authorized Service Facility nearest to you,
please call the Canon Computer Systems Customer Care Center at 1-800-
423-2366.

Before shipping the defective cartridge, place it in its original protective
bag. Seal the bag and place it in the original box and packaging.

You must include the following with your defective cartridge.

❍ Your name and address

❍ A copy of the proof of purchase (bill of sale)

❍ A print sample from the defective cartridge

❍ A complete explanation of the problem

9-10 Maintaining the MultiPASS L6000 Chapter 9
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Replacing the Toner Cartridge
The actual amount of toner that you use will vary depending on the print
density of a page. If the majority of your output is graphics, you may need
to change cartridges more often than when you are printing text only. See
Appendix A, Specifications, for details on the life expectancy of the toner
cartridge.

Preparing the Toner Cartridge

❍ Save the protective bag; you may need to repack the
cartridge later.

❍ Gently rock the cartridge from front to back and from side
to side several times to distribute the toner evenly inside the
cartridge.

❍ Poor print quality may result if the toner becomes
unequally distributed inside the cartridge.

Rock the
cartridge.

2

Remove the 
new FX-3 Toner

Cartridge from its
protective bag.

1
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❍ Place the cartridge on a flat, clean surface, and steady it
with one hand. 

❍ Remove the seal by gently pulling on the plastic tab with
your other hand.

❍ Use a firm even pull to remove the plastic seal. To avoid
breaking the seal, do not jerk on it unevenly.

3
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Inserting the Cartridge

❍ Press the release latches on the sides of the unit.

❍ Lift the cover forward to its open position.

❍ Dispose of the toner cartridge properly. To recycle your
used cartridge, follow the instructions included with your
new FX-3 Toner Cartridge.

Remove the 
old cartridge.

2

Open the 
front cover.

1
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9-14 Maintaining the MultiPASS L6000 Chapter 9

❍ Align the rails on the left and right sides of the cartridge
with the guides inside the unit.

❍ Slide the unit into position.

❍ Always hold the cartridge by its handle when inserting it in
the unit.

❍ Press down and back on the cartridge’s handle.Gently press the
cartridge into 

the unit as far 
as it will go.

4

Insert the new
toner cartridge

into the unit.

3
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Transporting the MultiPASS
If you need to transport the MultiPASS, be very careful. 

❍ Unplug the power cord. 

❍ Disconnect the telephone lines and parallel cable.

❍ Remove any paper from the multi-purpose tray or manual
feed slot.

❍ Remove any document from the ADF.

❍ Open the front cover and remove the toner cartridge.

❍ Store the toner cartridge in its original protective bag or
wrap it in a thick cloth to avoid any exposure to light.

Remove the 
toner cartridge.

3

Remove any 
paper.

2

Disconnect 
all cables.

1

Close the 
front cover.

5
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9-16 Maintaining the MultiPASS L6000 Chapter 9

❍ Remove the paper rest.

❍ Remove the support trays.

❍ Close the output tray and extension.

❍ Replace all shipping tape and shipping materials.

❍ Carefully pack the unit in its original packing materials.

N If you no longer have the shipping carton your MultiPASS came in, pack
the unit in a suitably sized, sturdy cardboard box, using bubble wrap, foam
peanuts, or other suitable packing materials. (If you use foam peanuts, be
sure to wrap the unit in plastic first to prevent the packing materials from
entering any openings in the unit.)

Pack the unit.

5

Remove 
all trays.

4
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This chapter contains information to help you solve problems you may
have when using the MultiPASS L6000. It includes:

❍ Paper jams

❍ LCD messages

❍ Printing problems

❍ Print quality problems

❍ Paper feeding problems

❍ Faxing problems

❍ Telephone problems

❍ Copying problems

❍ General problems

❍ Technical notes

❍ Memory Clear Report

If you have a problem with your MultiPASS and you cannot resolve it by
referring to the information in this chapter, contact the Canon Computer
Systems Customer Care Center. See page 1-2 for details.

Canon’s support personnel are trained in the technical support of Canon’s
products and should be able to help you with your problem. If your
printer requires service, they can provide you with the telephone number
of your local Canon Authorized Service Facility (ASF).

N Attempting to repair the MultiPASS yourself may void the limited
warranty as to that repair. See the limited warranty card for details.

Chapter 10 Troubleshooting 10-1
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If you need to contact Canon directly, make sure you have the following
information:

❍ Product name—MultiPASS L6000

❍ Serial number

❍ MultiPASS Desktop Manager version number

❍ Place of purchase

❍ Nature of problem

❍ Steps you have taken to solve the problem and the results

The serial number is located on the label on the back of the unit:

The version number of MultiPASS Desktop Manager is included in the
About information. In the Desktop Manager, click Help and then click
About.

CANON INC.(DA1)
RS5-8658

MADE IN JAPAN

NO. X X X X X X X X
SERIAL
NUMBER

MP L6000—USERS MANUAL/V000/12-97

A
25

0_
7-

01



Tr
ou

bl
es

ho
ot

in
g

Paper Jams
On occasion, the document feeding into the MultiPASS or the paper in its
multi-purpose tray may misfeed or jam. You can usually clear the problem
easily.

N You need not unplug the MultiPASS to clear paper jams.

Jams in the Automatic Document Feeder (ADF)

Stops the operation.

❍ Gently pull the operator panel toward you.  

N Do not try to pull out the document without opening the operator panel;
you may tear or smudge the document.

Open the 
operator panel.

2

Press STOP.

1

CHECK DOCUMENT
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❍ Pull the jammed page in either direction, but DO NOT
force it.

❍ If a multipage document is loaded, remove the entire
document from the ADF.

❍ Gently press the operator panel until it clicks closed.

❍ Fan and stack the sheets, and replace the stack in the ADF.

❍ Press STOP to clear the error message.

❍ Start your operation again.

Close the 
operator panel.

4

Remove the
document.

3
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Jams in the Output Slots

❍ Fan the paper, and tap it on a flat surface to even out the
stack.

❍ Reload the paper into the multi-purpose tray. Make sure
you adjust the paper guide to the stack, and that the stack
does not exceed the limit mark.

If you are printing from a Windows application, follow any instructions
displayed on your computer.

If the paper jam occurred while a fax was being received, the MultiPASS
will store the fax in memory and print it when the jam is cleared.

Remove the 
stack of paper

from the multi-
purpose tray.

2

Gently pull 
any jammed paper

out of the unit.

1

CLEAR PAPER JAM

Tr
ou

bl
es

ho
ot

in
g

Chapter 10 Troubleshooting 10-5

MP L6000—USERS MANUAL/V000/12-97

JA
M

_R
E

M
O

V
E

FACEDOWN
OUTPUT SLOT

FACEUP OUTPUT
SLOT



10-6 Troubleshooting Chapter 10

MP L6000—USERS MANUAL/V000/12-97

Jams Inside the Unit

C ❍ The fixing assembly (shaded) becomes extremely hot when
the MultiPASS is in use. Be very careful not to touch it, as
injury may result.

❍ When removing the jammed paper, be careful not to touch
the transfer charging roller, as its surface is very delicate and
susceptible to finger oil and scratches, which may lead to
print deterioration.

❍ Press the release latches on the sides of the unit.

❍ Lift the cover forward to its open position.

Open the 
front cover.

1

F
IX

IN
G

_A
S

S
Y

_2
O

P
N

_C
V

R

TRANSFER
CHARGING
ROLLER



Tr
ou

bl
es

ho
ot

in
g

❍ Hold the cartridge by its handle and remove it from 
the unit.

❍ Cover the cartridge to protect it from the light.

Now locate the jammed piece of paper.

Press the paper
release lever

toward the back
of the unit.

3

Remove the 
toner cartridge.

2
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Jams in the Back Area of the Unit

If the paper has jammed near the multi-purpose tray slot:

❍ Hold the unit steady and pull the jammed paper straight out from the
unit.

N ❍ If the jammed sheet tears, remove all of the paper scraps from the 
unit.

❍ Be careful not to spill the toner on the jammed sheet. The toner is 
not fused to the paper yet, and any toner spilled inside the unit may 
adversely affect print quality.

❍ Be careful not to get toner on your hands or clothing. If you do, 
wash it off immediately with cold water.

If the top edge of the paper is in the fixing assembly: 

❍ First move the jammed paper toward the back of the unit (1) 

❍ Then pull it toward you to remove it (2).
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Jams in the Front Area of the Unit

If the top edge of the paper has passed through the fixing assembly:

❍ Pass the paper under the roller.

❍ Use both hands to carefully pull the jammed paper.

❍ Pull gently being careful not to tear the paper. Make sure no paper
remains inside the unit.

❍ Be sure to remove all the jammed paper. Any remaining paper will
cause more jams.
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If the paper is jammed near the faceup delivery slot:

❍ Hold the front cover and gently pull the sheet through the exit slot.

N Do not close the front cover while removing a jammed sheet of paper. This
will return the paper release lever to its closed position.

After Clearing a Paper Jam
After removing the jammed paper, follow these steps:

1. Install the FX-3 Toner Cartridge back in the unit.

2. Move the paper release lever back to its original position (toward 
the front).

3. Close the front cover to reset the unit.

4. Load paper in the multi-purpose tray.

If you are experiencing repeated paper jams, it may be due to the paper
you are using:

❍ Tap the paper on a flat surface before stacking it in the multi-purpose
tray.

❍ Check that the paper you are using and your printing environment are
within the specifications of the unit. See Appendix A, Specifications.

❍ Make sure you have removed any scraps of paper from inside the unit.
Any remaining paper will cause another paper jam.
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LCD Messages
The following messages are displayed in the LCD when the MultiPASS is
performing a function or encounters an error. The Error Code appears on
the Activity Report.

Message Error Code Cause Action
AUTO REDIAL — The MultiPASS is Wait for the MultiPASS

waiting to redial the to try redialing. If that
other party’s number doesn’t work, wait until
because the line was the MultiPASS starts to
busy or the other dial the number, then 
party did not answer press STOP to cancel
when you tried to send redialing. Try to send
the document. the document again at a

later time.

BUSY/NO SIGNAL #005/018 The telephone number Try sending the
you dialed is busy. document at a later

time.
The fax number dialed Check the fax number
was incorrect. and dial again.
The other party’s fax is Contact the other party
not working. and have them check

their fax.
The other party is not Contact the other party
using a G3 machine. and have them send or

receive the document
using a G3 machine.

The touch-tone/rotary Set your MultiPASS
pulse setting on your to the setting that
MultiPASS is incorrect. matches your telephone

line (see page 8-4).
The receiving fax did Contact the other party
not answer within 55 and have them check
seconds. their fax. You can try to

send the document
manually. For an over-
seas call, add pauses at
the end of the registered
number.

CALLING — The MultiPASS is Press STOP if you 
calling the receiving want to cancel the 
fax machine. transmission.
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Message Error Code Cause Action
CHANGE CARTRIDGE — The toner cartridge Rock the cartridge to

may be empty. distribute the toner
inside (see page 9-11).
If necessary, replace the
toner cartridge. Any
documents received in
memory will be printed
automatically.

Memory may be full Replace the toner 
because toner ran out. cartridge and have the

other party send the 
fax again.

CHECK COVER/CART — The toner cartridge Make sure the toner
is not installed properly. cartridge is installed

properly.
The front cover is open. Close the front cover.

CHECK DOCUMENT #001 The document is Remove the document
jammed in the ADF. you are trying to send or

copy and start again.
CHECK PAPER SIZE The size of the paper Set the correct paper 

in the multi-purpose  size in the Receive Fax
tray and that specified dialog box of the 
in the MultiPASS setup Setup Options in the 
are different. MultiPASS Desktop

Manager (see page 8-7).
CHECK PRINTER — The toner cartridge may Reinstall the cartridge

be defective. and try your operation
again.
If the error does not
clear, try unplugging the
unit. Wait several
minutes, then plug it
back in. Also, try
installing a new toner
cartridge.

The unit is connected Make sure the power 
to an uninterruptible cord is plugged into an
power supply (UPS). AC outlet.

CLEAR PAPER JAM #009 There is a paper jam Remove any paper from
or the multi-purpose the multi-purpose tray. 
tray is empty. Clear the paper jam (see 

pages 10-5 to 10-10).
Then reload paper in the
multi-purpose tray. Any
documents received in
memory will be printed
automatically.
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Message Error Code Cause Action
COMMUNICATING — You tried to send a fax Wait until the fax is
PLEASE WAIT manually when the sent, or use memory

MultiPASS was already sending.
sending a fax from
memory.

DOC TOO LONG #003 It took more than 32 Divide the document 
minutes to send or and send or copy each 
copy a document. part separately.
It took more than 32 Contact the other party.
minutes to receive a Have them divide the
document. document and send 

each part separately.
The document is longer Use a copy machine to
than 39.4 inches (1 m). make a reduced copy of

the document and send
the copy.

DOCUMENT READY — The document in the Send the fax, scan the 
ADF is ready for faxing, document, or make a 
scanning, or copying. copy.

ECM RX — The MultiPASS is ECM transmissions may
ECM TX — receiving (RX) or take longer than normal

sending (TX) a fax transmissions. Turn off
using ECM. ECM if you need to

receive or send quickly,
or if you know your local
lines are in good
condition.

HANG UP PHONE — The telephone is Place the telephone
off hook. properly into its cradle.

LOAD PAPER — The MultiPASS is out Load paper in the multi-
of recording paper purpose tray. Any 
(the multi-purpose documents received in
tray is empty). memory will be printed

automatically.
MEMORY FULL #037 The memory of the Print out any documents

MultiPASS is full that are stored in 
because it has received memory. Then start the 
too many documents, operation again.
or a very long or 
detailed document.
Memory is full because Divide the document 
you tried to send too and send each part 
many pages at once, separately.
or a very long or
detailed document.

MEMORY FULL — The MultiPASS is The MultiPASS
PLEASE WAIT sending a fax and its continues to send the

memory is full. fax as memory becomes
available.
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Message Error Code Cause Action
MEMORY USED nn% — Shows the percentage of If you need more space,

memory currently in use. print or send any
documents in memory.

NO ANSWER #005 The receiving fax Make sure you dialed 
machine does not the correct number. 
answer. Try again later.

NO RX PAPER #012 The other party’s fax is Contact the other party
out of paper or its and have them install
memory is full. paper in their fax.

NO TEL # #022 The one-touch or coded Register the number
speed dialing number (see page 3-18).
has not been registered.

NOT AVAILABLE — In manual sending, you Use regular dialing.
entered a speed dialing
number that is assigned
to a group.

PLEASE WAIT — The MultiPASS is Wait until the date and
warming up. Receive Mode appear in

the LCD display, then
begin.

REC’D IN MEMORY — The paper or toner ran Add paper to the multi-
out, or a paper jam purpose tray, change the
occurred, so the toner cartridge, or clear 
MultiPASS received the the paper jam. The
document in memory. MultiPASS automatically

prints the document
stored in memory.

RECEIVED IN FILE — The computer was Turn the computer on 
off and a document to upload the file to the
was received in the Desktop Manager. 
memory of the 
MultiPASS. To print the document, 

press FUNCTION then
scroll to FILE PRINT and
press START/COPY.

START AGAIN — An error has occurred Start the procedure 
in the phone line or in again from the 
the system. beginning.

TX/RX CANCELLED — You pressed STOP to Try sending again.
cancel the transmission.

TX/RX NO. nnnn — When the MultiPASS Write the number down 
sends or receives a fax, if you’ll need it later. 
it assigns it a unique
identification number.
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Printing Problems
Problem Cause Solution

The ALARM light The MultiPASS may have a Clear any paper jams. See 
comes on and the paper jam. page 10-3.
MultiPASS L6000
beeps while printing If you cannot clear the 

problem, unplug the
MultiPASS, wait 15 seconds,
then plug it in again. (You will
lose any documents stored in
memory.) If the problem is
fixed, the ALARM light will be
off and the LCD display will
show the date and Receive
Mode (Standby Mode).

If the ALARM light stays on,
call the Customer Care Center.
See page 1-2.

Data from computer is The power cord may not Check that the power cord is
not printed be plugged in securely. plugged securely into the unit

and into the wall outlet. If the
MultiPASS is plugged into a
power strip, make sure the
power strip is plugged in and
turned on.

The interface cable may not Check the interface cable 
be securely connected to the connection.
MultiPASS and the computer.

The interface cable may Make sure the cable is a
not be the correct type. bi-directional parallel interface

cable less than 6.6 feet (2 m) in
length.

The MultiPASS or computer Unplug the MultiPASS and
may have been turned on turn off the computer. Plug
when you connected the the unit back in and turn
interface cable. the computer back on again.

The toner cartridge may need Rock the toner cartridge.  
to be replaced.  See page 9-11.

The application you are Check the computer and the
printing from may not be application to make sure they 
set up properly. are configured correctly.
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Problem Cause Solution

Data from computer is The MultiPASS L6000 may not Make sure the MultiPASS
not printed (continued) be set as the default printer L6000 is selected as the default

or the selected printer. or current printer.

Make sure MultiPASS
Background is running.

The printer driver may be Make sure the MultiPASS 
configured with the wrong Printer Driver is configured
port. to use the computer’s 

parallel port. See page 2-5.

The computer’s parallel port Make sure your computer’s 
may be disabled. CMOS has the primary 

parallel port set to LPT1.
(Your computer should have
a Setup Program that lets you 
do this.) See your computer’s
documentation.

The printed output is There may be a communication Make sure the computer 
not what you expected problem between the MultiPASS and the application are 

and your computer. configured correctly for 
communicating with the
MultiPASS.

The interface cable may not Check the interface cable’s 
be securely connected to the connections. 
MultiPASS and the computer.

The interface cable may not Make sure you are using a
be the correct type. bi-directional parallel interface 

cable that is less than 6.6 feet 
(2 m) long.

You may not be using the Make sure you have
correct printer driver. selected the MultiPASS

printer in your application.

Previous software settings Make sure the MultiPASS
may not be cleared. was cleared of the previous 

software settings before the 
print job started. See the 
application’s documentation.
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Problem Cause Solution

Printout does not Paper may not be loaded Make sure the paper is loaded
match paper size and aligned correctly in and aligned correctly. See

the multi-purpose tray. page 1-9.

The application’s page Make sure the paper size and
size and margin settings margin set in your application
may be incorrect. are correct for the paper in the

multi-purpose tray.

The selected printer driver Make sure you select the
may be incorrect. MultiPASS printer in your

application.

Print jobs vanish or you Another Windows application Turn off spooling in the
are printing garbage on your computer may be MultiPASS Printer Driver.

trying to communicate with See page 2-5.
the printer port the MultiPASS
Background is using. This
conflict can result in strange
printing behavior.

Make sure the MultiPASS If the MultiPASS Background 
Background is loaded. icon does not appear on the

bottom of your screen, turn on
the MultiPASS Background.

The printout curls Your pages may include a Remove each sheet as it is
large amount of toner. printed. Allow it to dry, then

roll it in the opposite direction
of the curl.

Your computer indicates A device time-out occurs when Make sure the MultiPASS 
a device time-out the computer sends data to the is plugged in, and that its 

MultiPASS, but the MultiPASS interface cable is securely
does not respond. The attached to the unit and to
MultiPASS may be unplugged, the computer. Clear any paper 
not connected to the computer, jams, and make sure paper is 
or have a paper jam. loaded properly in the multi-

purpose tray.
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Print Quality Problems
Problem Cause Solution
Print is not clear The paper you are using Make sure you are using 

may not be supported by paper that matches the
the unit. specifications (see page A-1).

You may be printing on the Some paper has a right side 
wrong side of the paper. for printing. If the print quality

is not as clear as you would like
it to be, try turning the paper
over and printing on the other
side. 

Printed output has Toner may be low or Remove the toner cartridge
vertical white lines unevenly distributed. and gently rock it from front 

to back and from side to side to
evenly distribute the toner. 
If this does not solve the
problem, replace the toner
cartridge.

Paper Feeding Problems
Problem Cause Solution

Paper does not load The multi-purpose tray may Make sure the stack of paper
contain too many sheets. in the multi-purpose tray does

not exceed the limit mark.

Paper may not be inserted Make sure the stack of paper
correctly in the multi-purpose is inserted into the multi-
tray. purpose tray, and the paper

guides are adjusted correctly.

Certain types of paper may not Try feeding the paper through 
feed properly through the the multi-purpose tray, one
manual feed slot. sheet at a time.

Paper is loaded skewed Paper may not be stacked Make sure the stack of paper
(printing is skewed) correctly in the multi-purpose is straight in the multi-purpose

tray. tray. 

Make sure there are no gaps
between the stack of paper and
the paper guides.

Make sure the paper exit path is
clear.
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Problem Cause Solution

Several sheets load Paper may not be loaded Make sure paper is inserted
into unit at the same correctly in the multi-purpose correctly in the multi-purpose
time tray. tray.

Sheets of paper may be Be sure to fan the stack of 
sticking together. paper before placing it in the

multi-purpose tray.

Too much paper may be Make sure the paper rest is
stacked in the multi-purpose extended and the paper is
tray. stacked correctly in the 

multi-purpose tray.

Do not force the stack into the
multi-purpose tray.

Different types of paper may Load just one type of paper.
be stacked in the multi-purpose
tray.

Make sure you are loading paper
that matches the specifications
of this unit.
See Appendix A, Specifications,
for details.

Transparencies do not The transparency may not Make sure you load only one
feed correctly be loaded correctly. transparency at a time.

Repeated paper jams The paper you are using may Fan the paper before stacking
occur be causing the jams. it in the multi-purpose tray.

This keeps the sheets of paper
from sticking together.

Check that the paper you are
using and your printing
environment are within the
specifications of the unit. See
Appendix A, Specifications, 
for details.

Envelopes do not feed Envelopes may not be Make sure the envelopes are
loaded correctly. loaded properly. (See page 2-11.)

Make sure there are no more
than 7 envelopes in the multi-
purpose tray.

You may need to choose Make sure you select the
the envelope setting in correct envelope size in the
your printer driver. Paper Setting dialog box in your

printer driver. 

Envelopes may not match Envelopes must be U.S.
the specifications for this unit. Commercial number 10 

(9.5 × 4.1 inches) or 
European DL (220 × 110 mm).



10-20 Troubleshooting Chapter 10

MP L6000—USERS MANUAL/V000/12-97

Faxing Problems
Problem Cause Solution

Cannot send a The MultiPASS may have Unplug the unit and let it
document overheated. cool for several minutes. Try

sending again.

The MultiPASS may not be If you have a pulse line, be 
set for the type of telephone sure the MultiPASS is set
line in use (pulse/tone). for pulse dialing.

The document may not Remove the document, stack
have been fed correctly it, and load it into the ADF
into the MultiPASS. correctly (see page 1-12).

Make sure the operator panel 
is closed.

The one-touch or coded Check the one-touch or coded
speed dialing number you speed dialing button and be
used may not be registered sure it is registered correctly.
for the feature you want 
to use.

The receiving fax may be Call the other party and ask
out of paper. them to make sure paper is

loaded.

There may be other documents Allow time for the current 
being sent from memory. document to finish sending.

An error may have occurred Check the LCD for an error
during sending. message.

The telephone line may not Make sure there is a dial tone
be working properly. when you lift the telephone. 

If not, contact the local
telephone company.

The receiving fax machine may Make sure the receiving fax 
not be a G3 fax machine. machine is compatible with 

the MultiPASS (which is a G3
fax machine).

Images on faxes The receiving fax machine may Check the MultiPASS by
received from the not be working properly. making a copy. If the copy is
MultiPASS are clear, the problem may be in 
spotted or dirty the receiving fax machine.

The document may not be Remove the document and
properly inserted in the load it correctly into the 
ADF. ADF. See page 1-12.
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Problem Cause Solution

Cannot send or receive The other party’s fax may Some fax units do not 
using Error Correction not support ECM. support ECM transmission.
Mode (ECM) If the other party’s fax does

not support ECM trans-
mission, then the document is
sent in the normal mode
without error checking.

Errors occur frequently The phone line may be in Lower the transmission speed.
while sending or receiving poor condition, or you may See the Advanced: Send Fax

have a poor connection. dialog box (page 8-5) and the
Advanced: Receive Fax dialog
box (page 8-8).

The sending fax machine may The sending fax machine
not be functioning properly. usually determines the fax’s

quality. Call the sender and 
have them make sure the top 
cover and scanning glass on 
their fax machine are clean.

Cannot receive a The MultiPASS may not be To receive faxes automatically,
fax automatically set to receive automatically. the Receive mode must be

Fax Only, FaxTel, or Ans.
Machine mode.

The MultiPASS may have a Print out any document 
document stored in memory. stored in memory. (See 

page 5-5.)

The MultiPASS Desktop Check the In Box in the 
Manager may have Desktop Manager.
received the fax.

An error may have occured Check the LCD for an error
during reception. message. (See page 10-11.)

The multi-purpose tray may Make sure paper is loaded
be empty. in the multi-purpose tray.

The telephone line may not Make sure all phone line
be connected properly. connections are secure.

The MultiPASS is printing The incoming fax is stored 
a document. in memory and will print

when the print job is 
complete. 
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Problem Cause Solution

The MultiPASS does The MultiPASS may not For the MultiPASS to switch
not switch automatically be in FaxTel mode. automatically between fax 
between telephone and and telephone reception, the
fax transmissions Receive Mode must be set to

FaxTel mode.

In the Advanced: Receive Fax Make sure this option is set
options, the “Default Action to Receive. (See page 8-8).
if No Answer To Telephone”
is set to Disconnect.

There may be a document Make sure you have printed
in memory. out any documents in memory.

An error may have occured Check the LCD for an error
during reception. message. (See page 10-11.)

The multi-purpose tray may Make sure paper is loaded in
be empty. the multi-purpose tray.

The sending fax may not Some fax units cannot send
send the CNG signal that the CNG signal that tells your
tells the MultiPASS that the MultiPASS the incoming signal
incoming signal is a fax. is from a fax. In such cases, 

you will have to receive the
document manually.

Cannot receive a You may have pressed Always press START/COPY
document manually START/COPY after hanging before hanging up the 

up the telephone. telephone. Do not press 
START/COPY after you hang
up the telephone; this will 
disconnect the call.
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Problem Cause Solution

Print quality is poor You may not be using the Be sure you are using paper
correct type of paper. that meets the paper

requirements for the MultiPASS
(see page A-1).

The sending party may be Make a copy on your
having a problem. MultiPASS. If the image is

OK, then your MultiPASS is
operating properly. Contact
the other party and have
them check their machine.

Error correction (ECM) Make sure Error correction
may be disabled. (ECM) is set to on in the

Advanced: Receive fax
dialog box of the Desktop
Manager.

Faxes do not print The toner cartridge may not Make sure the toner cartridge 
be installed correctly. is installed correctly (see page 

9-11).

The toner cartridge may need Try another toner cartridge.
to be replaced.

Fax images print blotched The telephone lines may ECM sending/receiving should
or uneven be in poor condition, or eliminate such problems. 

you may have a bad However, if the telephone 
connection. lines are in poor condition,

you may have to try again.

The other party’s fax may Remember, the sending fax
have a problem. usually determines document

quality. Be sure the other party’s
top cover and scanning glass are
clean.
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Telephone Problems
Problem Cause Solution

You cannot dial The telephone line may Be sure the telephone line is
not be connected properly. correctly connected to the

MultiPASS (see your Quick Start
Guide).

The unit may not be getting Make sure the power cord is
power. connected to the MultiPASS

and to an AC outlet; make
sure the AC outlet has power.

The MultiPASS may not If you have a pulse line, be 
be set for the type of sure the MultiPASS is set for
telephone line in use pulse dialing (see page 8-4).
(pulse/tone).

The phone disconnects The MultiPASS may not be Make sure the MultiPASS
while you are talking plugged in properly. is plugged in correctly.
on the line

If the MultiPASS is in Disable the “If Silence is heard 
Answer Machine Mode and for” option in the Answering 
Silent Receive is enabled, Machine Mode Option of the
the unit will switch to fax Advanced Receive Fax dialog 
receive mode when it detects box.
a period of silence.

Copying Problems
Problem Cause Solution

The MultiPASS will not The document may not be Make sure the document is set
make a copy loaded correctly in the ADF. facedown in the ADF and the

LCD displays DOCUMENT
READY.

Make sure the operator panel
is closed.

The telephone may be off hook. Make sure the telephone is 
in its cradle.

The toner cartridge is not Make sure the toner cartridge 
installed. is installed correctly.

The MultiPASS may not be Try to print a document from
be operating properly. your computer.
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Problem Cause Solution

MEMORY FULL The MultiPASS’s memory Print out any faxes stored in 
appears in the LCD is full. memory. Then print one copy 
when you are making at a time.
multiple copies

The documents you are trying If nothing is stored in memory,
to print may have too much print one copy at a time.
graphic or detailed information.

General Problems
Problem Cause Solution

The MultiPASS has The power cord may not be Make sure the power cord is
no power securely plugged into the unit. plugged securely into the unit

and into a wall outlet.

If the power cord is connected
to a power strip, make sure the
strip is connected to an outlet
and turned on.

The power cord may not be Check the power cord by
supplying power. substituting another, or by

connecting the power cord to a
wall outlet you know to be
working.

Nothing appears in the The MultiPASS may not be Check the plug and be sure it is
LCD display receiving power. firmly plugged into the power

connector and the wall outlet.

Open and close the front cover.

If the display remains blank,
unplug the MultiPASS, wait five
seconds, then plug it in again.
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Technical Notes
Using Other Bi-directional Devices

If you have another bi-directional device (such as a Windows Printing
System printer or a later-model laser printer) installed on your computer
and you are attempting to use the same port on which you have the
MultiPASS connected, you may experience undesirable results when
printing a document.

Be sure the MultiPASS is the only device configured to a particular port.
The MultiPASS operates properly only with a dedicated parallel port.
(Note that you can set the WPS driver to file, or use a PCL emulation
driver for the WPS printer, or install a second parallel port—one for each
printer.)

MultiPASS Hardware Cannot Initialize
1. Remove any pass-through devices, switch boxes, zip drives, tape

backups, docking stations, scanners, and any software associated with
these products. 

2. Make sure that the MultiPASS is connected directly to the computer
with a bi-directional (IEEE 1284-compliant) interface cable that is 6
feet or shorter. Do not attempt to use a longer cable.

3. Shut down the computer and unplug the MultiPASS. Disconnect and
reconnect the interface cable. Plug in the MultiPASS and wait until
the LCD displays the date and Receive Mode. Once the unit is in
Standby mode (the LCD displays the date and Receive Mode), turn on
the computer.

4. Check that the parallel port is set for ECP or bi-directional mode in
the computer’s BIOS. If you do not know how to enter the BIOS or
make the changes, contact the computer manufacturer.

5. If the above procedures do not resolve the problem, please call the Canon
Computer System Customer Care Center. See page 1-2 for details.
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Using Switch Boxes
Canon does not recommend using a switch box with the MultiPASS. To
use more than one printer, it’s a good idea to add a second parallel port to
your computer.

If the Power Goes Out
If power to the MultiPASS L6000 is cut off, any documents stored in its
fax memory will be lost. (The MultiPASS automatically prints a list of the
lost documents when power is restored.) Because of this, be sure to print
documents stored in memory or resend them as soon as possible.

While the power is out, the MultiPASS will receive telephone calls if a
telephone is attached. However, you cannot make calls (unless you are
using a cordless phone) or send or receive faxes.

Avoid unplugging the MultiPASS unless absolutely necessary. This is the
same as a power outage.

Memory Clear Report
The Memory Clear Report summarizes the documents that were cleared
from memory when a power failure occurred. This report is generated
automatically.

❍ If you experience a power failure, any documents stored in memory
will be lost.

❍ When you turn on the MultiPASS after power is restored, the
MultiPASS automatically prints out a list of documents that were
stored in the memory at the time of the power failure.
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N If there is no paper in the multi-purpose tray when the power goes out, the
LCD will display LOAD PAPER and PRINTING REPORT when the power is
restored. If this happens, load paper in the multi-purpose tray and wait for
the unit to print the Memory Clear Report. You will be unable to send
documents or receive faxes in memory until you do 
this. If you have no paper available and you urgently need to send a
document or receive a fax in memory, press the STOP button to enable
sending and receiving. However, please note that once you have pressed the
STOP button, the unit will no longer print the Memory Clear Report.
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Printing method
Laser beam printing

Printing resolution
300 × 300 dpi (default)
600 × 600 dpi 

Paper handling
Automatic feed
Manual feed

Multi-purpose tray capacity
Plain paper

(20 lb or 75 g/m2) Approx. 100 sheets 
Envelopes 7 envelopes (U.S. Commercial 

number 10 or European DL)

Paper size
Letter 8.5 in × 11 in
Legal 8.5 in × 14 in
A4 210 mm × 297 mm
U.S. Commercial  

number 10 envelope 9.5 in × 4.1 in
European DL envelope 220 mm × 110 mm

Media type
Plain paper Auto (100 sheets) or manual feed
Transparencies Manual feed only (faceup delivery)
Envelopes Auto (7 envelopes) or manual feed (faceup 

delivery)

Paper weight
Automatic feed 17 to 24 lb (64 to 90 g/m2) 
Manual feed 17 to 28 lb (64 to 105 g/m2) 

Printing width
Maximum 8.56 in (212 mm)

Print speed
Up to 6 ppm

ASpecifications
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Printable areaÑPapers
The shaded portion in the following figure shows the printing area 
for papers.

Printable areaÑEnvelopes
The shaded portion in the following figure shows the printing area for an
envelope.

Interface
IEEE 1284-compatible, bi-directional parallel interface

European 
DL

a 110 mm
b 220 mm
c 5.5 mm (max)

U.S. 
Commercial 
number 10

a 4.1 in
b 9.5 in
c 0.22 in (max)

c

a

b

A4 size
a 210 mm
b 4.0 mm (max)
c 5.0 mm (max)
d 297 mm
e 5.5 mm (max)
f 10.1 mm (max)

Legal size
a 8.5 in
b 0.16 in (max)
c 0.20 in (max)
d 14.0 in
e 0.22 in (max)
f 0.42 in (max)

Letter size
a 8.5 in
b 0.16 in (max)
c 0.20 in (max)
d 11.0 in
e 0.22 in (max)
f 0.40 in (max)

a

b

e

d

f

c
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Toner Cartridge
FX-3 Toner Cartridge
Cartridge yield Approx. 2700 pages/cartridge 

at 4% paper coverage

Facsimile
Applicable line
Public switched telephone network

Compatibility
G3

Data compression system
MH, MR, MMR (ECM-MMR)

Modem type
Fax modem

Modem speed
14400/9600/7200/4800/2400 bps

Automatic fallback

Transmission speed
Approx. 6 seconds/page* at 14.4 Kbps, G3 ECM-MMR

transmitting from memory

Transmission/reception memory
Approx. 1.4 MB DRAM, MR storage
Approx. 122 pages* (up to 20 documents)
LCD displays memory used 
Uses direct transmission when memory full

Automatic Document Feeder (ADF)
20 pages, letter or A4 size (based on 20 lb paper)
10 pages, legal size
1 page, other sizes

Fax printing speed
Approx. 6 pages/minute*

*Based on the CCITT #1 Chart, Standard mode

Appendix A Specifications A-3
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Fax resolution
Fine mode—203 pels/in × 196 lines/in

(8 pels/mm × 7.7 lines/mm)

Standard mode—203 pels/in × 98 lines/in
(8 pels/mm × 3.85 lines/mm)

Dialing
Automatic dialing

One-touch speed dialing (6 locations)
Coded speed dialing (50 locations)
Group dialing (55 locations)

Manual dialing (with numeric buttons)
Automatic redialing (including error redialing)

Redial times: 1-10
Redial interval: 2-99 min

Manual redialing
Pause button (variable length: 1-15 sec)

Networking
Delayed transmission (through Desktop Manager only)
Sequential broadcast (up to 57 locations through operator panel and up 

to 65 locations through Desktop Manager)
Automatic receiving
Non-ring reception
Deactivate ECM
DRPD (Distinctive Ring Pattern Detection)

Report/reference
Activity report (up to 20 transactions)
Non-delivery report
TTI (Transmitter Terminal Identification)

Toner saver
Economy mode for printing received faxes extends 
cartridge life to approx. 2700 pages

A-4 Specifications Appendix A
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Copier
Scanning resolution
600 × 300 dpi (Direct copy)
300 × 300 dpi (Memory copy)

Printing resolution
600 × 600 dpi

Default size
100%

Reduction sizes
70%, 80%, 90%

Copy speed
One copy only—25 seconds
First copy of multiple copies—45 seconds
Subsequent copies—10 seconds

Multiple copies
Up to 99 copies of a document

Scanner
Scanning method
Solid-state electronic scanning by contact image sensor

Scanning image processing
UHQ™ (Ultra High Quality image enhancement)
Halftones—256 levels of gray

Automatic document feeder
Paper size—Up to 20 letter-size or A4-size sheets

10 legal size sheets
1 sheet for other sizes
(Based on 20 lb paper)

Document thickness—
Auto feed—0.002 to 0.005 in (0.07 to 0.13 mm)
Manual feed—0.023 to 0.0118 in (0.06 to 0.3 mm)

Document weight—
Auto feed—13 to 24 lb (50 to 90 g/m2)
Manual feed—10.6 to 90 lb (40 to 340 g/m2)

Appendix A Specifications A-5
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Scanning resolution
200 × 200 dpi, 300 × 300 dpi, and 600 × 600 dpi

Effective scanning width
8.42 in (214 mm)

Compatibility
TWAIN

Scanning speed
B&W Text mode—8.7 sec/page (300 × 300 dpi) 

17.5 sec/page (600 × 600 dpi)
Grayscale mode—35 sec/page (300 × 300 dpi) 

70 sec/page (600 × 600 dpi)

Document sizes (W × L)
Maximum—Auto feed—8.5 × 14 in (216 × 355.9 mm)
Maximum—Manual feed—8.5 × 39 in (216 × 1 mm)
Minimum—Auto feed—4.1 × 5.8 in (105 × 148 mm)
Minimum—Manual feed—3.5 × 1.75 in (88.9 × 44.5 mm)

8.5 in
(216 mm)

Up to a maximum 
of 32 minutes for 
sending each page
or
14 in (355.9 mm) in 
length (AUTO FEED) or 
approx. 39 in (1 m) in 
length (MANUAL FEED)

3.5 in
(88.9 mm)

MANUAL FEED

AUTO FEED

1.75 in
(44.5 mm)

4.1 in
(105 mm)

5.8 in
(148 mm)

A-6 Specifications Appendix A
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Scanned image
The actual scanned image size for the MultiPASS is shown below. This
information applies to documents that will be scanned for faxing or
copying.

There is a 0.12 in (3.0 mm) margin on either side of the sheet and a 
0.16 in (4.0 mm) margin on the top and bottom that are outside
the scanning area.

MultiPASS Desktop Manager for Windows
System Requirements
IBM® PC or compatible computer with a 486DX 66 MHz or 

higher processor
16 MB of memory 
25 MB of free hard disk space 
Microsoft Windows 95 
Bi-directional Centronics-compatible parallel cable (IEEE 1284-compliant)
CD ROM drive

PC Fax
Canon proprietary MultiPASS Desktop Manager for Windows
Fax/Telephone address book
Fax Viewer
Fax Log
Fax distribution lists
Real-time MultiPASS hardware status available through computer

Legal/Letter

0.12  in
(3.0 mm)

0.12  in
(3.0 mm)

0.16  in
(4.0 mm)

0.16  in
(4.0 mm)8.42  in

(214 mm)

Appendix A Specifications A-7

MP L6000—USERS MANUAL/V000/12-97

P
A

P
E

R
 S

IZ
E



A-8 Specifications Appendix A

General Specifications
Power Source
120V/60Hz

Power Consumption
Approx. 620W (Maximum)
Approx. 7W (Standby)

Dimension (W x D x H)
144 in × 14.4 in × 9.5 in
(365 mm × 365 mm × 242 mm)
Main unit – no trays

Weight
19.0 lb (8.6 kg)

Environmental Conditions
Temperature: 50° F - 90.5° F (10° C - 32.5° C)
Humidity: 20% to 80% RH

Liquid Crystal Display (LCD)
16 × 1

Display Languages
English, French, Spanish

Telephone
Automatic FAX/TEL switchover
Answering machine connection

(CNG detecting signal, no sound)
Telephone connection
Remote reception by telephone
Remote receiving ID (Default): 25
Tone button
Pause button (variable length: 1-15 sec)

MP L6000—USERS MANUAL/V000/12-97
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Space Requirements
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27.0” (685 mm)

14.3” (365 mm)

TOP VIEW

SIDE VIEW
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Receiving Faxes and Phone Calls
AutomaticallyÑFaxTel Mode

In FaxTel mode, the MultiPASS monitors all incoming calls to see whether
the call is from another fax machine or from a telephone:

Telephone Fax  Fax  

Sending document 
manually

Sending document 
automatically

MultiPASS answers without ringing

MultiPASS listens for FAX TONE
(For 8 sec)

FAX TONE
 detected   

FAX TONE is not detected

Document received 
automatically.

MultiPASS starts ringing Pick up the 
handset to talk.

If you don’t pick up the handset
(within 15 sec)

F/T SW ACTION
Choose between:

Receive (factory default setting) and Disconnect
DISCONNECT

RECEIVE
(Factory default setting)

(FAX TONE is detected 
and the MultiPASS 
switches to receive  
mode.)

The MultiPASS 
disconnects the call.

F/T RING TIME
(Factory default 
setting = 15 sec)

RING START TIME
(Factory default 

setting = 8 sec)

Telephone charges 
begin for caller.

Type of call

MP L6000—USERS MANUAL/V000/12-97
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If you plan to use the MultiPASS as a stand-alone fax, and you do not
install the MultiPASS Desktop Manager, you must enter your name and
fax number from the operator panel. If you choose to use the MultiPASS
this way, you will not be able to use its many features, such as speed
dialing, PC faxing, or scanning. Canon recommends that you install the
MultiPASS software as described in the Quick Start Guide. See Chapter 3
for details on using the MultiPASS Desktop Manager.

LCD Menu System
Default settings are shown in bold.

Option Description/Settings

USER SETTINGS

DATE & TIME Set the date and time (24-hour clock) using the
numeric buttons.

UNIT TELEPHONE # Enter your fax number using the numeric buttons
(up to 20 characters).

UNIT NAME Enter the name you want to appear at the top of
each fax page you send (up to 24 characters).

TEL LINE TYPE Sets the dialing method the MultiPASS L6000
uses to match the type of phone line you have,
TOUCH TONE or ROTARY/PULSE.

FILE PRINT Prints documents stored in the MultiPASS
memory (when the MultiPASS Desktop Manager
is installed).

MP L6000—USERS MANUAL/V000/12-97
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Entering Information in the MultiPASS 
When using the MultiPASS as a stand-alone fax machine, you must enter
your user information into the unit through the operator panel.

When entering information through the operator panel of the MultiPASS,
follow these guidelines.

❍ If you pause and do not make an entry for more than 60 seconds, the
MultiPASS returns to Standby mode. You must start the procedure
over from the beginning.

❍ If you make a mistake while entering registration information, you can
correct it in one of two ways:

• Press < or > to move the cursor under the wrong character, and
then enter the correct character.

• Press STOP and reenter the information.

Entering Your User Information
Follow the steps below to set the date and time for your MultiPASS and to
enter your fax number and your name. The date and time appear in the
LCD display as well as on the documents you send. Your fax number and
name appear on each document you send.

MP L6000—USERS MANUAL/V000/12-97
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❍ Use the month-day-year format (mm/dd/yy).

❍ Precede single digits with a zero.

11/15/97 00:00

1 2
ABC

3
DEF

4 5
JKLGHI

6
MNO

7 8
TUVPRS

9
WXY

0
OPER

TONE

SYMBOLS

Enter todayÕs
date and the 

time using the 
numeric buttons.

3

06/08/97     15:36
START/COPY

DATE & TIMESTART/COPYPress
START/COPY

twice.

2

USER SETTINGS
1 2Then press  

the > button.

FUNCTION 
FUNCTIONPress FUNCTION

on the one-touch
speed dialing

keypad.

1

MP L6000—USERS MANUAL/V000/12-97
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❍ Set the time using the 24-hour clock system.

❍ Example:

07:30 = 7:30 A.M.
17:05 = 5:05 P.M.

❍ You can enter a space with the > button to make your
number easier to read.

TEL =   6665552222

1 2
ABC

3
DEF

4 5
JKLGHI

6
MNO

7 8
TUVPRS

9
WXY

0
OPER

TONE

SYMBOLS

Enter your fax
number (up to 20

digits) using the
numeric buttons.

5

TEL = START/COPY

DATA ENTRY OKSTART/COPYPress START/COPY
twice when the

date and time 
are entered.

4

11/15/97     08:15

1 2
ABC

3
DEF

4 5
JKLGHI

6
MNO

7 8
TUVPRS

9
WXY

0
OPER

TONE

SYMBOLS

MP L6000—USERS MANUAL/V000/12-97
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❍ After a few seconds, the LCD display changes to:

❍ Press the button with the letter you want to enter; for
example, press 2 three times to enter a capital C.

Button Characters
1 1
2 ABCabc2
3 DEFdef3
4 GHIghi4
5 JKLjk15
6 MNOmno6
7 PQRSpqrs7
8 TUVtuv8
9 WXYZwxyz9
0 0
# -.*#!”,;:^’_=/|’?$@%&+()[]{}<>

❍ Correct errors by moving the cursor to the error using 
< or > (on the one-touch speed dialing keypad) and
entering the correct character.

CANON FAX BACK

Enter your 
name (up to 

24 characters)
using the 

numeric buttons.

7

START/COPYThen press
START/COPY

again.

UNIT NAME

DATA ENTRY OK
START/COPYPress START/COPY

when the 
fax number 
is entered.

6

MP L6000—USERS MANUAL/V000/12-97
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The MultiPASS returns to Standby
Mode.

STOPPress STOP to
complete the
registration.

9

DATA ENTRY OK
START/COPYPress START/COPY

when you finish
entering your

name.

8

MP L6000—USERS MANUAL/V000/12-97
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Activity report
Journal of fax transactions, both sent and received.

Address Book
The electronic Address Book provided by the MultiPASS Desktop
Manager that allows you to create a list of people with their phone and fax
numbers.

Automatic dialing
Dialing fax or telephone numbers by using a shortcut of pressing one to
three buttons. To use automatic dialing, you must register the numbers in
the MultiPASS Desktop Manager. See also one-touch speed dialing keypad,
coded speed dialing, and group dialing.

Automatic document feeder (ADF)
Refers to the document tray in which you stack the document you want to
fax, copy, or scan.

Automatic redialing
When the receiving fax machine is busy or does not answer, or when an
error occurs while sending, the MultiPASS waits a specified amount of
time and then automatically redials the number. You define the number of
times the unit redials and the length of time between redialing.

Bi-directional parallel interface port 
An interface connection that is capable of both sending or receiving. For
example, when you print and when you send a fax from your computer,
data goes from your computer to the MultiPASS; when you scan and when
you receive a fax into your computer, data goes from the MultiPASS to
your computer.

bps
Bits per second. Refers to the speed with which a fax machine sends and
receives data.

Broadcasting
Transmitting documents to more than one location.

GGlossary



G-2 Glossary

CCITT #1 Chart
A test chart, defined by CCITT/ITU-TS, used to measure the
transmission speed as well as the transmitting and receiving memory
capacity of a fax machine.

CCITT/ITU-TS
Formerly known as CCITT, Consultative Committee for International
Telegraph and Telephone. CCITT has been replaced by the International
Telecommunications Union-Telecommunications Sector (ITU-TS), a
committee created to set international standards for telecommunications.

Centronics
The popular name for the parallel printer port used by most printers and
personal computers.

CNG
Calling Tone. This is a signal sent by fax machines to identify the call as an
incoming document. When the receiving fax detects this signal, it
automatically starts to receive the fax transmission. The majority of fax
machines in use today can send and detect CNG signals.

Coded speed dialing
An automatic dialing method that allows you to dial a fax or telephone
number by pressing the CODED DIAL button and a two-digit code using
the numeric buttons. 

cps
Characters per second. A unit of measurement that indicates the printer’s
speed.

dB(A)
Stands for decibel level (a decibel being a unit of measurement for the
intensity of the sound coming from the unit), adjusted for background
noise.

Dialing methods
Ways of pressing one or more buttons to access a number to connect to an
outside party or fax machine. Dialing methods include one-touch speed
dialing, coded speed dialing, group dialing, and manual (regular) dialing.

Document
The sheet of paper containing the data that you send to or receive from a
fax.

dpi
Dots per inch. A unit of measurement for indicating a printer’s resolution.

MP L6000—USERS MANUAL/V000/12-97
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DRPD
Distinctive Ring Pattern Detection. Allows you to assign up to five different
ring patterns to distinguish voice and fax calls using your telephone
company’s special services.

ECM
Error Correction Mode. The ability of your MultiPASS to reduce system
and line errors when sending or receiving from another fax with ECM
capability. ECM is most effective in areas where the telephone lines are in
poor condition or there is frequent interference on the line. 

FAX/TEL switching
The ability of the MultiPASS to automatically detect whether a call is from
a fax or telephone. With this feature, one telephone line can be shared by
both the telephone and the fax.

FINE
The fax setting for documents with very small characters and lines.

Fine mode
One of the printer’s print modes. Use this mode when printing on
transparencies or printing a halftone image that produces grayscale or
intermediate colors.

Font
A complete set of characters of the same size and style; a particular
implementation of a typeface. For example, 12-point, Courier bold.

G3, Group 3 fax machine
Defined by CCITT. Uses encoding schemes to transmit image data while
reducing the amount of data that needs to be transmitted, thus reducing
transmission time. Encoding schemes for G3 fax machines are Modified
Huffman (MH), Modified Read (MR), and Modified Modified Read
(MMR).

Grayscale
Representing color in black and white as a result of different intensities of
color. Different colors and intensities of colors appear as different shades of
gray.



G-4 Glossary

Group dialing
A dialing method that enables you to dial up to 55 registered one-touch
speed dialing or coded speed dialing numbers together as a group. This
means that you can press just one to three buttons to enter numbers when
sending the same document to many destinations.

Halftone
Using this method, the MultiPASS produces shades of gray by mapping
dots to be printed. 

IEEE 1284
IEEE 1284 is the new specification standard for computer-to-peripheral
bi-directional parallel interface communications. The new standard was
adopted by IEEE, Institute of Electrical and Electronic Engineers, Inc., in
1993. Some of the benefits it provides are: bi-directional communication
between computers and peripheral devices, a higher speed data transfer
rate, and protection against data loss due to noise interference.

Interface port
The MultiPASS comes with one IEEE 1284, bi-directional parallel
interface port, located on the back of the unit. You attach the cable that
connects your computer and MultiPASS to this port. 

Jack
The telephone receptacles (RJ11 type) on your wall or in your MultiPASS
used to connect the MultiPASS to the telephone line, telephone, answering
machine, or data modem.

Landscape orientation
Refers to printing across the length of the page (as opposed to portrait
orientation printing across the width of the page).

Manual feed
A method of feeding paper into the printer one sheet at a time.

Manual receiving
A method of receiving faxes in which you answer all incoming calls using a
telephone. 

Manual redialing
When you use regular dialing, you can redial a number “manually” simply
by pressing REDIAL on the operator panel. The last number called is the
number redialed.

MP L6000—USERS MANUAL/V000/12-97
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Memory broadcast
Allows you to send a scanned fax to as many as 57 locations at once, using
a combination of one-touch speed dialing, coded speed dialing, and regular
dialing.

Modem
A device that converts (Modulates) digital data for transmission over
telephone lines. At the receiving end, this device converts the modulated
data (DEModulates) to digital format that the computer understands.

MultiPASS Desktop Manager for Windows
Canon’s exclusive software package that allows you to use the MultiPASS
with your Windows software applications. You must install the Desktop
Manager to use your MultiPASS as a printer, scanner, or PC fax.

Noise
A term applied to a variety of problems that impair the operation of
telephone lines used for faxing.

Noise level
See dB(A).

Numeric buttons
The round numbered buttons on the operation panel marked the same as
a standard telephone keypad. Press them to perform manual dialing, to
enter numbers and letters when you register numbers and names, and to
enter coded speed dialing codes with two or more digits.

One-touch speed dialing keypad
The round buttons numbered 1 to 6 on the operator panel, each of which
may be registered as a fax or telephone number. Once a number is
registered, you press one button to dial the entire number.

Page orientation
Refers to the direction of print on the page. Printing across the width of a
page is called portrait orientation. Printing across the length of a page is
called landscape orientation.

Pause
A timing entry required for registering certain long distance numbers and
for dialing out through some telephone systems or switchboards. Pressing
the REDIAL/PAUSE button enters a pause between digits of a telephone
number.

MP L6000—USERS MANUAL/V000/12-97
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PC fax
An electronic way to send and receive faxes. A PC fax is sent from or
received directly into a computer. Using the MultiPASS Desktop Manager
you can send and receive PC faxes, and save, sort, and/or print the PC
faxes.

Portrait orientation
Refers to printing across the width of the page (letter style). This is the
opposite of landscape orientation, which is printing across the length of the
page. 

Printable area
The area of a sheet of paper or envelope on which a printer can reproduce
text or graphics (the printable area is smaller than the paper).

Printer driver
Software that sends printing instructions to a printer (in this case, the
MultiPASS). The printer driver keeps track of the attributes of a printer
and the codes the program must send to access those attributes.

Pulse
See Rotary pulse.

RAM
Random Access Memory. Memory that is used for temporary storage of
information such as documents you want to print, scanned and received
documents, and downloaded fonts.

Receiving
Receiving faxes is also defined as RX or reception. This refers to how the
MultiPASS receives fax documents.

Redialing, automatic
See Automatic redialing.

Redialing, manual
See Manual redialing.

Reduction mode
The automatic feature of the MultiPASS that reduces the received image to
ensure it fits on the page. You can turn this feature on/off with the Reduce
to Fit Paper option in the Receive Fax dialog box of the MultiPASS
Desktop Manager.

MP L6000—USERS MANUAL/V000/12-97
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Registering
A process by which you place fax or telephone numbers and names in the
MultiPASS’s memory for automatic dialing so that you can save time
dialing frequently called destinations. You register numbers using the
Address Book in the MultiPASS Desktop Manager.

Regular dialing
Pressing the individual numeric buttons to dial a fax or telephone number.

Remote receiving ID
A two-digit code that enables you to manually activate a fax using a
telephone that is connected to the MultiPASS. (The default code is 25.)

Remote reception
Activating a fax by answering a telephone that is connected to the
MultiPASS, but that is not located near the unit (such as a cordless phone).
You need to dial a remote receiving ID number to start remote reception.

Resolution
The measurement of a printer’s quality expressed in dots per inch (dpi).
Low resolution causes font characters and graphics to have a jagged
appearance. Higher resolution means smoother curves and angles as well as
a better match to traditional typeface designs. Resolution values are
represented by horizontal data and vertical data, for example, 
600 × 600 dpi. 

Rotary pulse
A telephone dialing system where a dial is rotated to send pulses to 
the telephone switching system. When you pulse dial, you hear clicks.
When you touch-tone dial, the most common dialing system, you 
hear tones. 

RX
See Receiving.

Sender ID
Information printed at the top of a fax (also called TTI or Transmit
Terminal ID). This data appears only if the sending fax has been
programmed with the information.

Sending
Sending transmission is also defined as TX or transmit. A fax document
that has been scanned by a fax machine and sent over telephone lines, in
the form of electrical pulses, to another fax machine is a sending
transmission. The MultiPASS also allows you to send a document directly
from your computer (PC faxing).

Sending speed

MP L6000—USERS MANUAL/V000/12-97
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G-8 Glossary

The rate at which faxes are transmitted through the phone line. See also
bps (bits per seconds).

STANDARD
A document setting for sending normal typewritten or printed documents
containing only text and no drawings, photographs, or illustrations.

Standby
The mode in which the MultiPASS is on and ready to use. All operations
start from Standby mode when the LCD displays the date and time.

Tone/pulse setting
The ability to set the MultiPASS to match the telephone dialing system
your telephone line uses: touch-tone or rotary pulse.

Toner Saver
You can enable or disable economy printing (toner saving feature) when
receiving faxes. By enabling the Toner Saver Mode, toner consumption can
be decreased by as much as fifty percent, resulting in a longer effective
cartridge life. You set Toner Saver Mode in the Advanced: Receive Fax
dialog box.

Transaction number
A unique number assigned to each fax document sent (TX NO.) or
received (RX NO.) by the MultiPASS and used to identify that particular
fax document.

Transmit
See Sending.

TrueType font
The scalable font technology built into Microsoft Windows. It offers you
the same font images both on computer displays and printer outputs.

TTI
Transmit Terminal ID. See Sender ID.

TWAIN
An industry standard that allows you to input image data directly 
from a scanner or other input device. Because your MultiPASS supports
TWAIN, you can use the scanning features of the MultiPASS with any
Windows application that also supports TWAIN. 
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TX
See Sending.

Typeface
The printed design of characters. For instance, Courier, Script, and Roman
typefaces all print characters of different designs.

Typestyle
Refers to how the typeface appears: slanted (italic) or upright.

UHQ (Ultra High Quality)
An exclusive Canon digital image processing system that incorporates 64
shades of gray along with a special edge enhancement feature which
ensures that text and photos are transmitted with ultimate clarity.
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Arranging, documents: 7-11
Arrow buttons: 1-8, B-2, B-5
Attention needed status: 8-16
Auto start send: 8-6
Automatic 

dialing: 4-4–5
mode: 2-6
redialing: 4-7–8
report: 8-4
retries option: 8-4

Automatic Document Feeder: See ADF
Automatically feeding paper: 2-11

B
B&W text mode: A-6
Bi-directional parallel 

cable: A-7
port: 1-6

Black & White 
mode, scanning: 6-5
options, scanning: 6-7

Brightness, grayscale scanning: 6-6
Bulletin Board Service, Canon: 1-2

C
Calls, responding: 5-9–10
Canada, support: 1-3
Cancel sending: 4-10
Canon 

Authorized Service Facility (ASF): 
1-3, 9-10, 10-1

Canada: 1-3
Clean Earth Campaign: 9-10 
Customer Care Center: 1-2
Fax Retrieval System: 1-2
Referral Service: 1-2
Web site: 1-2

300 dpi: 2-6, A-5
486DX processor: A-7
600 dpi: 2-6, A-5

A
Accessories: 1-2
Active job: 7-4, 7-6
Address Book 

entries: 3-11–15
exporting: 3-17–18
importing: 3-15–16
setting up: 3-10–18
sorting: 3-12

ADF: 1-5, 1-12, 2-8, 4-2, 6-1, A-3, A-5
document thickness: A-5
document weight: A-5
paper jams: 10-3–4
paper size: A-5

Advanced 
Receive Fax options: 8-8–10
Send Fax options: 8-5–6

ALARM light: 1-8, 4-4, 10-15
Annotations: 7-14–29

adding: 7-20–24
copying and pasting: 7-26
hiding: 7-24
including: 4-19
moving: 7-25–26
panel: 7-17–18
removing: 7-28
resizing: 7-26
revising: 7-25–26
showing: 7-24

Answer Machine Mode: 5-4–5
Answer options: 8-7
Answering machine: 5-4–5

mode options: 8-10
Applicable line: A-3

Index I-1
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I-2 Index

Cartridge: See FX-3 Toner Cartridge
CCITT No. 1 chart: 5-6, A-3
CD ROM: A-7
Clean Earth Campaign: 9-10
Cleaning

MultiPASS L6000: 9-3–6
scanner components: 9-6–8

CODED DIAL button: 1-8, 4-5
Command 

bar: 3-4
buttons: 3-11

Compatibility: A-3
scanning: A-6
TWAIN: A-6

Components: 1-5–6
Concealing, region: 7-22
Contrast

grayscale scanning: 6-6
setting: 4-15

Copier, specifications: A-5
Copies: 6-2

resolution: A-5
speed: A-5

Copying 
and receiving: 5-6
problems: 10-24–25

Copying, documents: 1-11, 6-1–4
operator panel: 6-2–4
resolution: 6-4

Cover page
attaching: 4-18
previewing: 4-18
See also Fax cover page

Cover Page Designer
opening: 4-22
using: 4-23–24

Custom 
mode: 2-6
print settings: 2-7

Customer Care Center: 1-2–3, 10-1

D
Data compression system: A-3
DATE & TIME option: B-1
Date format: 8-3

Default settings
receive fax: 8-8
send fax: 8-5

Delete fax, after sending: 4-19 
Desktop Manager: See MultiPASS 

Desktop Manager
Destinations: 4-11
Details tab, Windows: 2-5
Diagnostics, MultiPASS: 8-20–21
Dialing

automatic: 4-4–5
fax: A-4
regular: 4-2–4

Dimensions, unit: A-8
Disconnecting, MultiPASS: 8-20
Display 

language: 8-3, A-8
size, adjusting: 7-18–19

Docking stations: 10-26
Document(s)

adding pages: 1-14
annotating: 7-14–29
arranging: 7-11
deleting: 7-8, 8-3
display area: 7-17
exporting: 7-10, 7-28
highlighting: 7-23–24
identifying: 1-15–16
image, reviewing information: 7-20
importing: 7-9
manipulating: 7-11–13
merging: 7-13
moving: 7-7
MultiPASS Desktop Manager: 7-1–29
orientation: 7-18
paging through: 7-20
preparing: 1-11–14
printing: 2-3
printing, MultiPASS Desktop 

Manager: 7-2–3
receiving: 5-2–5
removing page: 7-12
renaming: 7-8
reviewing: 7-20
saving: 7-27
scrolling through: 7-11–12
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sending: 4-2–10
sizes, scanning: A-6–7
sorting: 3-9–10
splitting: 7-12–13
thumbnails: 3-8
transmitting: 4-11–13
viewing: 3-7–10

Document feed lever: 1-7, 6-1
setting: 1-14–15

DOCUMENT READY message: 4-2
Document view: 3-8, 7-2, 7-11–13

adjusting: 7-18–20
Document Viewer: 7-15

window: 7-15–17
default options: 7-29

Documentation, using: vii–viii
Dots per inch (dpi): 2-6, A-5

scanning: 6-6
Draft mode, printing: 2-6
Drawing graphic, creating: 7-14, 7-24
DRP service: 5-4, 5-9–10
DRPD 

feature: 5-9–10
switch options: 8-10

Drum: 9-8

E
Economy mode: A-4
Effective scanning width: A-6
E-mail 

attaching document: 7-10
support, Canon: 1-2

Entering information: B-2–6
Envelopes

loading: 2-11–13
printable area: A-2

Environmental conditions: A-8
Error Correction (ECM): 8-5, 8-9
Error status: 7-5, 8-16
Export Tiff: 7-10
Exporting

Address Book: 3-17–18
document: 7-10, 7-28

Extension phone: 5-3

F
Facedown delivery: 2-8–10

slot: 1-5
Faceup delivery: 2-8, 2-10, 2-15

slot: 1-5
Facsimile, specifications: A-3–4
Failed status: 7-5
Fax(es)

header: 1-15, 8-4, 8-6
information: 8-4
memo: 4-19–20
printing speed: A-3
quality: 4-13–15
receiving: 5-1–10
resending: 4-8
resolution: A-4
sender, identifying: 4-19
sending: 4-1–30

Fax cover page
background: 4-21–22
creating: 4-24–27
deleting: 4-29
designing: 4-20–30
editing: 4-27–28
printing: 4-29–30

Fax Log 
comment: 4-19
displaying: 3-21–22
printing: 3-21–22
using: 3-21–22

Fax Only Mode: 5-2
Fax Retrieval System, Canon: 1-2
Fax sending

cancelling: 4-10
messages: 4-10

Fax/Telephone switching options: 8-9
Faxing 

problems: 10-20–23
documents: 1-11

FaxTel Mode: 5-2–3, A-10
Feeding paper

automatically: 2-11
manually: 2-14–15

Index I-3
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I-4 Index

FILE PRINT 
message: 5-8
option: B-1

Fine mode
fax: A-4
copy: 6-3

Fine resolution: 4-14–15
Fixing assembly: 1-6, 10-6
Folder(s)

creating: 7-7
deleting: 7-8
list: 3-4
Desktop Manager: 3-5–7
renaming: 7-8

Front cover: 1-5–6
FUNCTION button: 1-8, B-3
FX-3 Toner Cartridge: 1-2, 2-8, 

9-8–10, A-3
compartment: 1-6
guidelines: 9-8–10
warranty: 9-10

G
General 

problems: 10-25
specifications: A-8

General tab, Windows: 2-5
Graphics, and text mode: 2-6
Graphics tab, Windows: 2-6
Grayscale mode: A-6

scanning: 6-5
Group 

address: 3-14–15
dialing: 4-6–7
entries, Address Book: 3-12

Guidelines
MultiPASS L6000: 9-1–2
toner cartridge: 9-8–10

H
Halftone, scanning: 6-7
Halftoning: 2-6
Hard disk space: A-7

Hardware, cannot initialize: 10-26
Help, Windows 95: 2-4
High quality printing: 2-6
Highlighting: 7-14

document: 7-23–24

I
IBM PC computer: A-7
Identifying, documents: 1-15–16
Idle message: 8-16
IEEE 1284-compliant: A-7
If power goes out: 10-27–28
Image 

area, scanned: A-7
contrast: 8-6
display, adjusting: 7-19

Import Tiff: 7-9
Importing

Address Book: 3-15–16
document: 7-9

In Box: 5-7
folder: 3-6

Individual entries, Address Book: 3-11
Ink/toner saver mode: 8-9 
Inside unit, paper jams: 10-6–10
Installing, printer driver: 2-2
InstantExchange warranty program: 1-3
Intensity: 2-6
Interface: A-2

J
Jams, paper: 10-3–10
Job status: 7-4–5

L
L6000 tab, scanning: 6-7
Labels: 2-13
Laser 

printer, specifications: A-1–2
safety: vi–vii

Layout area: 4-23–24
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Line jack: 1-6
Liquid crystal display (LCD): A-8

display: 1-7
menu system: B-1
messages: 10-11–14

List view: 7-2
documents: 3-9–10

Listen time: 8-9
LOAD PAPER message: 1-9
Loading 

documents: 1-12–13
envelopes, multi-purpose tray: 

2-11–13
Loading paper

manually: 2-14–15
multi-purpose tray: 1-9–10, 2-11

M
Magnetic fields: 9-1
Main tab, scanning: 6-5
Maintaining, MultiPASS: 9-1–16
Making phone call, Desktop 

Manager: 8-12–13
Managing documents, Desktop 

Manager: 7-1–10
Manual 

mode: 5-3
redialing: 4-7
sending: 4-9

Manual feed slot: 1-5, 2-8, 2-14
Manually feeding paper: 2-14–15
Media type: 2-6, A-1
Memory: A-7

faxes stored: 6-4
printing document: 5-5
sending: 4-2

Memory Clear Report: 10-27–28
MEMORY FULL message: 6-4
Menu bar: 3-3, 4-23

viewer: 7-16
Merging, document: 7-13
Messages, LCD: 10-11–14
Modem 

speed: A-3
type: A-3

Monochrome Scan option: 6-4
MultiPASS 

diagnostics, using: 8-20–21
hardware, cannot initialize: 10-26

MultiPASS Background
adding to StartUp: 8-19
closing: 8-17–19
removing from StartUp: 8-18
restarting: 8-19

MultiPASS Desktop Manager 
closing: 3-5
documents: 7-1–29
folders, using: 3-5–7
making phone call: 8-12–13
receiving faxes: 5-7–8
scanning: 6-4–8
screen: 7-1
selecting documents: 7-2
setup: 8-1–22
setup options: 8-2–11
specifications: A-7
starting: 3-2
system requirements: A-7
uninstalling: 8-21–22
using: 3-1–22
utilities: 8-1–22
window: 3-3–5

Multiple copies: 6-3–4, A-5
Multi-purpose tray: 1-5, 1-9–10, 2-8, 

2-11–13
capacity: A-1

Multitasking: 4-1, 5-6
My Folder: 3-7

N
Networking, fax: A-4
No answer, telephone: 8-10
Numeric buttons: 1-8, 4-2, B-3–5

O
OCR software: 6-6
Off hook alarm: 8-6
On error option: 8-6
On hold status: 7-5–6

Index I-5
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One-touch speed dialing: 4-5
buttons: 1-8

On-line help, Windows 95: 2-4
Opening, Cover Page Designer: 4-22
Operator panel: 1-5, 1-7–8

copying documents: 6-2–4
using: 1-7–8

Optical Character Recognition (OCR) 
software: 6-6

Out Box: 3-9
folder: 3-6, 7-3–6

Outgoing message: 5-5
Output slots, paper jams: 10-5
Output tray: 1-5

extension: 1-5

P
Packing materials: 9-16
Page 

adding to document: 1-14
orientation: 2-6
panel: 7-17, 7-20
size, scanning: 6-7

Paper 
feed method: 2-6
feeding problems: 10-18–19
guidelines: 2-2
handling: 2-1–2, A-1
jams: 10-3–10
loading: 1-9–10, 2-11
path: 2-8
printable area: A-2
type: 2-6
weight: A-1

Paper delivery selector: 1-5, 2-8–10
Paper guides: 1-5, 1-9–10, 2-14
Paper release lever: 1-6
Paper rest: 1-5
Paper size: 2-6, A-1

option: 8-7
Paper tab, Windows: 2-6

Parallel cable: A-7
connector: 1-6

Pass-through devices: 10-26
Pause 

duration: 8-5
entering in numbers: 4-3

PC fax(es)
sending: 4-16–19
specifications: A-7
See also Fax(es)

Phone call, Desktop Manager: 
8-12–13

Phone line option: 8-4
PHOTO mode: 2-6, 6-3
Photo resolution: 4-14–15
Photographs, copying: 6-3
Photosensitive component: 9-8
Plain paper: 2-1, A-1
Power 

consumption: A-8
cord connector: 1-6
failure: 10-27
goes out: 10-27–28
source: A-8

Preferences 
setting up: 8-3
tab, scanning: 6-6

Preparing documents: 1-11–14
Preview, scanning: 6-8
Print 

model: 2-6
speed: A-1
test page: 2-5

Print quality: 2-6
problems: 10-18

Printable area: A-2
Printer driver

installing: 2-2
Windows 95: 2-4

Printer port, defining: 2-5
Printer Properties dialog box: 2-4
Printer setup, Windows: 2-4–7
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Printing: 2-1–15
and receiving: 5-6
document: 2-3
document, from memory: 5-5
documents, MultiPASS Desktop 

Manager: 7-2–3
method: A-1
options, specifying: 2-7
problems: 10-15–17
resolution: A-1, A-5
speed, fax: A-3
status: 8-16
width: A-1

Problems: 10-1
Properties dialog box: 2-4

Q
Quality, faxes: 4-13–15
Queued job: 7-4

R
RAM: A-7
REC’D IN FILE message: 5-6, 5-8
REC’D IN MEMORY message: 5-6
Receive conditions: 8-8
Receive fax, via telephone: 5-3–4
Receive Fax options: 8-7–10

advanced: 8-8–10
Receive Mode: 5-1–5, 5-10, 8-7
RECEIVE MODE button: 1-7
Receiving 

documents: 5-2–5
fax status: 8-16

Receiving faxes: 5-1–10
computer off: 5-7–8
computer on: 5-7
FaxTel mode: A-10
Desktop Manager: 5-7–8

Receiving telephone calls: 5-2–3
Recording paper: 2-8
REDIAL/PAUSE button: 1-8, 4-3
Redialing: 4-7–8

canceling: 4-8

Reduction 
mode: 6-3
option: 8-7
sizes: A-5

Region, concealing: 7-22
Registering, and receiving: 5-6
Registration card: 1-3
Regular dialing: 4-2–4
Remote option: 8-10
Removing page, document view: 7-12
Report(s)

automatic: 8-4
receive: 8-8
reference, fax: A-4

Resend option: 8-6
Resending, fax: 4-8
Resolution

copying: 6-4
printing: A-1
scanning: A-5–6, 
setting: 4-13–15

RESOLUTION button: 1-8, 4-14–15, 6-3
Responding to calls: 5-9–10
Retry status: 7-5
Ring 

patterns: 5-9–10
time: 8-9
tone: 8-9

Routine maintenance: 9-2

S
Safety 

information: vi–vii
instructions: 1-3–4

Scan 
folder: 3-6, 6-8
mode: 6-5
resolution: 6-5

Scanned image size: A-7
Scanner(s): 10-26

components, cleaning: 9-6–8
specifications: A-5–7

Index I-7
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Scanning: 6-1, 6-4–9
documents: 1-11, 6-4–8
enlarging: 6-5
image processing: A-5
message: 8-16
method: A-5
Desktop Manager: 6-4–8
preview: 6-8
reducing: 6-5
resolution: A-5–6
speed: A-6
width: A-6
Windows application: 6-9

Scanning glass: 9-6
Scheduled job: 7-4, 7-6
Scrolling, documents: 7-11–12
Selecting paper delivery: 2-9–10
Send Fax 

advanced: 8-5–6
defining: 4-18–19
dialog box: 4-17
options: 8-4–6

Sending
document: 4-2–10
fax status: 8-16
multiple locations: 4-11–13
PC faxes: 4-16–19

Sending faxes: 4-1–30
manually: 4-9

Sent Fax folder: 3-6
Sequential broadcasting: 4-11–13
Serial number, unit: 10-2
Servicing, unit: 1-3
Setting tab, Windows: 2-7
Setting up

Address Book: 3-10–18
speed dial assignments: 3-18–21, 

8-11
Setup 

analyzer, Windows: 2-7
Desktop Manager: 8-1–22
options: 8-2–11
warning: 8-2

Silent receive: 5-10
option: 8-7

Space requirements: A-9
Specifications: A-1–12
Speed, scanning: A-6
Speed dial

assignments, setting up: 3-18–21, 
8-11

group: 3-20–21
individual: 3-19
tab, Desktop Manager: 8-11

Speed option
receiving: 8-9
sending: 8-5

Splitting, document: 7-12–13
Spool settings: 2-5
Stamp: 7-14

inserting: 7-22–23
Stand-alone fax: B-1–6
Standard mode

copying: 6-3
fax: A-4

Standard resolution: 4-14–15
START/COPY button: 1-8, 4-3, 5-3
Status 

bar: 7-17–18
line: 3-5, 3-11
messages, Status Monitor: 8-16

Status Monitor: 3-2
messages: 8-16
minimized: 8-14–15
opening: 8-14
using: 8-14–16
window: 8-15

Sticky note: 7-14
adding: 7-20–21

STOP button: 1-8
Stopped job: 7-5–6
Storing, toner cartridges: 9-9
Supplies: 1-2
Support: 10-1

options: 1-2
technical: 1-2
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Support trays: 1-5
Switch boxes: 10-26–27
System requirements, MultiPASS 

Desktop Manager: A-7
System-defined folders: 3-5–7

T
Tape backups: 10-26
Technical 

notes: 10-26
support: 1-2, 10-1

TEL LINE TYPE: B-1
Telephone

answering machine jack: 1-6
calls: 5-2–3
jack: 1-6
option: 8-3
problems: 10-24
receiving fax: 5-3–4
specifications: A-8

Text documents, copying: 6-3
Text Enhanced mode, scanning: 6-5–6
Threshold, scanning: 6-7
Thumbnails, documents: 3-8
TIFF file format: 7-9–10
Tone tab, scanning: 6-6
Toner: 9-8
Toner cartridge: 1-2, 9-4–5, 9-15

guidelines: 9-8–10
inserting: 9-13–15
preparing: 9-11–12
replacing: 9-11–15
specifications: A-3
storing: 9-9
See also FX-3 Toner Cartridge

Toner saver
fax: A-4
mode: 8-9

Toolbar: 3-3, 4-23
viewer: 7-16–17

ToolTips: 3-3
Transfer charging roller: 1-6, 9-4, 10-6
Transmission 

reception memory: A-3
speed: A-3

Transmit Terminal Identification (TTI): 
1-15

Transmitting, document: 4-11–13
Transparencies: 2-14
Transporting, MultiPASS L6000: 9-15–16
Trash folder: 3-7

emptying: 7-9
Troubleshooting: 10-1–28
TTI: 1-15
TWAIN 

compatibility: A-6
interface: 6-9

U
Ultra High Quality (UHQ) image 

enhancement: A-5
Uninstalling, MultiPASS Desktop 

Manager: 8-21–22
UNIT NAME option: B-1
UNIT TELEPHONE # option: B-1
User information, entering: B-2–6
USER SETTINGS: B-1
User-defined folders: 3-7
Utilities, MultiPASS Desktop Manager: 

8-1–22

V
Variable fields

adjusting: 4-25–26
inserting: 4-24–25

Variables bin: 4-23–24
Viewing documents: 3-7–10
Volume option: 8-3
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W
Warranty: 1-3, 10-1

FX-3 Toner Cartridge: 9-10
Web site, Canon: 1-2
Weight, unit: A-8
White out: 7-14, 7-22
Windows 95: 2-4, 3-2, A-7

on-line help: 2-4
printer setup: 2-4–7

Windows application
scanning: 6-9
sending faxes: 4-16–19

Windows Printing System users: 10-26
Windows tabs, using: 2-5–7
Work area: 3-4

Z
Zip drives: 10-26
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L6000

MultiPASS L6000 LCD Menu System

Normal Functions
Press Function and use arrows to scroll.

User Settings
     Date & Time Uses 24hr clock
     Unit Telephone # Up to 20 Characters
     Unit Name Up to 24 Characters
     Tel Line Type Selects line type
          Touch Tone
          Rotary Pulse
File Print

Special Functions
Press Function and then "0", Scroll with arrows

Memory Clear
     Service Data
     Image Memory
     All Clear
Line Test
     Line Disconnect
     Line Connect Press "1" For This Option
Print report
     Activity Report
     Speed Dial List
     Users Data List
     Error Report

Page 1
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